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1. OVERTURE SUITE SOFTWARE

This manual provides information on Overture Suite 2.3 Software. This chapter describes the features
and installation of the Overture Suite 2.3 software. Overture Suite 2.3 is comprised of three different
software applications; Overture User Manager, Overture Media Manager, and Overture Media
Designer. This manual is divided into three main sections; each section is dedicated to one of the three
Overture 2.3 software applications. Firstly, the Overture User Manager application enables the user to
set security features for the Overture Media Manager. Secondly, the Overture Media Manager
application is used to manage devices and transfer files. Lastly, the Overture Media Designer is used to
create and add various graphics, logos, animation and other media files.

1.1. OVERTURE FEATURES

Overture Suite 2.3 is a software tool that is provided with Evertz's Media Branding Solution product
suite. The products in the Media Branding Solutions Suite enable users to insert animated and/or static
logos into an analog, SD or HD video signal. The animated or static logos allow users to apply their
brand onto the broadcast signal. The product lines that are part of this suite include: 9600 series, 9700
series, and QMC-2 Media Graphics module (QMG).

The Overture User Manager is a security tool, which enables the user to create user accounts and set
permissions to heighten security features for the Overture Media Manager. Please refer to section 2 for
more information.

The Media Manager enables the user to manage media files over a large TCP/IP network. Users can
manage their entire network of Media Branding products from one central location. Please refer to
section 3 for more information.

The Overture Media Designer enables users to create frame accurate animated logos (from a variety of
supported files), movies, images, CG Items, text crawls, temperature, time and date logos. Please
refer to section 4 for more information.

1.1.1. Minimum PC Requirements for Overture Suite 2.3 Software

The minimum PC requirements for the Overture Suite 2.3 software are:

e Pentium 4 class machine

e CD-ROM

e 512MB RAM

e 100Mb Ethernet card with TCP/IP configured

o 3D Video card with 32MB or greater texture memory, 1024x768 screen resolution (64MB Video
Card recommended)

¢ Windows2000 SP4, Windows XP, or Windows Server 2003

o Direct X version 9.0c

e QuickTime Player version 7 or better

¢ Manufacturer supplied video driver, not generic Windows driver

The PC must be running Direct X version 9.0c or later and the latest video drivers provided by the
computer's graphics card vendor must be installed. If the machine does not meet these system
requirements the Startup Error message shown in Figure 1-1 will be displayed.
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startwpbrror x|

& Cwerbure Media Designer has detected an error,
Please make sure that your PC meets the Following requirements;

&) Directy wersion 9.0c ar later is installed, and
b) The latest display drivers provided by vour graphics card wendor are installed.

If wou continue ko encounker problems running this software please conkack your
local Evertz support representative,

Figure 1-1: Startup Error Message

1.2. INSTALLATION INSTRUCTIONS

1. Copy the Overture 2.3 Software Suite .exe file to your PC.
2. Launch the installation by double-clicking the setup icon.
3. Follow the installation instructions detailed in the pop-up windows of the installer.

Upon completion, the desktop will show the three Overture Software icons, one for each
application: Overture User Manager, Overture Media Manager, and Overture Media Designer.

1.3. NETWORK CONFIGURATION

In order for Overture Suite 2.3 to operate properly, the PC on which the software is running needs to be
on the same TCP/IP network as the Media Branding products. When using a network server to store
media, Overture must also be connected to this network. Please contact your IT system administrator
to ensure network connectivity is established.
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2. OVERTURE USER MANAGER

2.1. GETTING STARTED

To launch the Overture User Manager application, double click on the Overture User Manager icon on
your desktop, or go to Start > All Programs > Overture Suite then select the Overture User Manager
option. When Overture User Manager is launched the user will be prompted to enter a username and
password. Enter admin for the username and leave the password blank. The user will be presented
with the User Manager screen as shown in Figure 2-1. This is Overture’s main user management
interface. The Overture User Manager is used to manage the user accounts for Evertz Media Branding
devices and software. Users will be able to add accounts, edit existing accounts and set permissions
on a per account or group basis. The Overture User Manager allows the user to set security features
for the Overture Media Manager.

tr Owverture User Manager EJ@
File Edit Tools Help
Entities Entiky Yiew
/
=r gy Users The fields below allow wou to modify the attributes of the selected user. If the account is not enabled the user
N B will not be able to login.
-4 Access Control Groups
[#-+  Policies
Username:
Password:
Confirm Password:
Full name:
Description:
Management General | Member OF FTP

Figure 2-1: Overture User Manager
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The Overture User Manager interface is divided into two panels. The different Overture User Manager
sections are listed below:

o Entities Panel allows the user to add or delete individual user accounts, group accounts or
modify policies. (See section 2.3)

o Entity View Panel allows the user to modify the parameters associated with the selected group.
(See section 2.4)

2.2. MAIN TOOLBAR

2.2.1. File Menu
The File drop down menu provides the options shown in Figure 2-2:

Mew User
Mew Group

Save Chrl+35

Exit Alt+F4

Figure 2-2: File Menu

e New User:  This option enables the addition of a new user. The user settings can be
configured in the Entity View (see section 2.4.1).

o New Group: This option enables the addition of a new group. The Group settings can be
configured in the Entity View (see section 2.4.2).

e Save: This option enables the user to save the management settings.

o EXxit: This option enables the user to exit the Overture User Manager application.

2.2.2. Edit Menu
The Edit drop down menu provides the options shown in Figure 2-3.

Inda Chel4+Z
Redo Chel4

Add Group Member
Remove Group Member

Delete

Figure 2-3: Edit Menu

e Undo: This option enables the user to undo the last action taken.

e Redo: This option enables the user to re-instate the undone action.
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e Add Group Member: This option enables the user to add a user to a group.

e Remove Group Member:  This option enables the user to remove a user from a group.

o Delete: This option enables the deletion of a group or user.

2.2.3. Tool Menu
The Tools drop down menu provides the options shown in Figure 2-4.

Zonfigure Device Security, ..

Figure 2-4: Tools Menu

e Configure Device Security: Selecting this option enables the user to configure the device
connection security.

2.2.3.1. Configuring the Device Security

By navigating to the Tools menu and selecting the Configure Device Security... option, the user can
setup the device connection using the dialog box shown in Figure 2-5.

In order to set security for the device, the user must enter the IP address of the device and create a
username and password for the device. Access to the device will then be restricted. Once the
appropriate information is entered, select the OK button to save changes.

L 5|

Device Connection Setup

Flease specify the device you want bo connect to
and provide a username and password to access
the device.

Device IP Address:
Username:

Passwiord:

(8] 4 ][ Cancel ]

Figure 2-5: Device Connection Setup Dialog Box
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2.2.4. Help Menu

The Help drop down menu provides the options shown in Figure 2-6.

About, .

Figure 2-6: Help Menu
e About... This option enables the user to view the Overture Media Designer version number.

2.3. ENTITIES PANEL

The Entities Panel allows the user to add or delete individual user accounts, group accounts and
modify policies. Figure 2-7 displays the Entities Panel with the default user account of admin listed.
Please note that the admin account cannot be deleted or disabled.

File Edit Tools Help

Entities
A
=l f1 Users
™ admin
=% Access Control Groups
Adminiskrators
=1« Policies
Iser Accounts

Management

Figure 2-7: User Control Panel
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Right clicking on any of the items in the Entities panel will display the following management menu:

Mew User
Mew Group

Delete

Figure 2-8: Entities Right Click Menu

The menu enables the user to perform the following actions:

e New User:  This option enables the creation of a new user account. Selecting this option will
place a new user under the Users item. The user settings can be configured in
the Entities View. See section 2.4.1.

e New Group: This option enables the creation of a new Control Group. Selecting this option
will place a new Group under the Access Control Groups item. The group
settings can be configured in the Entities View. See section 2.4.2.

o Delete: This option enables the deletion of a user or group. A user or group must be
selected in order for this option to be visible.

2.3.1. Users — Entities Panel

The Users item displays a list of the users. A new user can be created by right clicking on the Users
option in the Entities panel and selecting New User from the drop down menu. A new user can also be
added by selecting New User from the File menu. Once the new user is created it will appear under the
Users item in the Entities panel. To configure the user settings use the tabs in the Entity View to adjust
the parameters. See section 2.4.1.

2.3.2. Group — Entities Panel

The Group item displays a list of groups available. A new group can be created by right clicking on the
Groups option in the Entities panel and selecting the New Group option from the drop down menu. A
new group can also be added by selecting New Group from the File menu. Once the new group is
created it will appear under the Access Control Groups item in the Entities panel. To configure the
group settings use the tabs in the Entity View to adjust the parameters. See section 2.4.2.

2.3.3. Policies — Entities Panel

The Policies item displays a list of policies available. The user can modify the properties of the policy
using the parameters in the Entity View. See section 2.4.3.
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2.4. ENTITY VIEW

The Entity View enables the user to configure the parameters for the user, group, and policies.

2.4.1. User Entity View

When a User is selected in the Entities panel, the Entity View panel displays three tabs for
configuration: General, Member Of, and FTP which are outlined in sections 2.4.1.1 to 2.4.1.3.

2.4.1.1. General Tab

When a user is selected in the Entities panel and the General tab is simultaneously selected in the
Entity View panel, the user will be prompted to fill out the parameters of the fields, as shown in Figure
2-9.

Enkity Yiew

The Fields below allowe wou to modify the atkributes of the selected user, IF the account is nok enabled the user will
not be able to login.

Isername: Evertz User

Password: TITITTIT]

Confirm Password: L IITTITT

Full name: Eevrtz Microsystems Lid,
Description: |

Account is enabled

General | Member OF FTP

Figure 2-9: User ‘General’ Tab
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The administrator is required to fill out the following fields:

e Username: This field enables the administrator to assign a username to the selected user.
o Password: This field enables the administrator to assign a password to the selected user.

e Confirm Password: The administrator must enter the password again in order to confirm that it
is correct.

e Full Name: This field enables the administrator to enter the Full Name of the user.
e Description: This field enables the administrator to enter a description for the selected user.

e Accountis enabled: Placing a check mark in the “Account is enabled” field activates the user’s
account. If there is not a check mark placed in this field, the user will not be able
to login using the assigned username and password.

2.4.1.2. Member Of Tab

When a user is selected in the Entities panel and the Member Of tab is simultaneously selected in the
Entity View panel, the administrator will be able to assign a user to a Group, as shown in Figure 2-9.

To assign a user to a group, select the Add to Group button at the bottom of the screen. The Select
Entities to Add dialog box will appear, which will list the available groups. If the administrator has not
created any other Groups, only the Administrators group will be listed in this dialog box. Select the
desired group to which you wish to add the user and then press the OK button to apply the changes.
Click Cancel if you do not wish to assign the user to a group.
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Enkity Yiew

Displayved below are the groups the selected user belongs to. To add this user ko a group simply press 'Add to
Group’ to select available groups From a lisk, To remove this user From a group select the group(s) bo remove From
and press 'Remove From Group', You canalso drag a group from the Management Tree inko the box below,

Select Entities to Add

Flease seleck the group(s)juser(s) ko add;

Groups
| Administrators
Evertz Group

[ (0] 4 I [ Cancel

Add ko Group I | Remove From Group ]

General Member OF | FTP

Figure 2-10: User ‘Member Of’ Tab

To remove a user from a group, select the group listed in the Entity View field, and then click the
Remove from Group button.
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Enkity Yiew

Displaved below are the groups the selected user belongs ko, To add this user to a group simply press ‘Bdd to
Group' ko select available groups from a list, To remowve this user From a group select the groupis) to remove From
and press 'Remaove Fram Group', You can also drag a group from the Management Tree inko the box below,

Access Control Groups
Ewverkz Group

| Add to Group | [ Remoyve from Group

General Member OF | FTP

Figure 2-11: User has been added to a group

2.4.1.3. FTP Tab

When a user is selected in the Entities panel and the FTP tab is simultaneously selected in the Entity
View panel, the administrator will be able to assign a FTP account to the selected user.

Please note that when the user is attempting to connect to a device, the FTP
,@5 account specified must exist on the device to allow the user access.

The administrator must enter the following information:
e Username: This field enables the administrator to assign the user a FTP username.
e Password: This field enables the administrator to assign the user a FTP password.

e Confirm Password: The administrator must enter the password again in this field in order to
confirm that it is correct.
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Enkiky Wiew

The fields below allow wou bo associate an existing FTP account with the selected user, When the user is
atkempting to connect to a device, the FTP account specified must exist on the device to allow the user access,

Username:
Password;

Confirm Passwiord;

Gaeneral Member OF FTP

Figure 2-12: User ‘FTP’ Tab

If the username and password is set for the unit, then it will be registered for the
unit even if the firmware is re-installed. However, if Overture is re-installed, the
/gg user will have to set the same username/password for FTP again. Once the

username and password matches, the unit and Overture will approve
authentication and will be able to connect to the device.

2.4.2. Group Entity View

When a Group is selected under the Access Control Groups in the Entities panel, the Entity View panel
displays three tabs for configuration: General, Members, and Permissions which are outlined in
sections 2.4.2.1t0 2.4.2.3.
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2.4.2.1. General Tab

When a group is selected in the Entities panel and the General tab is selected in the Entity View panel,

the user will be prompted to fill out the parameters for the general group settings, as shown in Figure
2-13.

Enkity Yiew

The Figlds below allow wou ko madify the attributes of the selected group, IF the group is nok enabled the
members af the group will nat inherit any permissions set for the group.,

Marne: Evertz Group

Description:

Account is enabled

General | Members Permissions

Figure 2-13: ‘General’ Tab

The administrator is required to fill out the following fields:
e Name: This field enables the user to assign a name to the selected group.
o Description: This field enables the user to enter a description for the selected group.

e Accountis enabled: Placing a check mark in the “Account is enabled” field activates the group
account. If a checkmark is not placed in this field, the members of this group will
not inherit the permissions set for this group.
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2.4.2.2. Members Tab

The Members tab enables users to be added to the selected Group. To add a user to the group, select
the Add Group Member button and a Select Entities to Add dialog box will appear, as shown in
Figure 2-14. A list of available Users and Groups will be displayed. Select the desired users that you
wish to add and then press the OK button.

User(s) and Group(s) can also be added to a group by selecting them in the Entities panel
management tree and then dragging them into the Members box.

To remove a member from the group, select the member from the main box field and then press the
Remove Group Member button.

Ertkity Wiew

Displayed below are the members of the selected group. Ta add a member simply press 'ddd Group Member' ko
select available members from a lisk, To remove a member from this group select the member(s) ko remove and
press 'Remove From Group'. You can also drag a user or group from the Management Tree into the box below,

-

Select Entities to Add

Users

™~
Evertz User Flease select the groupisifuser(s) to add:

™ John
™ Peter
Users
® admin
™ Mike
Groups
| Administrators

(84 I [ Cancel

Add Group Member I I Remove Group Member

General Members | Permissions

Figure 2-14: Members Tab
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2.4.2.3. Permissions Tab

The permissions tab enables the user to set permissions for the selected group. Once these
parameters are configured the permissions will be applied to the selected group and all of its group
members. Figure 2-15 shows the available permission settings. Enabling and disabling these
parameters will configure the group permissions. The permissions applied will allow or restrict the
group’s permissions in Overture Media Manager.

To modify the permissions, double click the item and select either Disabled or Enabled from the
Permission Settings dialog box.

Enkity Yiew

Displayed below are the permissions associated with the selected group, To modify a permission simply double-click
the itemn and select the new walue From the dialog.

Media Commmander

Bypass Enabled
Gaenerate Conkent Enabled
Graup Owerride Erabled
Media Conkrol Enabled
Media Fade All Out Enabled
Setup Enabled
Setup Server Erabled
pload Conkent Enabled
Media Manager

Delete Enabled
Device Bypass Enabled
Device Conkrol Enabled
Device Management Enabled
Device Properties Enabled
Device Swstem Config Enabled
Device User Mainkenance Enabled
Device View Users Enabled
Download Enabled
Group Control Enabled
aroup Properties Enabled
Upgrade Firrmware Erabled
pload Enabled
User Manager

Adrministration Enabled

General Members Permissions

Figure 2-15: Permissions Tab
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2.4.3. Policies

To set the policy parameters, expand the Policies item in the Entities panel and select the User
Accounts item. The Permissions tab will be displayed in the Entity View window, as shown in Figure
2-16. The Password Restrictions items identify the permissions that are associated with the selected
policy. To modify the permissions, double click the item and select the new value from the permission
settings dialog box.

Enkity Yiew

Displayed below are the permissions associated with the selecked policy, Ta madify a permission simply double-click
the item and select the new wvalue from the dialog.

Password Restrictions

Dol Requirements Dizabled
Enforce Password Policy Disabled
Minimurm Password Length 10

Permissions

Figure 2-16: Policy Permissions Tab
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3. OVERTURE MEDIA MANAGER

3.1. GETTING STARTED

To launch the Overture Media Manager application, double click on the Overture Media Manager icon
on your desktop, or go to Start > All Programs > Overture Suite and then select the Overture Media
Manager option. When Overture Media Manager is launched the user will be prompted to enter a
username and password. Enter admin for the username and leave the password blank. The user will
be presented with the Media Manager Screen as shown in Figure 3-1. This is Overture’s main media
management interface. The Media Manager is used to manage the media files for Media Branding
products over a network. Users will be able to view, add to, remove from, and activate any media files
in their network or Media Branding products.

The Overture Media Manager has four main panels for managing media files. The Overture Media
Manager consists of the following panels (see Figure 3-1):

o Configuration Panel. See section 3.3.1.
e Remote Device Panel. See section 3.3.2.
e Media Panel. See section 3.3.2.10.
e Status Window. See section 3.3.4.
Overture Media Manager E]@
File Edit Control Tools Wiew Help
Configuration ¥ | | Remote Media Media x
This is the top level node for your current hardware setup. If this is a new installation of Euldey +11 b B
Cwerture you will not see any devices or groups under this node until you add a new device or Mame Size | Date
+-[ 3 Devices group. To add a new device or group simply click on the image or the page link provided below.
|l Groups
New Device
Add a new device to your hardware setup.
- -

TV per
L New Device Group )
Add a new device group to manage one or more devices.

< B2
My Config My Media | My Bookmarks
Status Window X
P
Command Media Status Size: Rate

Log | Transfer Queue

Figure 3-1: Overture Media Manager Screen
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3.2. OVERTURE MEDIA MANAGER TOOLBAR

This section describes the functions of the Overture Media Manager drop down menus.

3.2.1. File Menu

The File drop down menu provides the following options (see Figure 3-2):

¢ New Device...

Mew Device. ..
MNew Dewvice Graup...

Mew Bookrark, ..
Mew Falder, .,
Mew Plavlist. ..

Open
Index. ..

Download Selected
Security...
Upload...

Upload Selected
Uparade. ..

Properties

Expaort Configuratian, ..
Import Configuration, ..

Logout

Ezxit

Chrl+0

Ctrl+D

Ctrl+Shift-+L
Chrl4+U

Alt+Enter

Alt+F4

Figure 3-2: File Menu

manage media. See section 3.3.1.1.

enables the user to add a new device to which the user will transfer files and

o New Device Group... enables the user to create a new device group to manage media files.
Device groups are used for grouping multiple devices that may represent a certain time zone or
group of stations, enabling the user to simultaneously send media files to all devices in the

group. See section 3.3.1.2.

o New Bookmark... enables the user to create a new bookmark. The My Bookmark pane acts
as a pointer to a directory. Users can designate their favourite folders as bookmarks and then
select the bookmark from the directory to view its path. Once this option is selected the user will
be presented with a Create Bookmark dialog box, as shown in Figure 3-3.

Page 3-2
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-,

Create Bookmark

General

Mame:

Path:

Browse, ..

Cancel

Figure 3-3: Create Bookmark

To create the bookmark, enter the Name of the bookmark into the field and then select the path
using the Browse... button. Navigate to the appropriate file and select Open.

o New Folder enables the user to create a new bookmark folder. Once this option is selected the
user will be presented with a Create Bookmark Folder dialog box, as shown in Figure 3-4. The

user can add a name and description to identify the type of bookmarks that will be located in
this folder.

P o

Create Bookmark Folder

General

Marne:

Description:

Zancel

Figure 3-4: Create Bookmark Folder
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New Playlist... enables the user to create a new playlist. See section 3.3.3.1.2.

Open enables the user to launch the application associated with the selected extension file in
OMM. For example, if the media item selected is a text file, OMM will open the file with the
default text file editor, which is typically Notepad. The file type associations are setup in
Windows Explorer under Tools>Folder Options>File Types.

Index enables the user to retrieve the "thumbnails” for the media on the device. A thumbnail
will be created using a frame from the selected media. This thumbnail will be displayed in the
remote pane. Thumbnails will only be displayed when the user has used the Index function and
the thumbnail mode is selected by choosing View/Thumbnails or clicking on the Thumbnail
button in the Remote Media View. When the user selects the Index option, the Metadata being
downloaded will be displayed in the Status window console, as shown in Figure 3-5.

| Status Window

b,

Command I Media Skatus | Size Rate

B Log | Transfer Queue - 1

Metadata Retrieving metadata. .. (62%) 494 B

Figure 3-5: Downloading Metadata

After this download completes the user will be able to preview their thumbnails. Once the user
retrieves the thumbnails by using the index command, the thumbnails will be displayed in the
Remote Media pane as shown in Figure 3-6.
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Remate Media

Folders |showing 3 folders =]
W video active M 1 Mecka Element Active

General |
Playout Cache [ Used: 11.4 M8 (0.14%) W cached: 20,1 M8 (0.25%) Bl Free: 5.0 GB (99.62%:)
8.0 GB [ required: (no selection)

Figure 3-6: Remote Media Pane with Thumbnails Present

e Download Selected enables the user to select media from the remote pane and transfer it to
the media pane. This option will only be available if media is highlighted in the remote pane. It
will be grayed out if media is not selected in the remote pane.

e Security... this dialog enables the user add and remove FTP accounts for the selected device.
To add a new FTP account to the device, enter the username and password into the
appropriate fields and then click the ‘Add’ button. To remove an account, select the FTP
account in the list then click the ‘Remove’ button.
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Device Security ﬁl

MName l Password l

Username:

|
Password: l
[

Confirm Password:

OK | Cancel |

Figure 3-7: Device Security

Overture Media Manager needs to know which FTP account to use when it tries to

connect to a device. To do this the user must configure a FTP username and
,@5 password with the username that was used to login to Overture Media Manager.
See section 2.2.3.1 on how to configure Overture users.

e Upload... enables the user to upload a media file to the selected device.

e Upload Selected enables the user to select media from the media panel and transfer it to the
remote pane. This option will only be available if media is highlighted in the media pane. It will
be grayed out if media from the media pane is not selected.

e Upgrade... enables the user to upgrade the device firmware. See section 3.3.1.3.
o Properties enables the user to view the Device Properties window.

o Export Configuration enables the user to export the configuration to the appropriate product
family. When this option is selected, the Export Configuration dialog box will appear as shown
in Figure 3-8. The two options are Orchestra Server and Overture. Once this is selected a
dialog box will appear prompting the user to select the folder the user wishes to export their
configurations to. Export Configuration allows users to export Overture Media Manager's
configuration such as device settings, ftp accounts and group information.
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Export Configuration

Select the product Family that the configuration will apply to:

Product Family

() Orchestra Server
{E} Overture

[ oK ] [ Cancel

Figure 3-8: Export Configuration

o Import Configuration enables the user to import an existing configuration. When this option is
selected, the Browse For Folder dialog box will appear, as shown in Figure 3-8. Navigate to the
appropriate file and select the OK button. The user is now able to import an existing

configuration.

rI3rc|ﬂ~|»\fma For Folder W

Select a Folder From which ko import the configuration From;

ﬂﬁ' Desktop fad
+ u My Docurnents
+ _é My Compuker
= &J My Metwork Places

Folder: My Computer

[ Ok l [ Cancel

Figure 3-9: Import Configuration — Browse For Folder

¢ Logout enables the user to logout as the current user and login as the same or different user
without closing the program.

e EXxit enables the user to close and exit the Overture Media Manager application.
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3.2.2. Edit Menu

The Edit drop down menu provides the following options (see Figure 3-10):

3.2.3.

&dd To Syskem Config
Remove From Syskem Config

Copy Chel4+C
Paste Chel4y
Delete

Formak

Figure 3-10: Edit Menu

Add To System Config enables the user to add the selected media to the system config file.

Remove from System Config enables the user to remove the selected media from the system
config file.

Copy enables the user to copy the selected media file.

Paste enables the user to paste the selected media file. The user can also copy a file without
accessing the media pane and paste it into the desired location. To do so, the user must
navigate to the appropriate file on the connected computer, copy the file (right-click and select
copy or highlight and Ctrl+ C) and then use the paste command to paste the file in the
appropriate location in Overture.

Delete enables the user to delete the selected file or device.

Format Media... enables the user to format the compact flash disk.

Rename enables the user to change the name of the selected media.

Add to System File Pane enables the user to add the selected media to the system file pane.

Control Menu

The Control drop down menu provides the following options (see Figure 3-11):

Check Bypass State...

Bypass Chrl+B
Remove Bypass Ckrl+Shift+B
Media Cus Fa

Media In F7

Media Ouk Fa

Media All Cuk Shift+Fa

Figure 3-11: Control Menu
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Check Bypass State... allows the user to check if the device is running in Active Video or in
Bypass mode. When this option is selected a dialog box will notify the user as to what mode the
unit is in. If the unit is in Bypass Mode, it will notify the user that the ‘Relay is Active’ and when
the unit is not in bypass mode it will display “Relay not active”.

e Bypass enables the user to initiate remote bypass mode. The remote bypass feature triggers
the relay built into the keyer output with any processing in between (ie. Disables the keyer logo
functionality). When this option is selected it will trigger the Keyer to run in Bypass mode and
not in Active Video mode.

e Remove Bypass enables the user to remove the bypass mode. When this option is selected,
the Bypass mode will be removed from the Keyer and the relay will not be active. Removing
bypass will allow the Keyer to run in Active Video mode.

¢ Media Cue enables the user to cue a media file on the selected device or device group. This
will load the selected media file into the device’s memory cache and output on the preview
output of the device.

e Media In enables the user to fade in the selected media file. If the logo has not been loaded
into the device’s memory cache, this action will load the media file, fade it into the video signal
and display it on both preview and program outputs of the device.

¢ Media Out enables the user to fade the selected media file out of the video signal.

e Media All Out enables the user to fade all of the media files out of the video signal. If multiple
devices are active this command will fade out all of the media.

Please note for large media (such as big animations being performed in the
background) holding the SHIFT key down while performing a media operation

(ie. Media Cue or Media in) will force the media operation to be executed in the
,Ef background. Overture Media Manager will not know if the media has been
loaded successfully and it will not time out when waiting. This feature is only
necessary if you are using extremely large animations.

3.2.4. Tools Menu

The Tools drop down menu provides the following options (see Figure 3-12).

User Managet...
Configure QDBC,.,

Skap Watch Service

Figure 3-12: Tools Menu
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e User Manager... enables the user to access Overture User Manager from within OMM.

Selecting this option will display an Overture User Manager login screen as shown in Figure
3-13.

i o

Overture User Manager

Enter wour username and passwaord to login

cﬁ‘.?‘?' ] Username admin|

% ._\_.
Jr  password

Login ] [ Close ]

Figure 3-13: Overture User Manager Login Screen

e Configure ODBC... enables the user to configure the ODBC settings. The user can set the
Interval (in seconds) for which information will be compiled for the data file using data from the
ODBC Database. Under the devices field, the user must select a device to which the compiled
information will be uploaded to. See Figure 3-14.

e o

ODBC Confizguration

After every interval has elapsed, compile the data File
using daka from the ODBC Database,

Interval (in Seconds): 1

Afker a successful compile upload to:

Devices
o725
Mamedropper

Cancel

Figure 3-14: ODBC Configuration Window
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Start Watch Service enables the user to monitor the watch folders. By default the watch
service is started when the media manager is launched. This service monitors the watch folders
(right click/Properties for folders on the right side of media manager). When the contents of a
watched folder changes the watch service will compile the movie (either mov or avi). The
Watch Service is a feature designed to compile avi or mov files without the need to compile
them in Overture Media Designer. When avi or mov files are added to the “Watch Folder”, the
Watch Service will begin to compile the avi or mov file in an .evl logo format and an audio clip (if
audio is present with the movie clip). For information on setting the watch service see section
3.3.3.2.2.

Stop Watch Service enables the user to stop the watch service. When mov or avi files are
added to the “watch folder” they will not be compiled since the Watch service is disabled. Users
not using the Watch Service can disable this option.

3.2.5. View Menu

The View drop down menu provides the following options (see Figure 3-15):

Clear Log
Refresh FS

v Configuration
v [Media
W Skakus Window

Caompack
v Details
Thurnbnails

Figure 3-15: View Menu
Clear Log enables the user to clear the contents of the Status Window Log tab. Compilation

logs from the Watch Service will be logged in this pane and the “Clear Log” will permanently
clear this information.

Refresh retrieves and refreshes the most current version of the selected device, folder or
media.

Configuration: Placing a check mark beside this option displays the Configuration Window. If
a check mark is not placed beside this option, the Configuration Window will not be displayed.

Media Window: Placing a check mark beside this option displays the Media Window. If a
check mark is not placed beside this option, the Media Window will not be displayed.

Status Window: Placing a check mark beside this option displays the Status Window. If a
check mark is not placed beside this option, the Network Activity Window will not be displayed.

Compact: Placing a check mark beside this option will list the files in compact mode. Only the
filename will be listed in the Remote Media pane.
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o Details: Placing a check mark beside this option will list all the details of the files in the Remote
Media pane. (For example, filename, file size, location, date modified, etc...)

e Thumbnails: Placing a check mark beside the thumbnail option will display thumbnails of the
associated files in the Remote Media pane. The thumbnails must first be created by using the
index command before they can be displayed in the remote pane. See the Index description in
section 3.2.1 to set up the thumbnail option.

3.2.6. Help Menu

Clicking the About button (see Figure 3-16) in the Help drop down menu displays the version number of
the Overture software. (See Figure 3-17)

About, .

Figure 3-16: Help Menu

o
&« Mg
ok

: g@gzjf:

H
c 3

4]
E
7]
# B
#-El
]
]
]
kil
&
B

L

Cwerbure Media Manager
Copwright € 2007-2003 Evertz Microsyskems, Led,
Version: 2.2.0.1623

Figure 3-17: Help Screen
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OVERTURE MEDIA MANAGER PANELS

The Overture Media Manager is divided into four user panels:

Configuration Panel. See section 3.3.1.
Remote Device Panel. See section 3.3.2.
Media Panel. See section 3.3.2.10.
Status Window. See section 3.3.4.

3.3.1. Using the Configuration Panel

The Configuration panel enables the user to add, edit, upload and upgrade devices in the Overture
Media Manager.

Configuration >

| ~l]rrl:nupms

My Config

Figure 3-18: Keyers Panel

To access the Configuration panel drop down menu, right click on the Configuration heading, My
Devices item, or My Groups item (see section Figure 3-18) in the Configuration panel.

The following options can be accessed from the Configuration menu:

Mew Device. ..
MNew Device Group...

Figure 3-19: Configuration Menu

¢ New Device... enables the user to add a new device to which the user will transfer files and
manage media. See section 3.3.1.1.

e New Device Group... enables the user to create a new device group to manage media files.
Device groups are used for grouping multiple devices that may represent a certain time zone or
group of stations, enabling the user to simultaneously send media files to all devices in the
group. See section 3.3.1.2.
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3.3.1.1. Adding a Device

In order to manage the media files on the Media Branding products, the user must add the device to
the Keyers panel.

A device can be added by right-clicking the Configuration heading, My Devices item, or My Groups item
and selecting the New Device option from the drop down menu that appears.

A new device can also be added by highlighting the My Devices option in the Configuration pane and
then clicking the New Device image or page link that appears in the Remote Media pane, as shown in
Figure 3-20.

This is the top level node for devices in your current hardware

setup. If this is a new installation of Owverture you will not see any
devices under this node until you add a new device. To add a new
device simply click on the image or the page link provided below.

New Device
Add a new device to your hardware setup.

Figure 3-20: New Device Link — Remote Pane
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3.3.1.1.1. Configuring the Device Properties

Once selected, the New Device Properties window will appear, as shown in Figure 3-21. The New
Device properties window has three tabs: General, Member Of and Upload Folder.

¥ S

Properties: Namedropper

General | Member Of | Upload Folder

Mame: Mamedropper
Address: 192,168.8.71

Port:

Trigger Timeouk; | 120 : seconds
System File:

Browse, ..

[ ]Connect aukomatically

[ oK ] [ Cancel

Figure 3-21: Device Properties ‘General Tab’

The General tab requires that the user set the name, address, port, and system file information. The
user must fill in the appropriate information for the following device property fields:

e Name: Enter a name that uniquely identifies the device.

e Address: Enter the IP address of the device.

e Port: Define the port that the device is accessing.

e Trigger Timeout: Set the amount of time (in seconds) it will take for a media operation (trigger)

timeout to occur.

e System File: The user may select or create a system logo database using the System File field.
If a system file currently exists, the user can set this file by clicking the Browse
button and opening the desired file.

The user can also specify a system file name that does not exist and Overture will create a new
file using the entered name. To do this, select the Browse button and when the Select File
window opens, enter a new filename in the File Name field. The new file will be created in XML
format and can be edited and configured using the “Add to System Config” and “Remove from
System Config” options.
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¢ When the Auto Connect When Needed check box is filled in, the user is able to set the device

to automatically connect to Overture and refresh media when the Overture Media Manager is
launched.

The Member Of tab enables the user to select the group to which they wish to add the current device.

e The Groups field enables the user to select the group that the device will belong to. Refer to

Figure 3-22.

-

=,

Properties: Namedropper

General | Member OF | Upload Folder

Member Of:

Group

[ (8] 4 ] [ Cancel

Figure 3-22: Device Properties ‘Member Of’

To add the device to a group, select the Add button. An Add Group dialog box will appear, as shown in
Figure 3-23. If the group(s) has already been created in the Media Manager, the group will be listed

under the Names field. Select the desired group(s) and then click the OK button. The group(s) will be
listed in the Member Of dialog box.
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-,

rhdd Group @

Mame

B Facility
Conkrol Room

Cancel

Figure 3-23: New Device — ‘Add Group’

The Upload Folder tab enables the user to specify the action to be performed when media is uploaded
to the current device.

= =]

Properties: Namedropper

General | Member OF | Upload Folder

Select the action to be performed whenever media is uploaded
ko this device,

pload Action
(%) Prompt For Destination Folder
) Do Mot Prompt {Upload To The Selected Folder)

Maote that iF the media ko be uploaded exists in a Falder
other than the one selected here the media will be
uploaded ko the existing media Folder.

Folder
[cardi]

[ Ok ] [ Cancel

Figure 3-24: Upload Folder
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The Upload Action section enables the user to select the action that should be taken when media is
uploaded to the selected device. There are two options for uploading media:

o Prompt for Destination Folder: If the user selects this option, Overture will prompt the user to
select the destination folder whenever media is uploaded to this device.

o Do Not Prompt: If the user selects this option, Overture will automatically upload the media to
the folder selected here.

3.3.1.2. Adding a Device Group

Overture enables the user to create a new group of devices to manage media files. Device groups are
used for grouping multiple devices that may represent a certain time zone or group of stations, enabling
the user to simultaneously send media files to all devices in the group. The device group enables the
user to apply an operation to all the devices in the device group.

A device can be added by right-clicking the Configuration heading, My Devices item, or My Groups item
and selecting the New Device Group... option from the drop down menu that appears.

A new device group can also be added by highlighting the My Devices option in the Configuration pane
and then clicking the New Device Group image or page link that appears in the Remote Media pane,
as shown in Figure 3-25.

This is the top level node for device groups. A device group is a
containet for halding individual devices. Device groups allow the
execution of aperations in the same manner as individual device
operations but apply the operation to all devices contained in the
group. To create a device group simply click on the image or page
link pravided below.

New Device Group
- Add a new device group to manage ane or
more devices,

Figure 3-25: New Device Group — Remote Pane

Once selected, the New Device Group window will appear, as shown in Figure 3-26. The user will be
required to enter the appropriate information in the designated fields.

The General tab enables the user to assign the new device group name. Select a name that uniquely
identifies the group of devices. Enter the device group name into the Name field.

Page 3-18 Revision 1.9.2 OVERTURE MEDIA MANAGER



everl’_z® Overture Suite 2.3 Software Manual

L o

Hew Device Group

General | Members

Mame:

Zancel

Figure 3-26: General Tab — New Device Group
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The Members tab enables the user to assign members to the new device group. To add a member to
the device group, select the Members tab and view the list of available members. Place a check mark
beside the member(s) that you wish to add to this device group and select the OK button.

L o

Hew Device Group

zeneral | Members

Members:

v 96Z5LGA
HOe 7 250G

Zancel

Figure 3-27: Members Tab — New Device Group

3.3.1.3. Upgrading Device Firmware in the Configuration Panel

The device firmware in the Configuration Panel can be upgraded using Overture. To access the device
firmware, select a device from the Configuration list and right-click the mouse button. To upgrade the
firmware, the user will select the Upgrade option. An upgrade window will appear and the user will
then select the location of the BIN file required to upgrade the firmware.

3.3.2. Using the Remote Media Panel

The Remote Media pane enables the user to manage the media on the device. The Remote Media
pane provides access to view media, configure security, upgrade firmware and configure properties.
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3.3.2.1. Device Configuration

The Remote Media panel enables the user to manage the media on the keyer.

When a device from the My Devices option is selected from the Configuration pane, the user is
provided with a variety of options in the Remote Media pane to manage and configure the device, as
shown in Figure 3-28.

Remake Media

HD9725LG
182168 1. 125

This is the main page for your device named ‘HOS726L05"
This page provides convenient access to commaonly used features. Simply click on
a link ar an image to access that feature.

pmn Yiew Media
3 Retrieve and display media information for this device,

__-

—_—

Configure Security
Administration of device users and passwards.

Configure Praperies
Configure properties far this device

Firmware Upgrade
Flash this device with a factory provided image.

b I

Figure 3-28: Remote Pane — Device Selected

e View Media: This option enables the user to receive and display media information for the
selected media device. Overture will establish a connection with the device, and
receive media information from the device.
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e Configure Security:  This option enables the user to access the security information for the
device.

e Configure Properties: This option enables the user to set or modify the device properties.

The properties dialog box is divided into three tabs: General, Member Of and Upload Folder.
See section 3.3.1.1.1 for more information on the properties menu.
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3.3.2.2. Device Group Configuration

The Remote Media panel device group configuration enables the user to easily access the device
group properties and configuration. When the user has highlighted an existing device group from the
My Device Group item in the configuration panel, a list of options will appear in the Remote Media
window. The name of the device group will be listed in the remote panel and the Configuration

Properties, Group Upload, and Group Firmware Upgrade options will be listed, as shown in Figure
3-29.

Remate Media

Control Room

This is the opening page for your device group named 'Control Room'. This page provides
guick access to commonly used features. ¥ou may choose to customize the group
praperties, upload media or upgrade all devices in the group. Simply click on an image aor
a page link to access any of the features listed below.

. Configure Properties
q . Modify various configuration settings for this group

L Sroup Lpload _ _ -
Upload one or more media elements to all devices in this group.

N Sroup Firmware Upgrade
ﬂ Flash all devices in this group with a provided firmware image.

Figure 3-29: Remote Pane — Device Group Selected

e Configure Properties: This option enables the user to set the properties of the device group.
Upon selecting this option, the user will be presented with a properties
dialog box, as shown in Figure 3-30.
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The first tab in this dialog box is the General tab, which enables the user to modify the existing
device group name, as shown in Figure 3-30.

-

Froperties: Control Room

=,

General | Members

Mame: Conkral Room

Ik

] [ Cancel

Figure 3-30: General Tab — Device Group

The second tab enables the user to select the members from a list of existing devices, as
shown in Figure 3-31. By placing a check mark in the box beside the desired device, the user

will assign the selected device to the device group.
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Properties: Control Room

General | Members

Members:

L Rt
HO97Z5LG

[ Ok ] [ Cancel ]

Figure 3-31: Members Tab — Device Group

3.3.2.3. Remote Media Messages - Connecting to the Remote Panel

The following screen will be displayed when Overture is trying to establish a connection with the device
and receive media information.

Receiving Media Information
Cne moment please. ..

Figure 3-32: Attempting to Establish a Connection

If Overture cannot connect to the device, a connection error screen will be displayed as shown in
Figure 3-33. If the device is not connecting, check the properties settings to ensure that the device is
configured correctly. The user can launch the properties settings by selecting the properties link from
the connection error screen as shown in Figure 3-33.
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Communication Error
Cwerture encountered an error trying to
communicate with this device.

hain Page

Figure 3-33: Connection Error Screen

If the user is trying to connect to the device but they do not have access, the following Authentication
Failed screen will be displayed as shown in Figure 3-34. This screen indicates that the logged in user
does not have ftp permissions to the selected device. In order to access this device they must login as
an authorized user, or the user must have the administrator grant them access to this device. See
sections 2.2.3.1 and 2.4.2.3 for more information on setting permissions.

Authentication Failed

Pleaze check your user profile settings to ensure that you have specified the
carrect username and password to send for authenticating with this device.

hlain Page

Figure 3-34: Authentication Failed Screen
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3.3.2.4. Remote Panel Menus

When a device has established a connection with Overture, the Remote Media panel will display a list
of the media currently loaded on the device, as shown in Figure 3-35.

Overture Media Manager E]@
File Edt Control Tools Wiew Help
Configuration X | | Remate Media | [ Media B
= Ef S a2 Folder | C:\Documents and |
‘»:3 Canfiguration Folders | Showing 1 Folder :VJ: Narme 9
=3 Devices 5 %
e 9725 (192,168,2.134) W Video Active Logios
i &= Hamedropper (192.168.8.71) Marne Size Cache Size Skakus Standard Flacement Lacation __] bridge.evl 2163
= Groups || CityScape.evl 11.9
=5, Sample |
& Namadiciie Logos || edock.evl ‘jé
|1 HDEMaple2 94,1 kB 364.0 kB (-64, 213 [cardi] || evertz logo best 7.6
] HOESkationz 280.4 kB 640,0 kB {960, 213 [card1] ] het 90,2
|| MLago 9.8 ME 13.1 ME Cached (-84, 213 [cardi] __| headline_test 337.7
] SDELine 2011 kB 512.0 kB [-24, 182) [card1] ] tmaget 42,8
|| 'SDEMaple 12,9 kB 256.0 kB (-z4, 223 [cardl] ] hi1 225.2
|| SDEStation 81,7 kB 354.0 kB (232, 22) [cardl] | uhiz 256.3
] idhiz a0.2
|| my_projectl 90,2
|| my_projectz 337.7
|| my_project3 354.2
|| testevd £
|| testl.evl
| ] test31
|| test3z
|| best41
| || L] test42
General ] tests
T v T . 3 T || tests1
Media Cache  [I] Used: None I Cached: 13,1 ME (D.16%) [ Free: 5.0 GB (92.84%) g
5.0G5 |:| Required: {no selection) &l | [
1 My coni v v |y ok
Status Window x
%
Camrmand Media Status Size: Rate
['Lag | Transfer Queue

Figure 3-35: Remote Panel
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To access the media menu in the remote panel, right mouse click on a media item in the Remote Media
pane. The Remote Media menu provides the following options:

Dowwnload

Download To r

Media Cue
Media In
Media Ouk
Media All Cuk

faroup Cperation »

Cpen
Dpen With Motepad
Dependency Check,

Schedule, ..

pload...
Upgrade. ..

Delete

Figure 3-36: Remote Media Menu

o Download enables the user to download media to the media pane.

¢ Download To enables the user to download the selected media to the locations listed in the
drop down menu.

o Media Cue enables the user to cue a media file on the selected device or device group. This
will load the selected media file into the device’s memory cache and output on the preview
output of the device.

o Media In enables the user to fade in the selected media file. If the logo has not been loaded
into the device’s memory cache, this action will load the media file and fade it into the video
signal.

¢ Media Out enables the user to fade the selected media file out of the video signal.

e Media All Out enables the user to fade all of the media files out of the video signal. If multiple
devices are active this command will fade out all of the media.

e Group Operation enables the user to perform a media operation on a group that the device is a
member of (only visible if device is a member of a group).

¢ Open enables the user to open the media with its default editor in OMM (only works with text
and playlist files).
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e Open With enables the user to open the media with the default application used to open the
selected type of file from within Windows.

e Dependency Check enables the user to scan the media on the device to check for any
dependent media or missing files. This check scans for playlists, logos, text files, etc. The
dependency check determines the status of the files that the selected file depends on. For
example, if the user selects a crawl and the font or text file associated with the crawl is defined,
this check will determine its status and identify whether the crawl will be refused due to missing
files.

e Schedule... enables the user to program and schedule the selected media item. When the user
right-clicks on the desired media item in the remote pane and selects the Schedule... option
from the drop down menu, a calendar dialog box will appear, as shown in Figure 3-37. The
user has the ability to schedule the selected media to play on certain days, months, years and
times.

0 Schedule Start Date: The user can select a day, month and year from the calendar
which determines when the selected media will begin to playout.

0 Scheduler End Date: The user can select a day, month and year from the calendar
which determines when the selected media will end.

0 Weekday Mask: If the user wants to play the media on a certain weekday, they can
place a check mark beside the appropriate day of the week.

o Event Information: The user can identify the exact time in hours, minutes, seconds,
and frames in which the media is to begin and end playing. The duration will be
displayed once the start and end times are designated.

Placing a check mark beside the Loop Media check box will enable the media to repeat
for the amount of time that the user designates using the Media In Duration and Media
Repeat Interval fields.
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Create Schedule

General

|December |

Schedule Start Date

2008

Sl i
78 9 10
14 15 18 17
21 22 23 024
Z8 29 30 31

December ||

Sun Mon Tue Wed Thu

4
i1
18
25

Schedule End Date

2008

Fri

12
19
26

Sat

13
20
ZF

<p

It wgs 13
78 9 10
14 15 I8 17
21 22 23 24
Z 29 30 31

Enable Schedule

Sun Mon Tue Wed Thu

4
11
18
5

Fri

12
19
26

Sat

13
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Weekday Mask

Activate schedule on selected weekdavs,

Event Information

Enter ktimes in hours, minutes, seconds and Frames
Ewent Start Time: 0o 0o o0, 00
Event End Time: 0o 0o:o0, 00

Event Duration:

[Loop Media

All Day

[8].4

] I Canicel

o Paste enables the user to paste the selected media file.

Figure 3-37: Create Schedule Window

The user can also copy a file without

accessing the media pane. To do so, the user must navigate to the appropriate file on the
connected computer, copy the file (right-click and select copy or highlight and Ctrl+ C) and then
use the paste command to paste the file in the appropriate location in Overture.

e Upload... enables the user to upload a media file to the selected device. The upload option will
open the “Select Destination Folder On Device:” dialog box, as shown in Figure 3-38. This
window displays the cards on the device that the user can upload files to.

Page 3-30

Revision 1.9.2

OVERTURE MEDIA MANAGER



everl’_z® Overture Suite 2.3 Software Manual

Select Destination Folder On Device: HD9725LGA x|

Select the destination folder where you would like
to upload the selected media to.

Name |
[cardi]
[NAS]

OK | Cancel

Figure 3-38: Upload Dialog Box

e Upgrade... enables the user to upgrade the device firmware. See section 3.3.1.3.
e Delete enables the user to remove the selected media from the device.

When a media file is not selected in the Remote Media pane, right clicking in the remote pane will
reveal the following menu:

Check Bypass. ..
Evpass
Femove Bypass

Format. ..
Index...

Security. ..

Upload. ..
pgrade. ..

Refresh

Properties

Figure 3-39: System Files Menu

e Check Bypass State... allows the user to check if the device is running in Active Video or in
Bypass mode. When this option is selected a dialog box will notify the user as to what mode the
unit is in. If the unit is in Bypass Mode, it will notify the user that the ‘Relay is Active’ and when
the unit is not in bypass mode it will display “Relay not active”.
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Bypass enables the user to initiate remote bypass mode. Selecting this option will put the
device into bypass mode. The remote bypass feature triggers the relay built into the keyer
output with any processing in between (ie. Disables the keyer logo functionality). When this
option is selected it will trigger the Keyer to run in Bypass mode and not in Active Video.

Remove Bypass... enables the user to take the unit out of Bypass Mode and back into Active
Video mode.

Format... enables the user to format the compact flash disk.

Index... enables the user to retrieve the "thumbnails” for the media on the device. A thumbnail
will be created using an image from the selected media. This thumbnail will be displayed in the
remote pane. Thumbnails will only be displayed if the thumbnail mode is selected by choosing
View/Thumbnails or clicking on the Thumbnail button in the Remote Media View. When the user
selects the Index option, the Metadata being downloaded will be displayed in the Status window
console, as shown in Figure 3-40. After this download completes the user will be able to
preview the thumbnails. Please note that the image may be distorted in the thumbnail preview,
as Overture is forcing the image into a 4.3 ratio square.

| Skakus Window
”Cnmmand |.Meu:|ia l Status |.5ize .Rate
Metadata Retrieving metadata. .. (62%) 494 B

E Log | Transfer Queue - 1

Figure 3-40: Downloading Metadata

Once the user retrieves the thumbnails by using the index command, the thumbnails will be
displayed in the Remote Media pane, as shown in Figure 3-41.
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Remate Media
Folders |Showing 3 folders =]
M yides Active 1 Element Active

Ployout Cache [l Used: 11.4 M8 (0.14%) Il Coched: 20.1 M6 (0.25%) [l Free: 5.0 GB (39.62%)
8.0GE [ required: (no selection)

Figure 3-41: Remote Media Pane with Thumbnails Present

e Security... this dialog enables the user to add and remove FTP accounts for the selected
device. To add a new FTP account to the device, enter the username and password into the
appropriate fields and then click the ‘Add’ button. To remove an account, select the FTP
account in the list then click the ‘Remove’ button.
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Device Security ] ﬁl

~ »I
i H

I Password I

Username:

l
Password: [
[

Confirm Password:

OK | Cancel |

Figure 3-42: Device Security

&5

See section 2.2.3.1 on how to configure Overture users.

Overture Media Manager needs to know which FTP account to use when it tries to
connect to a device. To do this the user must configure a FTP username and
password with the username that was used to login to Overture Media Manager.

e Paste enables the user to paste the selected media file.

The user can also copy a file without

accessing the media pane. To do so, the user must navigate to the appropriate file on the
connected computer, copy the file (right-click and select copy or highlight and Ctrl+ C) and then
use the paste command to paste the file in the appropriate location in Overture.

¢ Upload... enables the user to upload a media file to the selected device.

e Upgrade... enables the user to upgrade the device firmware. See section 3.3.1.3.

¢ Refresh option enables the user to retrieve the most current version of the file.

o Properties enables the user to display the device properties.
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3.3.2.5. Remote Panel Views

The Remote Media panel window has three views: Details, Compact, and Thumbnails. The view can
be set using the View main menu as described in section 3.2.5 or using the view buttons displayed in
the Remote Media pane, as shown in Figure 3-43.

]

Figure 3-43: View Buttons

The Compact button = enables the user to list the files in compact mode. Only the filename will be
listed, as shown in Figure 3-44, when the Remote Media Pane is in compact mode.

| Remote Media
| —

aa

30 s Y Showing 3 Folders

M video Active Mo Active Media
{100 123 1147 q BEL 4 312.pst
||] .DS_Store 124 _q | ]148q Jz8 1313
I L] Ot L1125 q L1149 g 129 “L313.pst
|1 01.pst _]126. g L] 15.ed ] 2temp L] 314
3 02 _1127_q _]150q ] 2templ L1315
|' 02.pst J128.q #. 168_q.pst 2] 3.7GA L] 3musk
[Ld o3 1129.g ] 16KB 130 ] 3muskat
i L] 03 1130 q |_] 16KB-SD L] 300 2] 4.TGA
| ] 03.evl L1131 q L 16KB.pst L] 301 ] 48.evl
|7 03.pst L]132_q =] 16KB.bxt L] 302 2] 5.tga
| “ 03.pst L1133 q L] 19 “L 302.pst L] so01
{|.]0s 1134.q RE: 1303 ] s02
0L 112 1359 [J20 1304 503
_Jtlizq 11369 a] 20.tga 1305 L] 504
| L] 113 L1137 q “. 20.tga.pst 308 ] 508
[IL] 113 q 11389 2] 20.tga.kxt _ 307 ] 506
[ 114 _1139.g LJat 308 _] 507
! | 1140ShdwipeLeft 1140 g L] 22 1309 L B07.pst
__] 11405hdwWipeUp 141 g ] 22.7GA Bk 8] 6.tga
|__' 119 q L] 142_q Lz _1310 L]és
[ 12 _1143.q L]23 4. 310.pst _]6s
I t20_q ] 144_q [ 24 L] 311 # 85.pst
| L] 121 _]145 g k- . 311.pst L] 66
|IL] 1229 ] 146_g L]26 1312 L] 66
o | 2
i_ General
I
Playout Cache  [I] Used: None W Cached: None [B Free: 8.0 GB (100.00%)

8.0 GB

O] Required: {no selection)

Figure 3-44: Remote Media Pane in Compact Mode
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When in Details mode

, the user is able to list the following details of the files in the Remote Media

pane:
0 Name: This item identifies the filename of the file listed on the Remote Media pane.
o Size: This item identifies the file size/disk size of the file.

o Cache Size: This item identifies the file size of the cached information. This file size is usually
bigger than the disk size.

Please note that media with a “Not Available” value listed in the Cache size
,@5 indicates that this item is not available for cache because Overture may not be
able to read the standard.

0 Status: This item informs the user if the specific file is cached or not cached.

o Standard: This item informs the user of the video standard that the file was created in
(using Overture Media Designer).

o Location: This item identifies the location of the file on the device.

| Remaote Media

= 3B
Folders |Click here to select a Folder ko display =
| M video Active Na Active Media
|| Name | Size I Cache Size | Status | Standard | Location | :i
[
Logos
o 27.1 kB 256.0 kB [cardd]
L] ot 15.8 MB 24.3MB Cached 1080if60 [cardd]
] 02 7.6MB 11,4 MB Cached 1080860 [cardl]
L] 03 432.1 kB Mot available [cardd]
[ o3 164.6 kB 512.0kB 1080if60 [NAS]
] D3evl 3.7 MB 765.0 kB [cardi]
06 243.1 kB 8960 kB [carda]
BEH 7.6MB 11.4MB Cached 108060 [cardl]
L]112.q 7.6 ME 11.4 ME Cached 108060 [card1]
113 7.6MB 11.4 MB Cached 108060 [cardl]
_J113.q 7.6 MB 11,4 MB Cached 1080I{60 [cardl]
] 114 7.6 MB 11.4MB Cached 1080if60 [cardi]
] 11405hdwipeleft 339.4 kB 1.1 MB 1080if60 [cardl]
] 11405hdwipeUp 339.4 kB 1.1 MB 1080i{60 [cardl]
Ju19.q 7.6 MB 11.4 MB 1080if60 [cardl]
| ]12 133.3k8 384.0 kB 1080i60 [MAas]
1 120.q 7.6MB 11.4MB Cached 108050 [card1]
1121 _q 7.6MB 11.4 MB Cached 108060 [cardl]
11229 7.6 MB 11.4MB 1080i/60 [cardl]
1239 7.6MB 11.4 MB 1080if60 [cardl]
] 124 q 7.6MB 11,4 MB 1080§/60 [cardl]
L] 125 q 7.6 MB 11.4 MB 1080660 [cardi]
L] 126 q 7.6MB 11,4 MB 108060 [cardl]
[[1177 n 7.6 MR 11.4 MR INANITAN Traedi1] _.‘l]
General
Playout Cache  [I] Used: None [l Cached: 154.1 MB (1.88%) [l Free: 7.8 GB (98.12%)
| 6.0GB [[] Required: {ro selection)

Figure 3-45: Remote Media Pane in Details Mode
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o
The Thumbnail button ;I enables the user to display the thumbnails for each file in the Remote
Media pane, as shown in Figure 3-46. The user must first index the device before the thumbnails can
be displayed. The thumbnail view provides the user with a static preview image of the logo. Please

note that the image may be distorted in the thumbnail preview, as Overture is forcing the image into a
4:3 ratio square.

Remote Media

Folders [Showing 3 folders =]
M video Active W L Media Element Active

= d

mm [ used: 114 ME (0. 14%) W cCached: 20.1 M8 (0.25%) B Fre=: 8.0 GB (9.62%)
8.0 GE [C required: (no selaction)

Figure 3-46: Remote Media Pane in Thumbnail Mode
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3.3.2.6. Folders Drop Down Menu

The Remote Media pane has a drop down folder menu, which enables the user to display the contents
of the selected folder in the Remote Media pane. For example, Figure 3-47 displays that the user is
accessing the Folders drop down menu for the selected device. The device has three folders. Since all
of the folders are selected, the device will display all of the media items from all of the folders in the
Remote Media pane. If the user only wishes to display the contents of one of the folders, then there
would only be one checkmark placed beside the appropriate folder and only the media contained in that
folder would display in the Remote Media pane.

| Remote Media

L] o1

L] o2

L ]o3
[Jo3

| 03.ev
_Jos

L] 112
L]112.q
[]113
_]113.q
L1114

| 1119 q
L] 12

L1120 q
1121_q
L ]122_q
(1123 q
] 124_q
L1125 q

119 -

| Playout Cache [l Used: None

8.0 GB

o |

v [card0]
v [cardl]
¥ [nas]

| 1140ShdWipeLeft
| 11405hdWipeUp

General

15.8 MB
7.6 MB
164.6 kB
432.1 kB
3.7 MB
243.1 kB
7.6 MB
7.6 MB
7.6 MB
7.6 MB
7.6 MB
339.4 kB
339.4 kB
7.6 MB
133.3kB
7.6 MB
7.6 MB
7.6 MB
7.6 MB
7.6 MB
7.6 MB

T £ MDD

] required: 411.4 MB (5.029%)

Tk | status | standard | Location | |
—
256.0kB [cardO]
24.3MB 1080i/60 [cardn]
11.4 MB 1080i/60 [card1]
512.0kB 1080i/60 [Mas]
Mok available [card0]
768.0kB [cardl]
896.0 kB [card0]
11.4 MB 1080if60 [cardl]
11.4 MB 1080ij60 [card1]
11.4 MB 1080if60 [card1]
11.4 MB 1080if60 [cardi]
11.4 MB 1080i/60 [card1]
1.1 MB 1080if60 [cardl]
1.1 M8 1080i/60 [card1]
11.4 MB 1080if60 [cardl]
384.0kB 1080if60 [MAs]
11.4 MB 1080if60 [card1]
11.4 MB 1080i/60 [cardl]
11.4 MB 1080i/60 [card1]
11.4 MB 1080if60 [card1]
11.4 MB 1080ij60 [card1]
11.4 MB 1080i/60 cardl |
11 A LMD 1nan:Ln Erin']l ;1
B Cached: Nore [ Free: 8.0 GB (100.00%)

Figure 3-47: Folders Drop Down Menu
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3.3.2.7. Monitoring Media

Overture Media Manager enables the user to monitor the status of the media being loaded onto the
device. The buttons located under the Folders drop down menu enables the user to view the status of
the media on the keyer. As shown in Figure 3-48, when the keyer is running active video the Video
Active button will display the text “Video Active” and the button will be illuminated green. However,
unless the element is actively running, the button beside it will be grayed out and will read “No Active
Media”.

Remote Media

-
-

Fol ck here to select a Folder to display d
< M yideo Active lo Active Media

Figure 3-48: “Video Active” Button

When the Video Active button is green and the button beside it is blue, the blue button will indicate the
number of media elements that are currently active. For example, Figure 3-49 indicates that there are
“3 Media Elements Active”.

Remate Media

Erl
-

Folders |‘5r'¢w 3 j
M video Aftive I 1 Media Element Active
\_/

Figure 3-49: “Media Elements Present”

When media elements are active, the active elements will be highlighted in the Remote Media pane, as
shown in Figure 3-50.

An active media element that is highlighted red in the Remote Media pane indicates that the media is
on air. The media will be on both the preview and program channel.

An active media element that is highlighted orange in the Remote Media pane indicates that the logo is
cued and it is on the preview channel.

If a playlist is loaded on the device, the user can see the status for the entire playlist. For example, if a
playlist is cued then all of the media in that playlist will be cued and highlighted in the Remote Media
pane.

OVERTURE MEDIA MANAGER Revision 1.9.2 Page 3-39



Overture Suite 2.3 Software Manual everl'_zO
|

Folders |Cli|:k here to select a folder ko display j
M video Active W 11 Media Elements Active
| Name - [ size | Cache Size | Status | standard | Location | ]
Logos
164.6 kB S12.0kB 1080if60 [MAs]
| 00 27.1 kB 256.0 kB On-Air [card0]
15,8 MB 24.3MB Cached 108060 [cardn]
On-Air f [cardl]
L]03 432.1 kB Mok available [card0]
W 03.evl 3.7™MB 768.0 kB On-Air [card1]
| 06 243.1 kB 896.0 kB On-Air [card0]
Ld 7.6 MB 11.4 MB On-Air 1080i/60 [card1]
B 112 g 7.6 MB 11.4 MB On-Air 1080i/60 [card1]
| 113 T.6 MB 11.4 MB On-Air 1080i/60 [cardl]
B 113 7.6 MB 11.4 MB On-Air 1080i/60 [cardl]
il 114 7.6 MB 11.4 MB On-Air 1080i/60 [cardl]
] 11405hdWipeLeft 339.4 kB 1.1 M8 1080i60 [cardl]
__| 11405hd'Wipellp 339.4 kB 1.1 MB 1080y60 [cardl]
Ll119.q 7.6MB 11.4 MB 1080if60 [card1]
[]12 108060
B 120_q 11,4 MB Cue'd 1080i/6
B 121 q 11,4 MB Cue'd 108
L ]122_q 7.6MB 1.4 MB 1080if60 [cardi]
L] 123 q 7.6 MB 11.4 M8 10&0i60 [cardl]
L1124 q 7.6 MB 11.4 MB 1080i60 [cardl]
L]i25 g 7.6ME 11.4 M8 1080|860 [cardl]
L1126 q 7.6MB 11.4 MB 1080760 [cardl]
[{ 1127 n 7.6 MR 11.4 MR INRNIfAN lrard1] Ll
General |
Playout Cache  [I] Used: 92,9 MB (1.13%) B cached: 63.1 MB(0.77%) B Free: 7.8 GB (98.10%)
8.0 GB [ required: (no selection)

Figure 3-50: Active Media Elements

When the video is in bypass mode, the monitoring button will be red and display the text “Video
Bypassed”, as shown in Figure 3-51.

ck here to select a folder to display ;I
12 Media Elements Active
Size  ~ | theSizeIStaMs | standard | Location I ill
sidepanelS.evl
__| right wing.evl 884.5MB 1.3GB [NAS]
] left wing.evl 874.3 MB 1.3GB [MAS]
__| potter2 S81.4MB  Not available [card1] :I
| General

Figure 3-51: Media in Video Bypass Mode
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3.3.2.8. Configurable System Logos

Logos can be designated as "system" logos, in which case Overture displays the logos under the
System tab. Each logo in the system view is marked as either present or missing. System logos that
are present will appear in standard black font. System logos that are not present (missing) will be
bolded in red and the status will be listed as Deleted.

| Remote Media |

= |
Folders |Shu:uwin-;| 3 folders j
™ video Active M 3 Media Elements Active
|| Mame I Size I Cache Size I Skatus I Standard I Location I
Logos
| 00 27.1 kB 256.0 kB Deleted [cardD]
Lo 15,6 ME 24,3 ME 1080ifa0 [cardn]
L] oz 7.6 ME 11.4 ME 108060 [cardi]
(] 03 164.6 kB 51z2.0 kG 108060 [Mas]
L] 03 4321 kB Motk available [cardd]

| General | System

Playout Cache . sed: 14,1 MB (0,17%%) . Cached: 1.5 GB (18.83%:) . Free: .5 GE (80,99%:)
8.0 GE |:| Required: {no selection)

Figure 3-52: System Logo Window

The Overture Media Manager application can maintain a separate System logo XML database for each
piece of hardware, thus allowing for independent configuration. The XML database is name and
location configurable. Using the Browse button in the Device Properties window, the user can
configure a separate XML file for each hardware device (see section 3.3.1.1.1). Please note that the
same XML file can also be reused for each hardware device. Once the system file is specified,
Overture configures the XML file by right-clicking the desired file from the General tab of the Remote
Media pane and selecting “Add To System Config” or selecting the “Remove From System Config”
option provided in the edit menu. Refer to the System File item in section 3.3.1.1.1 for further
instructions on configuring a system file.
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3.3.2.9. Playout Cache Bar

Overture Media Manager enables the user to view the playout cache on the keyer. The following
playout cache meter is displayed in the Remote Media pane and determines the amount of playout
cache being used.

The orange bar indicates the amount of playout cache that is being used on air.
The blue bar indicates the amount of playout cached in the memory.
The green bar indicates the amount of playout cache available.

The light blue bar indicates the amount of playout cache required to load the file. The
required bar is displayed when the media has not been cached and will usually only be
shown if the file is large in size.

Playout Cache . Used: 104.3 ME (1,27%:) . Cached: 74.5 MB (0.91%:) . Free: 7.8 GB (97 .82%:)
5.0 GB [] required: 1.9 GB (23.63%)

Figure 3-53: Playout Cache

The following table outlines the playout cache calculations. Please note that all video standards will be
calculated using 30fps except for the 625 video standard, which will use 25fps.

Logo Total , . . Mapmgm
. , Overture Size Maximum Quantity Animation
Size Pixels
(seconds)
YCbR RGB YCbR RGB YCbR RGB
Format | Format | Format Format | Format | Format
512 MB PLAYOUT CACHE
525 Video Standard
1/9 38880 228 152 2301 3452 77 115
1/4 87480 513 342 1023 1534 34 51
full 349920 2050 1367 256 384 9 13
625 Video Standard
1/9 46080 270 180 1942 2913 78 117
1/4 103680 608 405 863 1295 35 52
full 414720 2430 1620 216 324 9 13
720p Video Standard
1/9 102480 600 400 873 1310 29 44
1/4 230400 1350 900 388 583 13 19
full 921600 5400 3600 97 146 3 5
1080i Video Standard
1/9 230400 1350 900 388 583 13 19
1/4 518400 3038 2025 173 259 6 9
full 2073600 12150 8100 43 65 1 2
2Gb PLAYOUT CACHE
525 Video Standard
1/9 | 38880 | 228 | 152 | 9206 | 13808 | 307 | 460
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1/4 87480 513 342 4091 6137 136 205
full 349920 2050 1367 1023 1534 34 51
625 Video Standard
1/9 46080 270 180 7767 11651 311 466
1/4 103680 608 405 3452 5178 138 207
full 414720 2430 1620 863 1295 35 52
720p Video Standard
1/9 102480 600 400 3493 5239 116 175
1/4 230400 1350 900 1553 2330 52 78
full 921600 5400 3600 388 583 13 19
1080i Video Standard
1/9 230400 1350 900 1553 2330 52 78
1/4 518400 3038 2025 690 1036 23 35
full 2073600 12150 8100 173 259 6 9
4Gb PLAYOUT CACHE
525 Video Standard
1/9 38880 228 152 18411 27617 614 921
1/4 87480 513 342 8183 12274 273 409
full 349920 2050 1367 2046 3069 68 102
625 Video Standard
1/9 46080 270 180 15534 23302 621 932
1/4 103680 608 405 6904 10356 276 414
full 414720 2430 1620 1726 2589 69 104
720p Video Standard
1/9 102480 600 400 6985 10478 233 349
1/4 230400 1350 900 3107 4660 104 155
full 921600 5400 3600 777 1165 26 39
1080i Video Standard
1/9 230400 1350 900 3107 4660 104 155
1/4 518400 3038 2025 1381 2071 46 69
full 2073600 12150 8100 345 518 12 17
8Gb PLAYOUT CACHE
525 Video Standard
1/9 38880 228 152 36822 55234 1227 1841
1/4 87480 513 342 16366 24548 546 818
full 349920 2050 1367 4091 6137 136 205
625 Video Standard
1/9 46080 270 180 31069 46603 1243 1864
1/4 103680 608 405 13808 20713 552 829
full 414720 2430 1620 3452 5178 138 207
720p Video Standard
1/9 102480 600 400 13970 20955 466 699
1/4 230400 1350 900 6214 9321 207 311
full 921600 5400 3600 1553 2330 52 78
1080i Video Standard
1/9 230400 1350 900 6214 9321 207 311
1/4 518400 3038 2025 2762 4143 92 138
full 2073600 12150 8100 690 1036 23 35
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3.3.2.10. Remote Media Split View

Once the user has created a new device group and they have added devices to the group, as
described in section 3.3.1.2, all of the media on the devices in the group can be viewed at once. The
Remote Media split view allows the user to view the media state for the selected file across multiple
devices.

In the configuration pane, select the Device Group that you want to view. Once the device group is
selected, all of the media across multiple devices can be viewed in the Remote Media pane. The
Remote Media pane will be split into two views:

e The top view is called Logos and it displays all of the media present on all of the devices in the
selected device group.

o The bottom view is called Selected Media Information and it displays the individual properties
of the item that is selected from the Logos panel.

Configuration ¥ | | Remote Media

ol Mame Status Device

<% Configuration

--( Devices Logos .
£ 9725 (192,168.,2,134) || HDEMaplez 1 Device
£ Mamedropper (192,168.8.71) __| HDEStation2 1 Device
--[5 Groups || MLoga 1 Device
= Samnple || SDELine 1 Device
& 9725 || 3DEMaple 1 Device
&= MNamedropper || SDESkation 1 Device
Selected Media Information
Mame Size Cache Size Skakus Standard Placement Location
Logos
|| HDEStationZ (Mamedropper) za0.4 kB 640,00 kB (980, 217 [cardl]
My Config < .

Figure 3-54: Remote Media Split View
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3.3.3. Using the Media Panel

The Media panel enables the user to manage the media on the devices (see Figure 3-55). When a
folder containing media is selected from the Folders drop down menu, the Media panel will display all
the files stored in the selected folder. The Media pane displays the Data Files, Logos (media
elements), Sound files and Playlists available in the selected directory.

Media x
Folder |, w E]
Marne Size  Date Modif,,,  Date Created  Date Acce...
Data Files
=] temperature. bt 6B O1/17/081... 01/17/081... O0OL/17/081...
Other
=] 2v00_76_96255... 1.7ME OF/11j06 1... 0928/07 ... 05/20/051...
=] AUTOEREC.BAT Mot available 03/20007 1... 0320007 1... 03/20007 1...
=] BDA.cab 636.6KE O7/09/04 1. 07/09/04 1. 08/14/07 1...
=] BDANT.cab 1.AME OF/19)042... 07/19/04Z.. 08/14/071...
=] BDAYP.cab 953 1 kB O7/19/04 2. 07/19/04 2.  08/14/07 1...
=] COMFIG,SYS Mot available 03/20007 1... 0320007 1... 03020007 1...
=] Directs.cab 14.8ME 07/09/04 1., 070904 1., D08/14/07 1...
=] DSETUR. I 61.5kE 07/09/040.. 07/09/040... 05/20/051...
=] dsetupzz,di 2.1 ME 07/09/040,. 07/09/040.. 0520005 1...
=] dxnt.cab 12,7 ME 07/09/04 1., 07/09/04 1... 08/14/07 1...
=] dxsetup.exe 461 5kE 07/09/04 0. 07/09/040... 05/200081...
=] gm.ini 194 B 0321007 1... 03/21/07 1... 10/0L)07 1...
=] hd9728lg-2v13_2... 6.3ME 09/14/07 1... 09/14/07 1... 05/20/051...
=] ManagedDi. CAR 3.3ME 07022004 1... 07/22/04 1. 08/14/07 1...
=] overture-setup-1... 11.6ME 09/19/07 1., 09/19)07 1., 05/20/081...
=] PKGIEZESW_2vil,.. 10225k 09)25/07 1... 09/28/07 1... O08/13/050..,
=] Pkaclnup log 166k 032107 1... 03/21)07 1... 10j01/07 1...
=] PKGHD9GZSSW _, ., 1.0ME 10/01)07 1... 10/01/07 1... 0&/13/080...
=] WLPro-C_10.4.51.., 44.7MB 11012007 1... 11J12/07 1... OS5/200081...
=] ¥LPro_10.4.512.... 191.4 ME 12/03/07 1... 12/03/07 1... O0OS5/20/081...
=] winzip.log 43.8kE 05/26/080... 11/14/07 1... OS/26/080...
My Media | My Bookmarks

Figure 3-55: Media Panel

Select a file in the Media panel and right click the mouse button to access the Media menu for that
item. This menu allows the user to upload, delete or refresh the media displayed in the Media panel.
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The Media menu provides the following options:

Upload
96250G4A (19z,168,1,133) Upload To 3
HOO7 250G (19z.168.1,126) i
Qpen
Skation 1
Delete
Skation 2
Renarme
Refresh

Figure 3-56: Media Menu

e Upload enables the user to upload the selected media to the device listed in the remote panel.

e Upload To option enables the user to upload the selected media to a device or device group
listed in the ‘Upload To’ sub-menu.

¢ Open enables the user to open and edit the selected file. The only file types that can be opened
are text and font files. Based on the type of file, the Open option will open the selected file in
the appropriate editor. For example, a text file (.txt) will be opened in Windows Notepad.

o Delete option enables the user to permanently remove the media file from its location.

e Rename enables the user to change the name of the selected media.

¢ Refresh option enables the user to retrieve the most current version of the file.

Selecting the “Delete” option not only removes the file in Overture, it also
,@f permanently removes it from the directory in which it resides.

3.3.3.1. Using the Right-Click Media Pane Menu

The user can access this media menu by right-clicking anywhere in the media pane.
Mews Bookmark. .
Mew Data File, .,

Mew Falder, .,
Mew Plavlist. ..

Refresh
Properties

Figure 3-57: Right-Click Media Menu

¢ New Bookmark... enables the user to bookmark the selected file.

¢ New Data File... enables the user to create a Crawl or CG Data file. See section 3.3.3.1.1.
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New Folder... enables the user to create a new folder.

o New Playlist... enables the user to create a new playlist. See section 3.3.3.1.2.

o Refresh option enables the user to refresh the page in order to retrieve the most current
contents of the folder.

o Properties enables the user to set the folder properties and the watch specifications. See
section 3.3.3.2.1 for more information on the properties window.

3.3.3.1.1. Adding a New Data File

To add a new data file, select the New Data File... item from the right-click media menu. The Select
Editor (as shown in Figure 3-58) will appear enabling the user to select the data file that the user wants
to create. The user has the option to create a CG or a Crawl data file.

Fa

Select Editor %

Please select the data file bype to be created
fram the lisk provided below,

@ =

Crawl

| Ok I I Cancel

Figure 3-58: Select Editor Dialog Box

Creating a CG Item:

1. If the user wishes to create a CG, they will select Cg item from the Select Editor window and
press the OK button.

2. The CG Editor window will appear, as shown in Figure 3-59. The CG Editor enables the user to
enter text into the Page Contents field. The present pages will be listed in the Pages section.
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[+]Cg Editor
A O

Page Contents

Pages
i &
= -
LS o
Page 1

Cance

Figure 3-59: CG Editor

3. To edit the font style, select the A button. The Formatting window will appear, as shown in
Figure 3-60. The user can select the font type, size and colour.
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-,

Formatting
Fonk
Font: Size: Colour:
i
. . g
@Arial Unicode MS &l A&
ADMUIELG }?
ADMUIESm 1z
1 13
Arial ”
Arial Black =
i 17
Arial Marrowy 18
. . 19
Arial Unicode MS 20
. 21
Avantzarde Bk BT 33
AvrntSarda MA RT M |24 I
Preview:
ABCDEFGabedefgl 2345
[ [0]4 ] [ Cancel

Figure 3-60: Formatting Dialog Box

4. The user can add a bullet by selecting the plus sign button o . Once selected, the Bullet

Properties window will appear, as shown in Figure 3-61.

5. Enter the name of the bullet into the Name field and enter the vertical shift value into the Vertical
Shift field. Press the OK button to create a bullet. The bullet will be displayed in the Page
Contents field beside any text that is entered.

e o

Bullet Properties

Enter the properties for the Bullet,

Marme:

Wertical Shift: i

Y
b

i ] [ Cancel

Figure 3-61: Bullet Properties

6. To edit the properties of the bullet, right click in the Page Content field and the menu shown in
Figure 3-63 will appear. New bullets can be added and edited using this menu. The content
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from the current page can be copied and pasted to another page using the copy and paste
commands in this menu.

Insert Bullet, .,

Set Font...
Paste Chrl+y
Select Al Chrl+4

Figure 3-62: Right-Click Page Content Menu

7. To create a new page, right-click in the Pages field. A drop down will appear, as shown in
Figure 3-63. Using this menu the user can insert a new page, append a page, delete a page,
and move the selected pages left and right.

Insert Page
Append Page
Delete Page

Maove Left
Movve Right

Figure 3-63: Right-Click Page Menu

8. Once all the appropriate information is entered into the different pages, press the Save button to
save the Cg item. A Save As dialog box will appear prompting the user to fill in a data file name.

Please note that all pages created must contain at least one line of content. If a
,@g page does not contain content the user will be unable to save the cg item.

Creating a Data File Crawl:

1. If the user wishes to create a Crawl, they will select the Crawl item from the Select Editor
window and press the OK button.

2. The Crawl Editor window will appear as shown in Figure 3-64. The CG Editor enables the user
to enter text content and bullets into the main field.

Page 3-50 Revision 1.9.2 OVERTURE MEDIA MANAGER



everl’_z® Overture Suite 2.3 Software Manual

Crawl Editor*

% A O

[ Save ] I Cancel

Figure 3-64: Crawl Editor

3. The user can add a bullet by selecting the plus sign button o . Once selected, the Bullet
Properties window will appear as shown in Figure 3-67.

4. Enter the name of the bullet into the Name field and enter the vertical shift value into the Vertical
Shift field. Press the OK button to create a bullet. The bullet will be displayed in the field
beside any text that is entered.

[ = =]

Bullet Properties
Enter the properties For the Bullet.
fame:
YWertical Shift: 1] ==
.v.

[ (8]4 ][ Cancel ]

Figure 3-65: Bullet Properties

Iy
5. To edit the background colour of the crawl, select the Set Background Colour button “ A

Select Background Colour dialog box will appear prompting the user to select the colour (see
Figure 3-66)
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Select Backzround Colour ﬁ

) = |
con = 2
e ———— 25 3]
Opacity —J 100 [@'

Figure 3-66: Select Background Colour

6. To change the font colour, select the Set Text Colour button A and a Select Text Colour dialog
box, similar to the one shown in Figure 3-66 will appear. Select the desire font colour and press

the Apply button.

7. Once all the appropriate information is entered into the field, press the Save button to save the
Crawl item. A Save As dialog box will appear prompting the user to fill in a data file name.

&5

Please note that the editor is unable to display the alpha component at this
time. However, the colour information written into the file will contain this data.
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3.3.3.1.2. Adding a New Playlist

To create a new playlist using OMM, select the New Playlist... item from the right-click media menu.
The Create Playlist window will appear as shown in Figure 3-67. The playlist editor is used to create
playlist scripts. This editor gives access to most of the playlist script features for cueing, bringing IN or
OUT multiple media files, waiting for a time interval or LTC point. The playlist editor will control groups
of media and list items that get accessed sequentially, which essentially controls how the logo will
playout.

Create Playlist

— || Command Parameter

DVE

A

DWE CFf

Py

[T

Media Cus

anas

X

Media In

anax

X

Media Qut

Save ]I Cancel

Figure 3-67: Create Playlist Window

The following is a list of commands that can be added to the playlist:

e DVE: The DVE feature is meant to be used with the QMG device. The user can select the DVE
Layer (either A or B) and set the Move Number.

Select the DNVE layer and move number,
DYE Layver
®@a
@]
Mowe Murnber: 1 =

Figure 3-68: DVE Parameters
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o DVE Off: The DVE Off feature enables the user to turn off one of the DVE layers (A or B).

Select the DVE layer ta kurn off,

DYE Lawver
®a
@]

Figure 3-69: DVE Off Parameters

e Media Cue: The command enables the user to cue a media file on the selected device. This
will load the selected media file into the device’s memory cache and output on the preview
output of the device.

| Cuskam Media |; Custom

Select the media name from the list provided below Enter the media name

Figure 3-70: Media and Custom Tabs

e Media In: This command enables the user to fade in the selected media file. If the logo has not
been loaded into the device’'s memory cache, this action will load the media file, fade it into the
video signal and display it on both preview and program outputs of the device.

e Media Out: This command enables the user to fade the selected media file out of the video
signal.

e Wait For: This command enables the user to set the wait mode and wait value. The user can
set the wait mode by selecting either Fields, Frames or Seconds. Once the wait mode is
determined, enter in the wait value.
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Select the wait mode and enter the value ta wait,

Wik Mode
(¥} Fields
) Frames
) Seconds

Wait Walue: | 0

e
w

Figure 3-71: Wait For Parameters

e Wait Out: This command waits for the playlist to be taken out.

e Wait Until Timecode: This command enables the user to set the timecode value. The user can
enter the hours, minutes, seconds, and frames for the timecode value.

Enter the timecode walue in hours, minutes, seconds and Frames.

00 hours ;00 minukes ; 00 seconds . 00 frames

Figure 3-72: Wait Unit Timecode Parameters

3.3.3.2. Using the Folders Drop Down Menu

The Folder drop down menu enables the user to navigate through the files on the user’s system. The
Folder menu provides access to all of the drives on the users computer. Use the Plus (+) and Minus (-)
buttons to navigate to the desired directory. The contents of the selected directory will be displayed in
the Media pane, if media files do not exist in the selected directory then the Media pane will remain
blank.
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Media

o
Folder |iA: E]

i My Campuker sked
R
= <
i D
== L:
i M
=
=
= Z:

O O oy O O O B

£ pJ
My Media | My Bookmarks

Figure 3-73: Folders Panel

To access the folders menu, right mouse click on a folder in the folders panel. The following menu will
appear:

Mew Bookmark. ..

Mew Folder, ..
Mew Playvlist, .

Delete

Refresh
Properties

Figure 3-74: Folders Menu

e New Bookmark... enables the user to bookmark the selected file.

o New Folder... enables the user to create a new folder for bookmarks.

o New Playlist... enables the user to create a new playlist. See section 3.3.3.1.2.
¢ Rename enables the user to rename the selected folder.

e Delete enables the user to remove the selected folder.
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Refresh enables the user to refresh and retrieve the latest information for that folder.

e Properties enables the user to set the folder properties and the watch specifications. Selecting
the properties option will open a Folder Properties dialog box, as shown in Figure 3-75. See
section 3.3.3.2.1 for more information on the properties window.

3.3.3.2.1. Media Properties Window

Selecting the properties item from one of the drop down menus will provide the user with the following
information.

The General tab enables the user to assign the selected folder a unique name to easily identify the
contents of the folder (see Figure 3-75).

= =]

Folder Properties

General | \Wakch

MName:

Location: al

Cancel

Figure 3-75: General Tab — Folder Properties

The Watch tab enables the user to set the watch properties for the folder.

To enable monitoring on a folder, place a check mark in the box beside “Watch This Folder” and
select the device or device group to which the output files from the movie compilation process
will be uploaded to. Refer to Figure 3-76.

Enabling monitoring forces Overture Media Manager to watch for changes in the selected
directory. When Overture Media Manager detects a change it will automatically perform the
action associated with the type of file that was found. When the action is complete it will upload
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the final output to the specified device or device group. See section 3.3.3.2.2 for more
information on enabling a watch action on a folder.

P o

Folder Properties

General | Watch

Watch This Folder

Loak For: |Movies (%, avi; *.mov) v |

Auko-Renarns

When the watched file bype is copied into this folder compile using the
Following settings

Compile Settings
Produck 9725 Series Kevers hl
Wideo Standard | 1080i-59.94 v

Cutput Format () RGE () ¥Chr
After a successful compile upload bo:
[ ] Do Mot Upload

Devices
9725

Cancel

Figure 3-76: Watch Tab — Folder Properties

e Look For: The Look For drop down menu enables the user to select the file type that the folder
is supposed to watch for. The drop down menu in Figure 3-77 provides a list of the available file
types that can be watched.

(0]

o
o
o

Movies will be compiled into Evertz Logos.

Images will be compiled into Evertz Logos.

Text Files will be renamed (if option is set).

CSV Files will be used to construct any data files that use the found csv file as the data
source.
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Watch This Folder

Loak Far: | Movies (%, avi; *.miow) W

Mavies [*.avi; *.mov]
Images (* bmp;*.jpg;*.jpeg;*. jpe;*.jp2;*. png; *.taa;*. targa;
Texk Files (*.kxt)
Z5Y Files (*.csv)

Figure 3-77: Look For Drop Down menu

¢ Auto Rename: The auto-rename function will only be available when the Look For drop down
menu is set to look for text files (.txt). The auto-rename feature will be greyed out when any

other file type is selected.

0 Rename To: When a check mark is placed beside the Rename To item, the user can
enter a filename into this field. Using the Auto-rename feature enables the user to
automatically rename a text file when it is placed in the selected folder. When the
watched file type is copied into this folder, the file will be renamed using the name you

entered in the Rename To field.

Watch This Folder

Lock For: | Texk Files (*.kxE) W

Auko-Renarns

When the watched file byvpe is copied into this Folder rename
the File ko the Follawing name,

Rename To:

Figure 3-78: Auto-Rename Section

o Compile Settings: The Compile Settings function will only be available when the Look For drop
down menu is set to look for Movie files or Image files. When the file types being watched are
copied into this folder, the files will be compiled using the settings specified in this section.
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Watch This Folder

Loak For: | Movies (%, avi; *.mow W

Auto-Rename

Whien the watched file type is copied into this Folder compile using the
Following settings

Compile Settings
Product |97Z25 Series Kevers w
Yideo Standard | 1080i-59,94 w

Cutput Format () RGE (O b

Figure 3-79: Compile Setting Section

0 Product: Using the drop down menu select the appropriate product series that you are
using. Figure 3-80 outlines the available product options.

Q725 Series Kevers b

7712 Series Upconverters
7725 Series Kevers
725 Series Kevers

Figure 3-80: Product Selection

0 Video Standard: Using the drop down menu select the desired video standard to be
used when the files are compiled. Figure 3-81 provides a list of the available video
standards.

1050i-59.94 w

525
16x9 525
625

16x9 625
720p-50
720p-59.94
720p-60
1080i-50
1080i-59,94
1080i-50
1080p-23.98

Figure 3-81: Video Standard Drop Down Menu

o Output Format: This feature enables the user to select whether the media will be
output as RGB format or YCbCr format.
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3.3.3.2.2. Enabling Monitoring

Overture Media Manager provides the user with the ability to Enable Monitoring via ‘watch folders’. In
each ‘watch’ folder the user can put xml files that tell the ‘watch’ folder how to compile the media in the
selected folder.

1. When Overture Suite 2.3 is installed, the overture installer will include five xml files in the
following directory C:\Program Files\Evertz\Overture Suite\omm\watch templates

2. A user can simply copy all five of these files and paste them into a "watched" folder in their
desired directory. (This will be the folder that the user selects in OMM to apply the “Enable
Monitoring” function to.)

3. The user can then modify the files appropriately to automatically control how the media is
compiled.

There are multiple files that can be placed in each ‘watch’ folder. The following default files can be
used:

default.resource.xml
default.object._prop.video.xml

EXAMPLE #1
For example, a sample xml file (default.resource.xml) looks similar to the following:

<?xml version="1.0" encoding=""utf-8"7>
<document xmlns:xi="http://www.w3.0rg/2001/XInclude">
<profile>
<segment frame="$begin" level="100%" repeat="'1" />
<segment frame=""$end" level="100%" repeat="$hold" />
</profile>
</document>

There can be multiple <segment ... /> lines within the <profile> block. Each <segment> statement tells
Overture Media Manager how to encode the loop points for the media file that is being compiled. The
above example creates 2 loop points.

First Segment: <segment frame="$begin" level="100%" repeat="1" />
The first segment creates an initial loop point, which sets the animation opacity to 100%.

Second Segment: <segment frame="$end"” level="100%" repeat="$hold" />
The second segment keeps the animation opacity at 100% and tells OMM to repeat the animation
until taken out.

EXAMPLE #2
For this example, assume that the animation is set to 100 frames.

<?xml version="1.0" encoding="utf-8"7>
<document xmlns:xi="http://www.w3.0rg/2001/XInclude">
<profile>
<segment frame="$begin" level="25%" repeat=""1" />
<segment frame=""20" level="50%" repeat=""1" />
<segment frame=""40" level="75%" repeat="4" />
<segment frame="$end" level="100%" repeat=""2" />
</profile>
</document>
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This example will create an animation with 4 loop points.

First Segment: <segment frame="$begin" level="25%" repeat=""1" />
The first segment creates the initial loop point, which immediately sets the animation opacity to
25%.

Second Segment: <segment frame="20" level="50%" repeat=""1" />
The second segment forces the second loop point to start where the first loop point left off at frame
1 and ends at frame 20. At the end of frame 20 the animation opacity will be at 50%.

Third Segment: <segment frame="40" level="75%" repeat="4" />

The third loop point starts where the second one left off (frame 21) and ends at frame 40. At the
end of frame 40 the animation opacity will be at 75%. This loop point has a repeat of 4, therefore
this animation segment will be repeated 4 times (it will play out frames 21 to 40 four times but the
animation opacity will reach 75% after the first repeat and will stay at that opacity for the next 3
repeats).

Fourth Segment: <segment frame="$end" level="100%" repeat="2" />

The fourth loop point starts where the third one left off (frame 41) and ends at $end ($end indicates
the length of the animation). $end could be replaced with 100 since our animation had 100 frames.
This loop point has a repeat of 2, which repeats frames 41 to 100 two times.

The frame=" " attribute signifies the frame number. This attribute can have any number ranging from 0
to the animation length. The $begin and $end are special "tags" that OMM understands. For example,
$begin actually indicates 0 (eg. frame="0" and frame="$begin" indicate the same value) and $end is the
animation length, therefore in a 100 frame animation $end would indicate frame 100.

The level=" " attribute is the opacity level. This value can be 0 to 100 and is a percentage of the
maximum opacity (100).

The repeat=" " attribute is the repeat count for the segment. It can have any number ranging from 0 to
32768. The $hold attribute is also a special "tag" that equates to O internally (which means repeat
forever - or - until a command is issued to the keyer to take the logo out). Placing repeat="$hold" and
repeat="0" indicates the same value internally.

The "default.resource.xml” file functionality is the same as if you opened Overture
Media Designer and added a movie, right clicked on the movie object in the
g canvas, selected bullet management, clicked properties for the bullet and created

loop points in the loop point editor. This file is simply the "backdoor" to the GUI
functionality provided by Overture Media Designer.
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3.3.3.3. My Bookmarks — Media Panel

The My Bookmarks tab lists all of the existing bookmarks and their location, as shown in Figure 3-82.

The user can link to a folder anywhere on their computer or network by creating a bookmark. Once a
bookmark is created, the user can double click on the bookmark in the My Bookmarks tab and the
folder and all its contents will be displayed in the My Media tab.

Media x
Folder | Mv Bookmarks/ w
Marne Path

My Bookmarks

Logos Z: [Docurments and Settings,

< »
My Media My Bookmarks

Figure 3-82: My Bookmarks — Media Pane

3.3.3.4. My Bookmarks Drop Down Menu

The My Bookmarks drop down menu enables the user to manage the bookmarks. The user must right-
click in the My Bookmarks pane to access the drop down menu, as shown in Figure 3-83.

Mew Bookmark, ..
Mew Faolder, .,

Figure 3-83: My Bookmarks Drop Down Menu

e New Bookmark...: This option enables the user to create a new bookmark. Upon selecting
this option, the user will be presented with a Create Bookmark dialog box,
as shown in Figure 3-84. In order to create a new bookmark, the user will
be required to enter a unique name to identify the bookmark, select it's path
by clicking the Browse button and then navigate to the appropriate

location. Once the bookmark is created it will be displayed under the My
Bookmark tab of the Media pane.
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L o

Create Bookmark

General

Marne:

Path:

Browse, ..

Zancel

Figure 3-84. Create Bookmark

o New Folder...: This option enables the user to create a new folder. Upon selecting this option,
the user will be presented with a Create Bookmark Folder dialog box, as shown
in Figure 3-85. The user will be prompted to enter a unique folder name and
folder description, if desired. Once the folder has been assigned, select the OK
button.

=,

Create Bookmark Folder

General

Marme:

Description:

Cancel

Figure 3-85: Create Bookmark Folder Dialog Box
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3.3.3.5. Transferring Media

The user can transfer media to the device (remote media pane) using the right click Media pane menu
and selecting the Upload menu option, or the user can simply select the media item from the Media
pane and drag it into the Remote Media pane window. Doing this will transfer the selected file(s) to the
device.

If the file being transferred already exists on the device, a Confirm Media Replacement window will
appear, as shown in Figure 3-86. This dialog box prompts the user to confirm that they are replacing
the selected media. To replace the media, ensure a check mark is placed beside the media item and
press the Replace button. If you do not wish to replace a media file, uncheck the box beside the media.

If items are being replaced on multiple devices, the user can approve each media replacement
individually by selecting the Next and Previous buttons. The device to which the media is being
replaced will be listed under the Hardware heading, as shown in Figure 3-86. To replace all selected
media, ensure the Replace Everything box has a checkmark beside it.

Confirm Media Replacement T x|

Please confirm the media replacement operation by placing a check mark beside the name of
each item that you want to replace. Once ready select the Replace button. Note that you
may abort this operation at any time by selecting the Cancel button,

~Hardware

The selected device already contains the files...
HD9725LGA v 19

™ Replace Everything

| e |_coml |

Figure 3-86: Confirm Media Replacement
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3.3.4. Using the Status Window

3.3.4.1. Transfer Queue Tab

The Status Window panel displays the actions currently being performed by the device. Figure 3-87
displays the Status Window panel.

Status wWindow b
P
Zornmand Media Skatus Size Rate

Upgrade CfDocuments ... Upgrading {reboot). .. (14%) 7.1MEB 52,3 kB/s

Log | Transfer Queue - 1

Figure 3-87: Status Window — Transfer Queue Tab

The actions displayed in the Network Activity panel includes:

e Command: States the action requested.

e Media: Indicates the filename of the media.

e Status: Indicates the current state of the transfer and the percentage of its completion.
e Size: Indicates the size of the file being transferred.

e Rate: Indicates the rate at which the transfer is occurring.

To access the Status Window menu, right mouse click the job in the Transfer Queue Panel. The
following menu will appear which enables the user to manage the job.

Cancel

Figure 3-88: Active Jobs Menu

e Cancel enables the user to cancel the action.
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3.3.4.2. Log Tab

The Log tab enables the user to log the actions that occur in regards to the watch service. To clear the
log file, select the Clear Log option from the View menu.

Skatus Window »

11:04:25 Watch service started,
16:03:50 Wakch service stopped,
16:08:52 Watch service started,
16:09:01 ‘Watch service stopped.

Log | Transfer Queue

Figure 3-89: Status Window — Log Tab
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4. OVERTURE MEDIA DESIGNER

4.1. GETTING STARTED

To launch the Overture Media Designer application, double click on the Overture Media Designer icon
on your desktop, or go to Start > All Programs > Overture Suite then select the Overture Media
Designer option. The Overture Media Designer application enables the user to create and insert a
variety of media components, which will be uploaded to the user’'s device using the Overture Media
Manager. The Media Designer allows the user to import and manipulate the properties of various
media files, such as .tiff, .tga, .omp, .mov, .avi, etc. The Design Canvas screen enables the user to
place the logo or text title (i.e. a crawl) in the desired location on the screen based on the video
standard. When Overture Media Designer is launched the user will be presented with the Media
Designer screen, as shown in Figure 4-1.

‘ ] Untitled - Overture Media Designer [3|§1
File Edit Media Object Build ‘Yiew Help Bl

i ]
) 1 = =
=  ab "a e ) .:E e
Design Canvas Propetties X
Zoom: 100% Shawing Obiject:
. 20x1 0E0) Object | Compiler

= =
b (8 I

Figure 4-1: Design Canvas Screen
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4.2. OVERTURE MEDIA DESIGNER TOOLBAR AND MENUS

This section describes how the toolbar and menus are used in the Overture Media Designer. The
toolbar and drop down menu functions are described in sections 4.2.1 to 4.2.8.

4.2.1. Main Toolbar

The Overture Media Designer main toolbar (shown in Figure 4-2) provides the following file
management and object modification options.

S imi» Rt ¢ B dTEE G e

¢) B ¥
Figure 4-2: Main Toolbar

‘e
PO ab R ]

Hll

Open Project: This button enables the user to open a previously saved Overture Project file
(-prj). Click on the Open Project button to open the Load Project window. The user will be
prompted to select the desired file from the appropriate directory.

Save Project: This button saves the media elements as an Overture Project file.

Build Project: This button enables the user to assemble the project’'s contents into the
appropriate files. See section 4.2.6 for more information.

Cancel Build: This button enables the user to cancel and exit the compile process.

Play: This button enables the user to preview the animated object by playing it on the design
canvas.

Step Back: This button enables the user to move the play mode back in one frame increments.
Pause: This button enables the user to pause the playback mode on the current frame.

Step Next: This button enables the user to move the play mode forward in one frame
increments.

Stop: This button enables the user to stop the playback mode of the selected object.

/ Zoom to 100%: This button enables the user to set the design canvas view to 100% (or full
b= size for the particular video standard).

Zoom In: This button enables the user to zoom in on the design canvas (up to 200%).
Zoom Out: This button enables the user to zoom out from the design canvas (up to 25%).
Move Left: This button horizontally moves the selected object to the left.

>3 Move Right: This button horizontally moves the selected object to the right.

Move Up: This button vertically moves the selected object up.
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Move Down: This button vertically moves the selected object down.

Align Left: This button enables the user to align all selected objects along the leftmost vertical
axis. This button is only accessible when multiple objects are selected.

Align Right: This button enables the user to align all selected objects along the rightmost
vertical axis. This button is only accessible when multiple objects are selected.

Align Top: This button enables the user to align all selected objects along the top horizontal
axis. This button is only accessible when multiple objects are selected.

Align Bottom: This button enables the user to align all selected objects along the bottom
horizontal axis. This button is only accessible when multiple objects are selected.

Align Centers Horizontally: This button enables the user to center all selected objects along
the horizontal axis. This button is only accessible when multiple objects are selected.

Align Centers Vertically: This button enables the user to center all selected objects along the
vertical axis.

Bring to Top: This button enables the user to bring the selected object to the top of the object
stack.

Move Up: This button enables the user to bring an object one step closer to the front.
Move Down: This button enables the user to send an object one step closer to the back.

Send to Bottom: This button enables the user to send the selected object to the bottom of the
object stack.

Add Audio: This button enables the user to add an audio file (.wav).

Add Crawl: This button enables the user to add a horizontal crawl object. See section 4.3.
Add CG Item: This button enables the user to add a CG Item object. See section 4.4.
Add Date: This button enables the user to add a date object. See section 4.5.

Add Image: This button enables the user to insert a fill graphic (ex. .tiff, .tga, .jpg, etc). See
section 4.6.

Add Image Sequence: This button enables the user to insert a series of images.
Add Temperature: This button enables the user to add a temperature object. See section 4.7.
Add Time: This button enables the user to add a digital or analog time object. See section 4.8.

Add Video: This button enables the user to add a QuickTime movie file (.mov) or Windows
movie file (.avi). See section 4.9.

Import Logo: This button enables the user to add a logo object.
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4.2.2. File Menu

The File drop down menu provides the following options as shown in Figure 4-3.
Mewy Project, ..
Open Project. ..
Close Project

Imnpork Exisking Logo. ..
Irnpoart Project. ..

Save Praject
Save Project As. ..

Exik

Figure 4-3: File Menu

e New Project... opens a new design canvas and enables the user to create a new Overture
Project file (.prj).

e Open Project... will enable the user to open a previously saved Overture Project file (.prj).

e Close Project enables the user to exit the existing project and close the current Design
Canvas. The user should use caution when selecting this button. A dialog box will appear to
prompt the user to save any changes. Any changes that have not been saved at this point
WILL BE LOST. Always save the project file before exiting.

e Import Existing Logo... enables the user to import an existing logo (.evl file) onto the design
canvas.

e Import Project... enables the user to import a previously created Overture project (.prj file)
e Save Project saves the media elements as an Overture Project file (.prj).

e Save Project As... enables the user to save the media elements as an Overture Project file
(-prj) under a unique file name.

e EXxit enables the user to close and exit the Overture Media Designer application.
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4.2.3. Edit Menu

The Edit drop down menu provides the options shown in Figure 4-4:

IUndo Chrl+Z
Redo Chrl4

Delete

Select Al Crrl+a

Figure 4-4: Edit Menu

e Undo enables the user to undo the previous action.
e Redo enables the user to reinstate the undone action.

e Axis Lock enables the user to lock the desired axis so that the objects will move in a straight
line horizontally or vertically.

e X enables the user to lock the x-axis so that objects can only be moved vertically on the
design canvas.

e Y enables the user to lock the y-axis so that object can only be moved horizontally on the
design canvas.

o Delete enables the user to remove the selected object from the design canvas.

e Select All enables the user to select all of the objects located on the design canvas.

4.2.4. Media Menu

The Media drop down menu provides the options shown in Figure 4-5:
Play
Pause

Skep Into
Skep Next
Skep Previous

Skop

Figure 4-5: Control Menu

o Play enables the user to play the selected media on the design canvas. Note that in order to
play the object, the selected media must be an animated image or movie.

o Pause enables the user to pause the playback mode on the existing frame. Note that in order to
play the object, the selected media must be an animated image or video clip.
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e Step Into enters playback mode and enables the user to step through each individual frame. To
enter this mode, select an animated object (ie. Movie, Animation or Logo) and select the Step
Into option. Using Step Next and Step Previous allows the user to skip frame-by-frame
through the selected object.

The user must use the stop " icon on the toolbar or the stop option from the Media drop

down menu, in order to exit Step Into mode. Please note that modifications to other objects
cannot be made until the Step Into mode is exited.

e Step Next enables the user to toggle through each individual frame of an object. Select
Media>Step Next to advance to the next frame in the sequence. If the console is turned on, the
playback settings will be displayed in the bottom left hand corner of the design canvas.

e Step Previous enables the user to toggle through each individual frame of an object. Select
Media>Step Previous to return to the previous frame in the sequence. If the console is turned
on, the playback settings will be displayed in the bottom left hand corner of the design canvas.

e Stop enables the user to stop the play sequence of the media on the design canvas. Note that
in order to use the stop function, the selected media must be an animated image or video clip.

Please note that modifications to other objects cannot be made during playback, therefore, the
user must select the stop option before making any changes to objects.

4.2.5. Object Menu

The Object drop down menu provides the options shown in Figure 4-6.

Align b Align b Left

Arrange L4 Arrange L4 Right

Add Audio Clip... Add Audio Clip... ;zfmm

add Crawl add Crawl .

Add Ca Ikem Add Ca Ikem 'u'erl.:lcal Center
Horizonkal Center

Add Date Add Date

Add Image. .. add Image...

Add Image Sequence. .. Add Image Sequence...

Add Temperature Add Temperature

Add Time ] Add Time ]

add video Clip... add video Clip...

Add Bullet »

Align Text »

Manage Bullets, .,

Mask, k

Figure 4-6: Object Menu
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The Align menu item enables the user to adjust the positioning of the objects relative to each other.
Select two or more objects by holding down the ctrl key and clicking on the desired objects on the
design canvas. Please note that all of the selected objects will align according to the position of the last
object selected. A yellow square around each object will indicate that these objects are selected.

Select one of the following options to position the objects:

alian 3 Left
Arrange k Right
To
add Audio Clip... P
Bokkomn
Add Crawl )
Vertical Center
add Ca Ikem .
Horizonkal Center
add Date
add Image. ..

add Image Sequence. .,
Add Temperature

Add Time 3
Add Video Clip...

Figure 4-7: Align Sub-menu

e Left enables the user to align all selected objects along the left vertical axis.

¢ Right enables the user to align all selected objects along the right vertical axis.

e Top enables the user to align all selected objects along the top horizontal axis.

e Bottom enables the user to align all selected objects along the bottom horizontal axis.
e Vertical Center enables the user to center all selected objects along the vertical axis.

e Horizontal Center enables the user to center all selected objects along the horizontal
axis.

The Arrange menu item enables the user to adjust the layer position of the selected media. Select the
Arrange option and then click on one of the arrange menu items in the pop up menu.
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The following Arrange options are available:

Align 3
Arrange g Bring ko Top
Mave L
Add Audio Clip. . P
Mave Dawn
Add Crawl
Send ko Bokkom
Add 15 Them
add Date
Add Image...

Add Image Sequence...
add Temperature

Add Time 3
add video Clip...

Figure 4-8: Arrange Sub-Menu

e Bring to Top enables the user to bring the selected object to the top of the object stack.
e Move Up enables the user to bring an object one step closer to the front.
e Move Down enables the user to send an object one step closer to the back.

e Send to Bottom enables the user to send the selected object to the bottom of the object
stack.

The following Object options are used to insert various forms of media:

Add Audio Clip... enables the user to add an audio file (.wav).

Add Crawl enables the user to add a horizontal crawl object. See section 4.3.

Add CG Item enables the user to add a CG Item object. See section 4.4.

Add Date enables the user to add a date object. See section 4.5.

Add Image... enables the user to insert a fill graphic (ex. .tiff, .tga, .jpg, etc). See section 4.6.
Add Logo... enables the user to add a logo object.

Add Temperature enables the user to add a temperature object. See section 4.7.

Add Time... enables the user to add a digital or analog time object. See section 4.8.

Add Video Clip... enables the user to add a QuickTime movie file (.mov) or Windows movie file
(-avi). See section 4.9.
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e Add Bullet enables the user to insert a bullet into a crawl. The crawl object must be selected
on the canvas in order for this option to be accessible.

Arrange 4

Add Audio Clip...

Add Crawl

Add CG Ikem

&dd Date

add Image. ..

add Image Sequence...
Add Temperature

Add Time 3
Add Video Clip. ..

&dd Bullet 3 IJsing Image. ..
Using Image Sequence...
Manage Bullets, ., sing Wideo Clip. ..

Mask, r ] o
sing Existing Loga. ..

Figure 4-9: Add Bullet... Menu

0 Using Image... enables the user to insert a scaled source graphic to fit into a crawl. See
section 4.3.6.1 for more information.

0 Using Image Sequence... enables the user to insert a scaled sequence of images to fit
into a crawl. See section 4.3.6.2 for more information.

0 Using Video Clip... enables the user to insert a scaled movie to fit into a crawl. See
section 4.3.6.3 for more information.

0 Using Existing Logo enables the user to insert a scaled logo to fit into a crawl. See
section 4.3.6.4 for more information.

e Align Text enables the user to align the text of an object with multiple lines of text. For
example, the user could align multiple lines of text in a CG Item. The Align Text options are Left,
Center and Right as shown in Figure 4-10.
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Arrange

add Audio Clip, ..
Add Crawl

Add CG Ikem
Add Date

add Image. ..

Add Image Sequence. .,

Add Temperature
add Time
Add video Clip. ..

Align Texk

Arrange

Add Audio Clip. ..
Add Crawl

Add CE Ikem
Add Date

Add Image. ..

Add Image Sequence. ..

Add Temperature
Add Time
Add Wideo Clip. ..

Add Bullek

Manage Bullets. ..
Mask,

Left
Center
Right

Figure 4-10: Align Text Menu

Manage Bullets... enables the user to manage the bullets in the crawl. Once inserted, use the
Manage Bullets... option to remove the bullet from the crawl, or modify the playback sequence
of the crawl by adjusting the bullet settings in the timeline. See section 4.3.7.

Mask enables the user to manage the mask settings. The crawl object must be selected on the
design canvas in order for this option to be accessible.

Load...
Clear
Create.,,,

Figure 4-11: Mask Menu

The following options are available in the Mask menu.

Load... enables the user to specify an external image that will shape the appearance of
the crawl (known as alpha mask or visibility mask). Standard images are supported where
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a valid mask consists of values from 0 to 255. A value of 255 will be fully opaque, while
values that approach 0 become more transparent. A value of O represents complete
transparency.

Text can be anchored to the top, center or bottom of the crawl window. The following
information is pertinent when applying crawl masks:

« Suggested mode of operation is to use full screen masks since Overture will auto-
place and auto-size the crawls to match the active pixel area of the mask, making
manual control unnecessary.

« Full-width (but not full-height) masks will have Overture auto-place the crawl's X-
position as per the mask’s active pixels, while the Y-position will be left unchanged.

« Similarly, full-height (but not full width) masks, will cause Overture to auto-place the
crawl’s Y-position as per the mask’s active pixels, and leave the X-position unchanged.

« For masks which are neither full-width nor full-height, Overture will leave the position of
the crawl unchanged.

« For all masks, Overture will auto-size the crawl to fit the active pixels of the mask.

. The position of the crawl may be changed after the mask is applied. The dimensions
of the crawl may also be changed as long as they do not exceed the active pixel
boundaries of the mask.

« The start position (top left corner) of the mask is always anchored to the start position
of the crawl. In other words, the crawl position cannot be changed with respect to its
mask.

o Clear enables the user to remove any applied alpha masks on the crawl.

e Create enables the user to create a crawl mask using either the Pixel Amount or the
Percentage, as shown in Figure 4-12.

o0 Pixel Amount: This setting enables the user to adjust the transparency of the
crawl on the left and right edges of the object based on pixel amount. For
example, if the width of the crawl is 1000 pixels and the user enters the value of 30
in the pixel amount field, then the crawl will have a gradual fade in from pixel 1 at
0% to pixel 30 at 100%. Pixels 31 to 969 will be 100% opacity. On the right side of
the crawl, pixel 970 will be 100% opacity and will gradually fade out to 0% opacity
at pixel 1000.

0 Percentage: This setting enables the user to adjust the transparency of the crawl
on the left and right edges of the object based on percentage. For example, if the
width of the crawl is 1000 pixels and the user enters a value 2% into the
percentage field, then the crawl will have a gradual fade at either side of the crawl
based on the percentage. In this particular example, 2% of 1000 pixels would be
20 pixels, therefore the opacity would be 0% at pixel 1 and gradually build up to
100% at pixel 20. Pixels 21 to 979 will be 100% opacity. On the right side of the
crawl, pixel 980 will be 100% opacity and gradually fade out to 0% at pixel 1000.

When defining the percentage for the ramp, Overture Media Designer will only
search for a file in .png format, as OMD creates this file and will only search the
library for items in this format. If the user wishes to use a .tiff file or other formats,
then the load mask option must be used instead, as the load mask will allow the
user to import rather than create the file.
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Create Mask

Famp Size

Enter the size of the ramp that will be created on each edge
af the objeck, You may specify the ramp size as a pixel value
ar as a percentage of the tokal objeck width,

'f:} Pixel Amount

{}:' Percentage
Z

4|

[ Save H Cancel ]

Figure 4-12: Create Mask

4.2.6. Build Menu

The Build drop down menu provides the options shown in Figure 4-13:

Build Project... F7

Cancel
Mode b
Target L4

Figure 4-13: Build Menu

Build Project... enables the user to assemble the project’s contents into the appropriate files.
By selecting Build Project... from the build menu, a playlist file (.ekp) and individual object files
(ie. crawl, logo, movie, image, etc) will be created for each object that was inserted into the
project.

For example, if the user created a new project and inserted a crawl, a CG Item and a logo onto
the design canvas, they would have a total of three objects. Before performing a compile,
ensure the project is saved as an Overture project (.prj) file. Once saved, select the Build
Project... item and Overture will assemble all the necessary files needed to load the contents
onto the Keyer. For this particular project, the compile function would create four separate files:
a playlist file (.ekp), and three .evl files with no extensions (one file for the crawl, one file for the
CG Item and one file for the logo). These files can be loaded individually or as a whole onto
the keyer depending on the desired effect.

If the user wants to run the .ekp file on the device, they must load the .ekp and all associated
.evl files onto the device from the Overture Media Manager. Running the playlist file (.ekp)
enables the user to load all the items at once, as they were created in Overture Media Designer.
This enables the user to cue or fade all of the files as a whole, rather than individually loading
each file. If the user only wants to fade or cue one of the .evl files created when the playlist was
compiled, then they are only required to load the desired .evl file onto the device.
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A playlist allows the user to combine a number of media elements into one file. The playlist can
contain up to 8 media elements.

Creating a playlist enables the user to set different fade actions for each of the elements. Each
element could have a quick out while another element could fade out at 600 frames. If the user
wishes to take different elements off air at different times, then the user could set hold points for
each element. The hold parameter applies to static logos and not animations.

o Cancel enables the user to cancel and exit the compiling process.
¢ Mode enables the user to select the encode mode that will be used to compile the project.

0 RGB enables the user to encode the file format in RGB mode. Encoding in RGB allows
for a better ratio of source to final output, uses less pixels, and produces a smaller file
size.

0 YCDbCr enables the user to encode the file format in YCbCr mode. YcbCr mode is the
most common encode mode.

o Target enables the user to select the appropriate target device series to which the media will be

transferred. Figure 4-14 displays the target menu options.

For example, if the device connected to your system is a HD9725LG unit, then you would select
the 9700 Series Keyers option as your target.

Build Design... F7

Mode r
Targek 4 7712 Series Upconverters
77250 Series Kevers

& 9700 Series Kevers

Figure 4-14: Target Menu
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4.2.7. View Menu

The View drop down menu provides the following options as shown in Figure 4-15.

‘Wideo Standard r

Console Window
v Properties Window

Toalbars k

v Graticules
v Guides
Set Background Caolour #

Zoam to 1005
Zoam In
Lo Dok

Figure 4-15: View Menu

o Video Standard enables the user to set the video standard. Figure 4-16 displays the available
video standard options:

Wideo Standard 2250

) 16x9 5250
Console Window .
v Properties Window .
Toolbars 3 T20p-50
] 720p-59.04
v Grétlcules 720p-60
v Guides 1080i-50
Set Background Colour # & 1050i-59.94
Zoom to 100% 1050i-60
Zoom In 1050p-23.98

Zoorn Dk

Figure 4-16: Video Standard Sub-Menu

e Console Window displays the video specifics on the design canvas. Placing a check mark
beside the console option will display the zoom percentage, video standard and pixel aspect in
the upper right hand corner of the design canvas.

e Properties Window displays the properties of the objects imported onto the design canvas.
Placing a check mark beside the Properties Window option will display the properties side bar.
If the check mark is removed from beside the Properties Window option, the properties window
will not be displayed.

e Toolbars option enables the user to display or hide a specific toolbar in the application. When a
check mark is placed beside the appropriate toolbar name, the corresponding toolbar will be
displayed in the window view.
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Widen Standard r

Consale Window

v Properties Window

Toolbars v Build
v Lavout
v Grakicules Y
] v Ohjecks
v GUides
v Standard
Set Background Colour  # )
W Wiew

Zoom bo 100%:
Zoom In
Zoam Ok

Figure 4-17: Toolbar Sub-Menu

Graticules enable the user to display the graticules, which define safe areas for the particular
video standard. A check mark beside the Graticules option will display the graticules on the
design canvas. If there is no check mark beside the Graticules option in the menu, then the
graticules will not appear on the design canvas. Refer to Figure 4-22.

Guides enable the user to easily position objects on the design canvas. When a check mark is
placed beside the guides menu item, horizontal and vertical lines will be displayed at the
corners of the each selected object. These guidelines will help the user to position the object
relative to the graticules and other objects on the design canvas.

Set Background Colour enables the user to change the background colour of the design
canvas. Figure 4-18 displays the available options in the set background colour sub-menu.
Select black or white from the menu, or click on the custom... option to apply a specific
background colour.

Wideno Standard r

Console Windaw

v Properties Window

Toolbars r
v (Eraticules
W Glides
Set Background Colour - EEEET
‘White
Zoorm bo 100%
Zoam In Cuskom, ..

Zoarm Ok

Figure 4-18: Background Colour Sub-Menu
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e Zoom to 100% enables the user to set the design canvas view to 100% (or full size for the
particular video standard).

e Zoom In enables the user to zoom in on the design canvas (up to 200%).

e Zoom Out enables the user to zoom out from the design canvas (up to 25%).

4.2.8. Help Menu

The Help drop down menu provides the following options shown in Figure 4-19.

About, .

Figure 4-19: Help Menu

e About... enables the user to view the Overture Media Designer version number. When the
About option is selected the About screen will be displayed as shown in Figure 4-20.

IATIONAL WEATHER SERVICE HAS ISSUED A SEVERE THUNDERSTO

Crverture Media Designer
Copyright € 2007-2008 Evertz Microsystems, Led,
Version; 2.2.0,1623

Figure 4-20: About Screen
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4.2.9. Design Canvas Menu

Right clicking anywhere on the design canvas will enable access to the options menu.

canvas menu is shown in Figure 4-21.

Figure 4-21: Design Canvas Menu

Undao add Ohject

Build Design. ..

add Aoudio Clip,.,
Add Craval

Add Ca Ikem
Add Date

add Image. ..

add Image Sequence...

Add Temperature
Add Time
&dd Wideo Clip...

Import Existing Logo. ..

Zoam ba 100%:
Zoarmn In
Zoarn Ok

Ctrl+Z

F7

e Undo enables the user to undo the previous action.

e Redo enables the user to reinstate the undone action.

The design

o Build Design enables the user to assemble the project’s contents into the appropriate files. See

section 4.2.6.

e Add Audio Clip... enables the user to add an audio file (.wav).
¢ Add Crawl enables the user to add a horizontal crawl object. See section 4.3.
¢ Add CG Item enables the user to add a CG Item object. See section 4.4.

o Add Date enables the user to add a date object. See section 4.5.

¢ Add Image... enables the user to insert an image and/or series of images (ex. .tiff, .tga, .jpg,

etc). See section 4.6.

¢ Add Image Sequence... enables the user to add a logo (.evl file). See section 4.6.
e Add Temperature enables the user to add a temperature object. See section 4.7.

¢ Add Time enables the user to add a time object. See section 4.8.
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e Add Video Clip... enables the user to insert a QuickTime movie file (.mov) or Windows movie
file (.avi) to create the media. See section 4.9.

e Import Existing Logo... enables the user to import a previously created logo file (.evl).

e Zoom to 100% enables the user to set the design canvas view to 100% (or full size for the
particular video standard).

e Zoom In enables the user to Zoom In on the design canvas (up to 200%).

e Zoom Out enables the user to Zoom Out from the design canvas (up to 25%).

4.2.10. Design Canvas Overview

Figure 4-22 outlines the features of the design canvas. When an object is selected on the design
canvas, the following features and properties will be displayed on the canvas.

Zoom Zoom: 100%
Video Standard ).94
Pixel Aspect

Guides

Graticules

Type image2
Qutput Filename Output File: Evertz Logo
Length

# of Frames

Figure 4-22: Design Canvas
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The canvas properties are listed at the top right corner of the design canvas. The following properties
are present:

Zoom: Identifies the zoom value of the canvas. If the user zooms in or out on
the canvas the zoom value will be reflected here.

Video Standard: This property identifies the video standard being used.

Pixel Aspect: This property identifies the pixel aspect ratio.

The object properties provides the following information:

Type: The first item listed in orange identifies the object type.
Output File: Identifies the filename of the object when it is output (compiled)
Length: Identifies the length (duration) of the clip (in hours, minutes, seconds).

Number of Frames: Identifies the total number of frames in the animation.

The console properties provides the following information:

Graticules define the safe areas for the particular video standard. Placing the content inside of
the graticules ensures that the objects will be properly displayed on the canvas. The user can
turn the graticules on or off using the View menu. A check mark beside the Graticules option will
display the graticules on the design canvas. If there is no check mark beside the Graticules
option in the menu, then the graticules will not appear on the design canvas.

Guides enable the user to easily position objects on the design canvas. These guidelines will
help the user to position the object relative to the graticules and other objects on the design
canvas. The guides can be turned on or off using the View menu. When a check mark is placed
beside the guides menu item, horizontal and vertical lines will be displayed at the corners of
each selected object.

OVERTURE MEDIA DESIGNER Revision 1.9.2 Page 4-19



Overture Suite 2.3 Software Manual everl2>

4.3. CREATING A CRAWL

To create a horizontal crawl, the user can select the Add Crawl option from the Object menu (see
section 4.2.5) or the main toolbar. Once selected, a horizontal green bar will appear on the design
canvas and a list of crawl properties will appear on the right in the Property Settings panel, as shown in
Figure 4-23. The user can set the placement of the crawl by selecting and dragging it to the desired
position using the mouse or by entering the desired coordinates in the Placement property of the crawl
Property Settings panel.

‘ ] Untitled* - Overture Media Designer [3|§1
File Edit Media Object Build ‘Yiew Help l
L : : =z . |
= JENE] (& O A = - iy 4 ¢ = e
> | ab 9 [ = ) ifg e

Design Canvas Properties X

Zoom: 100% Showing Object: crawl

Dbject | Compiler

3 &

E Appearance

Background [ o;zs5:050%

Font Mame Arial

Font Size 48

Text Color I:I 255;255;255 100%
B Behaviour

Direction Seroll Left
Expiration

Mode Ramp

Rate g

Repeat 1

Repeat Delay 5

Resume Don't Resume
B Placement

Baseline 36
Baseline Anchor Center
Height 48
tidth 1920
X o

¥ 103z

Replace this tex

%:0y: 1032 -- Video hi0 v:516

Figure 4-23: Horizontal Crawl on Design Canvas
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4.3.1. Crawl Menu

To access the Crawl Menu, select the crawl on the design canvas and right-click the mouse button.

The Crawl Menu will be displayed as shown in Figure 4-24.

Unda Chrl+Z
Reda Chrly

Add Bullet ]
Manage Bullets. .,
Mask, r

Ering to Top
Move Up

Mave Dawn
Send to Botkom

Delete

Figure 4-24: Crawl Menu

Undo enables the user to undo the previous action.

Redo enables the user to reinstate the undone action.

Add Bullets enables the user to insert images, video and logos as bullets in a crawl.

4-25 outlines the options provided in the bullets sub-menu.

Using Image...
IUsing Image Sequence. ..
Ising Wideo Clip...

Using Existing Loga...

Figure 4-25: Bullets Sub-Menu

Figure

0 Using Image... enables the user to insert a scaled source graphic to fit into a crawl. See

section 4.3.6 for more information.

0 Using Image Sequence... enables the user to insert a scaled sequence of images to fit

into a crawl. See section 4.3.6 for more information.

0 Using Video Clip... enables the user to insert a scaled movie to fit into a crawl. See

section 4.3.6 for more information.

0 Using Existing Logo enables the user to insert a scaled logo to fit into a crawl. See

section 4.3.6 for more information.
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¢ Manage Bullets enables the user to add or remove the existing bullets.

¢ Mask enables the user to add or remove a mask to the bullet.

Load...
Clear
Create,.,

Figure 4-26: Mask Sub-Menu

0 Load... enables the user to specify an external image that will shape the appearance of the
crawl (known as alpha mask or visibility mask). Standard images are supported where a
valid mask consists of values from O to 255. A value of 255 will be fully opaque, while
values that approach 0 become more transparent. A value of O represents complete
transparency.

Text can be anchored to the top, center or bottom of the crawl window. The following
information is pertinent when applying crawl masks:

Suggested mode of operation is to use full screen masks since Overture will auto-
place and auto-size the crawls to match the active pixel area of the mask, making
manual control unnecessary.

Full-width (but not full-height) masks will have Overture auto-place the crawl’s X-
position as per the mask’s active pixels, while the Y-position will be left unchanged.
Similarly, full-height (but not full width) masks, will cause Overture to auto-place the
crawl’'s Y-position as per the mask’s active pixels, and leave the X-position
unchanged.

For masks, which are neither full-width nor full-height, Overture will leave the
position of the crawl unchanged.

For all masks, Overture will auto-size the crawl to fit the active pixels of the mask.
The position of the crawl may be changed after the mask is applied. The
dimensions of the crawl may also be changed as long as they do not exceed the
active pixel boundaries of the mask.

The start position (top left corner) of the mask is always anchored to the start
position of the crawl. In other words, the crawl position cannot be changed with
respect to its mask.

o0 Clear enables the user to remove any applied alpha masks on the crawl.

o0 Create enables the user to create a crawl mask using either the Pixel Amount or the
Percentage, as shown in Figure 4-12.

o Pixel Amount: This setting enables the user to adjust the transparency of the

crawl on the left and right edges of the object based on pixel amount. For
example, if the width of the crawl is 1000 pixels and the user enters the value of 30
in the pixel amount field, then the crawl will have a gradual fade in from pixel 1 at
0% to pixel 30 at 100%. Pixels 31 to 969 will be 100% opacity. On the right side of
the crawl, pixel 970 will be 100% opacity and will gradually fade out to 0% opacity
at pixel 1000.
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0 Percentage: This setting enables the user to adjust the transparency of the crawl
on the left and right edges of the object based on percentage. For example, if the
width of the crawl is 1000 pixels and the user enters a value 2% into the
percentage field, then the crawl will have a gradual fade at either side of the crawl
based on the percentage. In this particular example, 2% of 1000 pixels would be
20 pixels, therefore the opacity would be 0% at pixel 1 and gradually build up to
100% at pixel 20. Pixels 21 to 979 will be 100% opacity. On the right side of the
crawl, pixel 980 will be 100% opacity and gradually fade out to 0% at pixel 1000.

When defining the percentage for the ramp, Overture Media Designer will only
search for a file in .png format, as OMD creates this file and will only search the
library for items in this format. If the user wishes to use a .tiff file or other formats,
then the load mask option must be used instead, as the load mask will allow the
user to import rather than create the file.

¢ Bring to Top enables the user to bring the selected object to the top of the object stack.

e Move Up enables the user to bring an object one step closer to the front.

¢ Move Down enables the user to send an object one step closer to the back.

e Send to Bottom enables the user to send the selected object to the bottom of the object stack.

o Delete enables the user to remove the object.
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4.3.2. Crawl Appearance

When the crawl is selected on the design canvas, the crawl properties can be adjusted through the
Crawl Property Settings panel located to the right of the design canvas (see Figure 4-27).

If the object is selected on the design canvas, the properties window will appear and the user can

select the appearance button "= to view and edit the object’s appearance.

Properties

Showing Object: crawl

Object

|':|$ |
]

J =

b

Compiler

*

B

Appearance
Background
Fonk Marme
Fonk Size
Text Colar
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Direckion
Expirakion
Mode

Rate

Repeak
Repeat Delay
Resume
Placement
Baseline
Baseline Anchor
Height

Width

k4

ki

[ 02550 50%

Arial

43

[ ] z55;255;255 100%

Scrall Left

Ramp

g

1

=]

Don't Resume

36
Center
43
1920
1]

103z

Figure 4-27: Crawl Appearance Tab
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4.3.2.1. Crawl Appearance

Background enables the user to set the background colour of the crawl.

Font Name enables the user to specify the font type of the crawl. Note that this font MUST BE
on the device with the crawl in order for the crawl to appear.

Font Size enables the user to set the size of the crawl font.

Text Colour enables the user to set the colour of the crawl text.

4.3.2.2. Crawl Behaviour

Direction enables the user to set the transition direction of the crawl. The crawl text can only
Scroll left, Scroll right or Scroll Up. By changing the direction to “Scroll Up”, the crawl will be
oriented vertically on the canvas. Please note that the vertical crawl option is primarily used to
support Chinese Characters or text that is written vertically. For vertical crawls, the font you are
using must support vertical orientation.

Expiration enables the user to set the number of days, hours, minutes and seconds before the
crawl expires.

Mode enables the user to control how the crawl initially appears on air. There are three modes:
Ramp, the crawl starts at one end of the screen and moves across to the other end; Bar, the
crawl background appears across the screen with the content starting from one end and moving
across to the other; and Bar2, both the crawl background and content appear across the entire
screen.

Rate enables the user to set the scroll rate of the crawl across the screen. The scroll rate is
adjustable in terms of seconds or pixels per frame.

Repeat enables the user to set the number of times the crawl will scroll through a complete
cycle (i.e. scroll across the screen and then pause). The range for this parameter is 0 to 30
times. If the repeat count is set to O, the crawl! will continue in an endless loop.

Repeat Delay enables the user to set the length of the pause between repeated crawils.
Resume enables the user to resume or stop the crawl. This property has two options. The user

can select Don’'t Resume, which will stop the crawl. The second option is Last On-Air State,
which enables the crawl to resume from the last state before the crawl was faded out.

4.3.2.3. Crawl Placement

Overture enables the user to accurately place an image on the design canvas. The placement of the
object is determined by pixel and line position of the object with respect to the top-left corner (0,0) of
the video standard selected. The user can enter these values manually or use the mouse to move the
object to the desired location.
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. )/ that the crawl text MIGHT be cropped. If the adjustments are made such that the

Baseline enables the user to set the position of the text in relation to the top edge of the crawl
background. This parameter allows the user to enter a specific value (in pixels) for the position
of the text in the crawl. For example, if the height of the crawl (background) is 500 pixels, and
the baseline is set to 400, then the text would be placed near the bottom of the crawl
background. However, if the user sets the baseline to 80 pixels, then the text would be placed
near the top of the crawl background.

Baseline Anchor option provides a quick method of positioning the text relative to the top edge
of the crawl, which enables the user to set the anchor of the text. There are four options to
select from which allows the user to vertically position the text in the crawl background bar. The
options are None, Top, Center and Bottom. For example, if Top is the selected value, Overture
Media Designer will place the inserted text at the top of the crawl background. OMD
automatically adjusts the position of the text when this value is set.

Height enables the user to set the height of the crawl, which is the crawl background not the
text. The entered height value must be a multiple of 4.

Width enables the user to view the width of the crawl, which is the crawl background not the
text. The entered width value must be a multiple of 4.

X enables the user to set the horizontal position of the crawl on the canvas. The entered value
must be a multiple of 2. The position of the crawl can be adjusted manually by entering the X
coordinate into the property box or by using the mouse to move the crawl and place it in the
desired location on the design canvas. If the crawl is moved with the mouse, the coordinates
will be reflected in the X field.

Y enables the user to set the vertical position of the crawl on the design canvas. The entered
value must be a multiple of 2. The position of the crawl can be adjusted manually by entering
the Y coordinate into the property box or by using the mouse to move the object and place it in
the desired location on the design canvas. If the crawl is moved with the mouse, the
coordinates will be reflected in the Y field.

When adjusting the top or bottom of the crawl background, the user should note

background is less than the font height of the crawl text, cropping of the text will
occur. Users should be aware of this when making the adjustments.
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4.3.3. Crawl Data Window

The Data property enables the user to set the data content of the crawl. The user can enter static text
into the crawl, provide a text file as the content of the crawl, or define a Really Simple Syndication (RSS
2.0) feed as the source for content of the crawl.

If the object is selected on the design canvas, the properties window will appear and the user can

|
=

select the data button to view and edit the object’s data.

The user can change the content of the crawl by specifying the particular data source to use. Select
the specific parameter (either Text String, Text File or RSS) from the Data Source and then select the
appropriate field to enter the data.

Properties x

Showing Object: crawl

Object | Compiler

F —1]
- % )
i || L

B Behaviour
[Data Separatar
Daka Source Skatic Text
E Data Source
Z5% File
Daka Figld 1
Daka Field 2
Draka Field 3
Daka Field 4
Daka Figld 5
QDEC Conneckion
E External Text File
Filename
E RrRss
URL
Update Inkerwval
B static Text
Text String Replace this bext

w0y 1032 -- Wideo hi0 w516

Figure 4-28: Crawl Data Tab

4.3.3.1. Data Behaviour

o Data Separator enable the user to set separators for the RSS, Text File, and Text String.

A crawl separator is a placeholder indicating where an image will be inserted into the crawl.
This image is being referenced from the keyer file system (via the internal compact flash,
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external compact flash or on the network attached storage system — NAS). The separator
image can be created in two ways via Overture. Firstly, it can be created manually by inserting a
static or animated logo. The other option is to add bullets to a crawl, which create logos when
the project is compiled. See section 4.3.6 and 4.3.7.

When using an external text file or RSS feed the user can (optionally) fill in the data separator.
The data separator is meant to serve as an easy way to divide topic "headlines" with a graphical
bullet. If the data separator has been filled in, then each time the crawl encounters a new line in
the text file it will automatically insert the data separator text into the text that it is going to
display, which will cause the crawl to show the designated "bullet". The data separator field is
not mandatory if the <graphic nhame=""> syntax appears in the original text string (whether text
file or RSS).

The output filename of the each bullet must match the name defined in the
g separator. See section 4.3.7.

4.3.3.2. Data Source

In order to access the data source controls, the data source selected in the behaviour section must be
set to External Text File.

e CSV File enables the user to load a csv file as the source data. Loading a csv file enables the
user to pull information from the CSV file and assign it to the CG Item lines.

e Data Field 1 to 5 enables the user to enter the text for each individual Line. The user can enter

unique text information for each Line. Upon selecting the appropriate button o] to launch the
corresponding field, the user can fill in unique information for that Crawl Data field.
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Editing: Data Field 1
|

I J [ Cancel

Figure 4-29: Editing Data Field 1

e ODBC Connection enables the user to connect to an ODBC Connection. The ODBC enables
connection to a data source, filter, and provides results to the keyer for dynamic crawls and CG
Items.

When the ODBC Connection button is pressed EJ the user will be presented with an ODBC
Connection Setup Dialog Box as shown in Figure 4-30.
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ODBC Connection Setup

Connection Info
Specify the ODBC connection setkings.,
Data Source Mame:

Jsername:

Password;

SOL Query:

Test Connection

Cancel

Figure 4-30: ODBC Connection Setup

o Data Source Name: Specify the name of the data source to which you are connecting.
0 Username: Enter the appropriate ODBC Connection username.

o0 Password: Enter the appropriate ODBC Connection password.

0 SQL Query: Enter the SQL Query information into the SQL Query field.

0 Test Connection: This button enables the user to test the ODBC connection.

4.3.3.3. External Text File

The user can dynamically change the content of the crawl by selecting the Text File parameter from

the Data Source property. Choose the file by selecting the -] button and then specify a particular text
file to use. When the crawl is activated on the Program, the contents of the crawl! will be read from the
text file. The user can now update the contents of the crawl by updating the text file, then uploading it
onto the device.

o Filename enables the user to enter the Text File content, when the Text File option is selected
from the Data Source property.

By default, when using an external text file, the keyer inserts a graphical “bullet” each time a
new line is found in the external text file. The bullet that gets inserted is specified using the
separator field in Overture. This indicates that the same bullet will be inserted for each new line
in the text file.
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Also, users can embed the <graphic name="bullet_name”> syntax directly into the external text
file to control where the bullet images will appear in the text order.

The text data file and the crawl MUST be put on the SAME compact flash storage
,@5 drive of the Media Inserter. When the crawl is pre-cached, the text data file is also
loaded.

4.3.3.3.1. Managing Bullets using the External Text File

If the crawl uses an external text file then OMD is not the creator of the text file contents. This indicates
that the text file creator must add the <graphic name=""> syntax to the text file in the places where they
want bullets to appear, see Figure 4-31. The advantage of using an external text file is that the crawl
logo does not need recompiling whenever the text file contents change. The bullets that were added to
the crawl at the time of crawl creation were automatically scaled (sized) by OMD to fit in the crawl.
Other previously created bullets can be called by the text file but there is no guarantee that the bullets
will "fit" into the crawl properly.

- w

& Crawl_Test - Motepad E]@

File Edit Formak Yiew Help

This is the first crawl headline <graphic name = "bullet-1"=
This is the second crawl headline <graphic name = "bullet-1"=
This iz the third crawl headline <graphic name = "bullet-1"=
This iz the fourth crawl headline <graphic name = "bullet-1"=

This 1= the fiftth crawl headline <graphic name = "bullet-1"=

Figure 4-31: Creating Bullets using Text Files

The difference between RSS feeds and external text files is that when the </title> tag is found in the
RSS feed it will insert the data separator text as opposed to a new line causing the same insertion
when using external text files.

When the separator is assigned in OMD, the bullet will appear after every line return.

The output filename of the each bullet must match the name defined in the
,g separator.
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4.3.3.4. RSS

For RSS, the user selects the RSS option from the Data Source menu. Click in the RSS URL field and

select the (o] button. A dialog box will appear and the user can enter the location of the RSS feed. For
example, for CNN Top Stories RSS feed, the user will need to find the IP address of the source. In this
case, the IP address and path for this feed is:

http://66.150.96.119/rss/cnn_topstories.rss

The user is required to enter the COMPLETE path. An update interval will need to be configured to
determine how often the device will check the RSS source for updates.

For the RSS to work correctly, the 9725 device MUST have a direct connection to
/@ the Internet. The connection MUST NOT have a firewall in its path.

¢ URL field enables the user to set the source of the RSS.

The bullet is inserted in the same manner as the External Text File. In the case of the RSS, the
keyer will automatically connect to the RSS URL and retrieve a new copy of the information at
intervals determined by the “Update Interval” field.

e Update Interval enables the user to determine how often the device will check the RSS source
for updates. The interval value is specified in seconds.

4.3.3.4.1. Managing Bullets using RSS

If the crawl uses an RSS feed then the RSS data feed must have the <graphic name=""> syntax
embedded in it. The RSS feed has the same benefit as an external text file since the crawl does not
need to be recompiled but also has the same limitations in that bullets could have been created in the
wrong size.

The RSS feed can contain the <graphic name=""> syntax. The difference between RSS feeds and
external text files is that when the </title> tag is found in the RSS feed it will insert the data separator
text as opposed to a new line causing the same insertion when using external text files.

The output filename of the each bullet must match the name defined in the
g separator.

4.3.3.5. Static Text

For the user to access the Static Text option, select the Static Text item from the Data Source menu.
Once selected, click the (-] button in the Text String field to enter the text string content.

e Text String enables the user to enter the Text Script content, when the Text String option is
selected from the Data Source property.

If neither the RSS or external text file is used, the text information in the crawl is specified by
entering the desired text into the Text String field in Overture. In order to display the bullet, the
user must enter the bullet filename directly into the Text String field.
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For example, Text String = Weather Alert <graphic name="alert_bullet’>. A weather alert has
been issued for Erie County. <graphic hame="topic_bullet"> In other news....etc.

In order for the Crawl to function properly, the user MUST ensure the selected Font
,@5 Type is loaded onto the device.

4.3.35.1. Managing Bullets using Static Text

If the crawl uses static text then the <graphic name=""> syntax must be added to the static text string
entered in OMD, see Figure 4-32. The static text gets embedded into the crawl logo and cannot be
changed without recompiling the crawl. The user can place the separator anywhere within text.

Editing: Text String

This is the First crawl headline <graphic name = "bullet-1"=
This is the second crawl headline <graphic name = "bullet-1"=
This is the third crawl headline <graphic name = "bullet-1"
This is the Fourth crawl headline <graphic name = "bullet-1" =
This is the fifth crawl headline <graphic name = "bullet-1"=

[ Ok ][ Cancel ]

Figure 4-32: Creating Bullets using Static Text
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4.3.4. Crawl Effects Window

The Effects panel enables the user to specify the transition effects for the Crawl object. If the object is
selected on the design canvas, the properties window will appear and the user can select the effects

button L to view and edit the object effects.

Properties x

Showing Object: crawl

Object | Compiler

E Fade Settings
Fade In
Fade Cuk 8
Hold
Cpacity 100
B Quick In
Action Fade
Direction
Curation 15
Enabled False
B Quick Out
Action Fade
Direction
Curation 15
Enabled False

10y 1032 -- Video bl w516

Figure 4-33: Crawl Effects Window

4.3.4.1. Crawl Fade Settings

e Fade In enables the user to specify the Fade In duration (in frames). The valid range is 1 to 600
frames.

e Fade Out enables the user to specify the Fade Out duration (in frames). The valid range is 1 to
600 frames.

e Hold enables the user to specify the hold duration (in frames). Enter a value of 0 to hold the
media on-air until taken out. A valid transition hold time range is from 1 to 600 frames.

e Opacity enables the user to set the opacity of the crawl fade with a valid range of 0 to 100%.
The opacity control specifies the key value applied to the media.
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4.3.4.2. Crawl Quick In

The Quick Effects In provides the following options:

e Action enables the user to set the action to be executed when the media is triggered.
The three actions available include fade, wipe, and push.

o Direction enables the user to specify the direction of the action (Does not apply to Fade
actions).

e Duration allows the user to specify the duration of the action (in frames).

e Enabled, when set to true, the quick effects action will be enabled. When set to false,
the quick effects action will be disabled.

4.3.4.3. Crawl Quick Out

The Quick Effects Out provides the following options:

e Action enables the user to set the action to be executed when the media is triggered.
The three actions available include fade, wipe, and push.

o Direction enables the user to specify the direction of the action (Does not apply to Fade
actions).

e Duration allows the user to specify the duration of the action (in frames).

e Enabled, when set to true, the quick effects action will be enabled. When set to false,
the quick effects action will be disabled.

4.3.5. Crawl Compiler Window

The compiler window enables the user to set the properties of the object, which will be used to identify
the individual object name and output layer when the playlist is compiled.

Properties x

Showing Object: crawl

Object | Compiler

E General
Exclude From Build | False
Cukpuk Filename crawl
Oukpuk Laver 093

w0y 1032 -- Wideo hi0 w516

Figure 4-34: Crawl Compiler Window
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o Exclude From Build enables the user to set whether the selected object will be included or
excluded from the compiling process. Select True if the user does NOT want the selected
object to be included in the compile build. Select False if the user does want to include the
selected object in the compile build.

e Output Filename enables the user to assign the object an output filename. When the project is
compiled, the object will be identified by the name specified in this field.

o Output Layer enables the user to assign the object to an output layer. This setting determines
the output layer of the object.

4.3.6. Adding a Static or Animated Graphic to the Crawl

Overture will allow users to import logos or scale static images, animated graphics or movies to fit into
a crawl. This is accomplished by right-clicking the crawl on the design canvas and selecting one of the
options listed in the Add Bullets sub-menu. The following sections describe how to insert the different
types of bullets.

Please note that when bullets are added in OMD it does not mean that the bullet will
actually appear in the crawl. The determining factor is whether the string that the
g crawl is displaying wants the bullets to appear. This is set using the Data Crawl
behaviours, see section 4.3.3. Making bullets appear can happen in one of three
ways; External Text File (4.3.3.3), RSS Feed (4.3.3.4), Static Text (see section 4.3.3.5).

In general, bullets are added to the crawl in OMD to ensure that the bullet is the right size and aspect
ratio for the crawl being generated. The crawl text *must* infer usage of the bullet by encoding the html
syntax <graphic name="bulletname"> at the position in the text string where the user wants the bullet to

appear.

25

The output filename of the each bullet must match the name defined in the
separator.

4.3.6.1. Add Bullets Using an Image

To insert an image into a crawl select Bullets > Add Image... option from the right-click crawl menu.
Once this option is selected, the Select Source Graphic window will appear as shown in Figure 4-43.
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Select Source Graphic
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Figure 4-35: Select Source Graphic

Locate the desired file in the appropriate directory and select the Open button. If the logo is too large
to fit into the crawl, a Size Options screen will appear as shown in Figure 4-44.

The following options will

be displayed:

o Fitresource inside object resizes the logo to fit inside the dimensions of the crawl.
0 Increase object height stretches the height of the crawl in order for the logo to fit inside the

crawl.

0 Leave as is (clipping may occur) inserts the logo into the crawl without resizing the logo.
The logo may be clipped if it is larger than the crawl.

OVERTURE MEDIA DESIGNER
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Size Options

The selected resource exceeds the ohject height. Please select a size
option from the list of options provided below.

Size Options

{*) Fit resource inside object
() Increase object height

) Leave as is {clipping may ocour

[ Ok ] [ Cancel ]

Figure 4-36: Size Options Window

4.3.6.2. Add Bullets Using an Image Sequence

To insert an image sequence into a crawl select Bullets > Add Image Sequence... option from the
right-click crawl menu. The Image Sequence Builder window will appear and the user will be
prompted to insert an image, as shown in Figure 4-37.

The Image Sequence Builder is divided into two sections: Source Graphics and Key Graphics
(Optional). The Source Graphics column inserts the actual image(s), whereas the Key Graphics
(Optional) column is used to add image(s) that represent how the fill image is presented on the screen.

The Source is the image that appears on the design canvas and the Key is the space that the image
fills.
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Image Sequence Builder
Source Graphics Kew Graphics (Optional)
Mame Path Marne Path
< [ £ >

Figure 4-37: Image Sequence Builder Window

The user can add a fill image or multiple images by selecting the Add... button under the Source
Graphics column. The Select Image(s) dialog box will appear as shown in Figure 4-38. The Select
Image(s) window allows the user to navigate to the appropriate directory, and select the desired image.
Select the Open button to add the image(s) to the Source Graphics list. Repeat the same procedure
to insert the image(s) into the Key Graphics (Optional) column.
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Select Image(s)
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Figure 4-38: Select Image(s) Window

It is common for a screen such as the one shown in Figure 4-39 to appear when selecting and opening

an image. The Select

image that is part of a larger sequence of images.

Insert Operation window may appear if the user is trying to import a single
To insert all of the images in a sequence select the

Insert Complete Sequence option. To insert only the images listed after the selected image in the

sequence, select the Insert Partial Sequence (from selection to end) option.

To insert only the

individual image, select the Insert Selected Image option. Once an option is selected the image(s) will
be displayed in the appropriate column of the Image Sequence Builder window.
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Select Insert Cperation

Crverbure has determined that the selected image is part of an animation sequence,
Please select the desired operation from the options provided belaw,

Insert Complete Sequence

Ewvertz_Logo-Large0ooo,kf ...
Evertz_Logo-Largel0ss, ki

k

Inzert Partial Sequence
{from selection to end)

Evertz_Logo-Large0ooo.kf ...
Evertz_Logo-Largeliss, ki

b

Insert Selected Image
Evertz_[ogo-Large0ooo, ki

k-

Figure 4-39: Select Import Function Window

To remove an image from either the Source Graphics or the Key Graphics (Optional) column,
highlight the image in the appropriate column and select the Delete button under the corresponding
column.

Once the desired images have been selected, click on the Continue button at the bottom of the
window.

If the image(s) is larger than the crawl dimensions, the Size Options window (see Figure 4-40) will
appear and display the following options:
o Fitresourceinside object resizes the image to fit inside the dimensions of the crawl.
0 Increase object height stretches the height of the image in order for the image to fit inside
the crawl.
o0 Leave as is (clipping may occur) inserts the image into the crawl without resizing the image.
The image may be clipped if it is larger than the crawl.
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Size Options

The selected resource exceeds the ohject height. Please select a size
option from the list of options provided below.

Size Options

{*) Fit resource inside object
() Increase object height

) Leave as is {clipping may ocour

[ Ok ] [ Cancel ]

Figure 4-40: Size Options Window

4.3.6.3. Add Bullets Using a Video Clip

To insert a video clip into a crawl select Bullets > Add Video Clip... option from the right-click crawl
menu. Once this option is selected, the Select Source Movie window will appear as shown in Figure
4-41. Locate the movie file (.avi or .mov) and select the Open button to insert the movie into the crawl.

P

Select Source Movie

Look ir: | ¢ My Computer v O & o [T~

5 ,ﬁ, 314 Flappy (A0
L ’f; “e Local Disk ()

My Fecent b CD Drive (D02
D ocuments

Desktop

by D ocuments

.II
48
My Computer

) B
My Mebwork Files of type: All Supported Movies [ avi:”.maov] [ |

Figure 4-41: Select Source Movie Window
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If the movie’s dimensions are larger than the crawl dimensions, the Size Options window (see Figure

4-42) will appear and display the following options:
o Fitresource inside object resizes the movie to fit inside the dimensions of the crawl.

0 Increase object height stretches the height of the movie in order for the movie to fit inside

the crawl.
Leave as is (clipping may occur) inserts the image into the crawl without resizing the image.

The movie may be clipped if it is larger than the crawl.

0]

Size Options

The selected resource exceeds the ohject height. Please select a size
option from the list of options provided below.

Size Options
{*) Fit resource inside object
() Increase object height

) Leave as is {clipping may ocour

[ Ok ] [ Cancel ]

Figure 4-42: Size Options Window

OVERTURE MEDIA DESIGNER Revision 1.9.2 Page 4-43



Overture Suite 2.3 Software Manual everl’_zO

4.3.6.4. Add Bullets by Using Existing Logos

To insert a logo into a crawl select Bullets > Import Logo option from the right-click crawl menu. Once
this option is selected, the Select Source Logo window will appear as shown in Figure 4-43.

Select Source Logo
Lookir: | & My Computer [ Q 5 i e
-4 14 3% Floppy (2
"3 “e# | ocal Disk (C:)
My Flecent 5D Drive (D)
Documents
f__,_.a
Deskiop
ty Documents
w58
tdy Computer
‘MJ File: narne: [ |
by Hetwork Files of type: EYL (""" evl) w |

Figure 4-43: Select Source Logo

Locate the desired file in the appropriate directory and select the Open button. If the logo is too large
to fit into the crawl, a Size Options screen will appear as shown in Figure 4-44.

The following options will be displayed:
o0 Fitresource inside object resizes the logo to fit inside the dimensions of the crawl.

0 Increase object height stretches the height of the crawl in order for the logo to fit inside the

crawl.
0 Leave as is (clipping may occur) inserts the logo into the crawl without resizing the logo.

The logo may be clipped if it is larger than the crawl.

Size Options

The selected resource exceeds the object height. Please select a size
option from the list of options provided below.

Size Options

(%) Fit resource inside object

() Increase object height

(") Leave as is {clipping may occur)

[ oK ][ Cancel ]

Figure 4-44: Size Options Window
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4.3.7. Managing Bullets

Once bullets are present in the crawl, the bullets can be managed. The crawl must be selected on the
design canvas in order to enable bullet management. Select the crawl and right-click the crawl object
then select the Manage Bullets item from the pop up menu, or navigate to the toolbar and select the

Object > Manage Bullets menu item. The following Manage Bullets screen will appear, as shown in
Figure 4-45.

| Manage Bullets

Bullets

Output File: {not specified)
Source: Skatic Image
Sevs e Length: 00:00:00.01
hAZ Vi Pinkxdpubloverturelgraphicsievertz\Evertz_Lo. . \Evertz_Logo-Large0000, LF Delete

Propetties

i

Output File: (not specified)
Source: Static Image

Ealq Length: 00:00:00.01
—————' :\Documents and SettingsiUserix-LINK_|ogo-blk-blk.png

Compiler Settings

Cutput File:

[ Save ] [ Cancel ]

Figure 4-45: Manage Bullets

The Bullets Manager enables the user to adjust the playback properties and remove the crawl bullets.
The user can edit the playback of the bullet frame-by-frame, the same way that the user modifies the
playback sequence of an animation or movie clip. To modify the playback sequence of a bullet, select
the desired object in the Manage Bullets window. The bullet will be highlighted in blue, indicating that
the specific bullet has been selected. Once selected, click on the properties button to modify the
object. Refer to section 4.3.8 for instruction on how to edit the playback properties in the bullet loop
point editor. Once the user has edited the sequence, select the OK button to apply changes and return
to the Manage Bullets window. Select Cancel to exit the Bullet Loop Point Editor and return to the
Manage Bullets window without applying the changes.
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The Bullet Manager also allows the user to remove a bullet from the crawl. To remove a bullet, highlight
the bullet in the Manage Bullet window and select the Delete button.

There is an Output File field at the bottom of the Manage Bullets window, which enables the user to
change the output name. To specify an output file name, highlight the bullet in the Manage Bullet
window and type an identifier name in the Output File field. The bullet will be assigned an output name,
which is used to identify the file when the project is compiled.

Any editing that has been done in the Bullet Manager, including the modifications made in the bullet
loop point editor, will not take effect unless the SAVE button is pressed. Otherwise, the changes made

will be cancelled when the CANCEL button is selected or the close button .__] is clicked. Once the
bullet manager has been closed, any editing can be undone by using the undo/redo options.

Please note that when bullets are added in OMD it does not mean that the bullet will
actually appear in the crawl. The determining factor is whether the string that the
g crawl is displaying wants the bullets to appear. This is set using the Data Crawl
behaviours, see section 4.3.3. Making bullets appear can happen in one of three
ways; External Text File (4.3.3.3), RSS Feed (4.3.3.4), Static Text (see section 4.3.3.5).

In general, bullets are added to the crawl in OMD to ensure that the bullet is the right size and aspect
ratio for the crawl being generated. The crawl text *must* infer usage of the bullet by encoding the html
syntax <graphic name="bulletname"> at the position in the text string where the user wants the bullet to
appear.

4.3.7.1. Managing Bullets using the External Text File

If the crawl uses an external text file then OMD is not the creator of the text file contents. This indicates
that the text file creator must add the <graphic name=""> syntax to the text file in the places where they
want bullets to appear, see Figure 4-46). The advantage of using an external text file is that the crawl
logo does not need recompiling whenever the text file contents change. The bullets that were added to
the crawl at the time of crawl creation were automatically scaled (sized) by OMD to fit in the crawl.
Other previously created bullets can be called by the text file but there is no guarantee that the bullets
will "fit" into the crawl properly.
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& Crawl_Test - Motepad E]@

File Edit Format Wiew Help

This is the first crawl headline <graphic name = "bullet-1">
This is the second crawl headline <graphic name = "bullet-1">
This is the third crawl headline <graphic name = "bullet-1"=
This is the fourth crawl headline <graphic name = "bullet-1"»

This i1z the fifth crawl headline <graphic name = "bullet-1"=

Figure 4-46: Creating Bullets using Text Files

The difference between RSS feeds and external text files is that when the </title> tag is found in the
RSS feed it will insert the data separator text as opposed to a new line causing the same insertion
when using external text files.

When the separator is assigned in OMD, the bullet will appear after every line return.

The output filename of the each bullet must match the name defined in the
,@5 separator.

4.3.7.2. Managing Bullets using RSS

If the crawl uses an RSS feed then the RSS data feed must have the <graphic name=""> syntax
embedded in it. The RSS feed has the same benefit as an external text file since the crawl does not
need to be recompiled but also has the same limitations in that bullets could have been created in the
wrong size.

The RSS feed can contain the <graphic name=""> syntax. The difference between RSS feeds and
external text files is that when the </title> tag is found in the RSS feed it will insert the data separator
text as opposed to a new line causing the same insertion when using external text files.

The output filename of the each bullet must match the name defined in the
,g separator.
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4.3.7.3. Managing Bullets using Static Text

un

If the crawl uses static text then the <graphic name=""> syntax must be added to the static text string
entered in OMD, see Figure 4-47. The static text gets embedded into the crawl logo and cannot be
changed without recompiling the crawl. The user can place the separator anywhere within text.

.

Editing: Text String

This is the First crawl headline <graphic name = "bullet-1"=
This is the second crawl headline <graphic name = "bullet-1"=
This is the third crawl headline <graphic name = "bullet-1"
This is the Fourth crawl headline <graphic name = "bullet-1" =
This is the fifth crawl headline <graphic name = "bullet-1"=

[ Ok ][ Cancel ]

Figure 4-47: Creating Bullets using Static Text

4.3.7.4. Managing Separators

When using an external text file or RSS feed the user can (optionally) fill in the data separator. The
data separator is meant to serve as an easy way to divide topic "headlines" with a graphical bullet. If
the data separator has been filled in, then each time the crawl encounters a new line in the text file it
will automatically insert the data separator text into the text that it is going to display, which will cause
the crawl to show the designated "bullet”. The data separator field is not mandatory if the <graphic
name=""> syntax appears in the original text string (whether text file or RSS).

4.3.8. Bullet Loop Point Editor

The Loop Point Control window displays each individual frame in an image sequence (see Figure
4-75). Each frame is numbered in the bottom left hand corner of the individual frame box.
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Bullet Loop Point Editor

Segment Start End Status
2 Frame: 1 1 Repeat Cnce
Opacity: 0% 100%%

[ 4 ‘ l Cancel

Figure 4-48: Bullet Loop Point Editor

The Loop Point Control window enables the user to view the properties of the loop points. The
Sequence column identifies the number of loop points (key frames) present in the image sequence.
When the Loop Point Control window is first opened it will display the number 2 in the Sequence
column. These two points indicate the beginning point (frame 1) and the end point (last frame). For
example, Figure 4-75 shows that the image sequence is 60 frames in length; therefore, the Start frame
is 1 and the End frame is 60.

The Start column identifies the frame number of the first frame in a frame segment and the End column
identifies the frame number of the last frame in the frame segment. For example, an image sequence
is 30 frames in length and a new loop point is inserted at frame 10, creating a total of three loop points
in this sequence. Therefore, the first frame segment would Start at 1 and End at 9 and the second
frame segment would Start at 10 and End at 30.

The Opacity property displays the opacity of the frame. The opacity of the selected loop point can be
adjusted to create a fade effect. For example, setting the opacity of a Start point to 0% and the opacity
of the End point to 100% will create a fade in effect.

The Status column displays whether the frame segment is held until taken out or repeated at the
selected loop point.

The loop points can be adjusted using key commands or mouse controls. Sections 4.3.8.1 and 4.3.8.2
describe these controls.
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4.3.8.1. Editing the Loop Points Using the Keyboard Controls

The loop points and frame segments can be edited using the key commands on the keyboard. Table
4-1 provides a list of keyboard commands that can be used to insert, edit and adjust loop point controls.

KEY DESCRIPTION

LEFT arrow The LEFT arrow key is used to navigate to the previous frame in the animated

== image sequence.

RIGHT arrow The RIGHT arrow key is used to navigate to the next frame in the animated image

— sequence.

+ The PLUS key (1) is used to zoom in on the frames view.

- The MINUS key (-) is used to zoom out on the frames view.

| The “I1” key is used to insert a loop point in the current (selected) frame.

The “D” key is used to delete a loop point in the current (selected) frame.

The “H” key is used to insert a hold. The hold is applied to the segment of frames
between the two loop points. The segment will be marked as Hold Until Taken
Out under the status column in the loop point editor.

Note that currently only one hold sequence per animation is supported. Therefore,
other existing hold sequences will be changed to “Repeat Once”. This change is
performed without warning.

R The “R” key is used to increase the number of repeat counts of a segment. Each
time the “R” key is pressed another repeat count is added.

R + SHIFT By holding the SHIFT key while pressing the “R” key, the user can decrease the
number of repeat counts of a segment. Each time the “R” + SHIFT keys are
pressed a repeat count is removed.

UP arrow ‘I When positioned on a loop point (key frame), the UP arrow will increase the opacity

in 1% increments.

DOWN arrow l

When positioned on a loop point (key frame), the DOWN arrow will decrease the
opacity in 1% increments.

UP arrow When positioned on a loop point (key frame), holding the SHIFT key while pressing
+ SHIFT the UP arrow will increase the opacity to 100%.

DOWN arrow 1 When positioned on a loop point (key frame), holding the SHIFT key while pressing
+ SHIFT the DOWN arrow will decrease the opacity to 0%.

Table 4-1: Loop Point Control Key Commands for Image Objects
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4.3.8.2. Editing the Loop Points Using the Mouse Controls

The loop point parameters can also be adjusted using the mouse controls. Double-clicking a frame in
the sequence will insert a loop point at the beginning of the selected frame. To adjust the opacity of the
loop point, select and move the point up or down to the desired opacity level. While dragging the loop
point up and down, the Opacity column will display the numeric opacity value.

To access other loop point controls, right mouse click on a frame in the sequence to reveal the loop
point menu. The loop point menu, shown in Figure 4-76, enables the user to edit the loop point
parameters using the following controls.

Insert Fade Point:

Repeat Once
FRepeat =2
Repeat x5
Cuskom Repeat. ..

Hold until FADE SUT {Loop)

Delete

Figure 4-49: Loop Point Menu

¢ Insert Fade Point enables the user to insert a loop point in the current (selected) frame.

o Repeat Once enables the user to repeat the frame segment once.

o Repeat x2 enables the user to repeat the frame segment twice.

o Repeat x5 enables the user to repeat the frame segment five times.

e Custom Repeat enables the user to assign the number of times the frame segment will repeat.
Selecting this option will reveal the Custom Repeat dialog box, as shown in Figure 4-50. The

user will enter the desired custom repeat value into the Repeat field and then select the OK
button.

Custom Repeat

Enter the custom repeat walue in the box provided below,

£
w

Repeat; | &

[ (0] 4 ] [ Cancel

Figure 4-50: Custom Repeat Dialog Box
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e Hold until FADE OUT (Loop) enables the user to insert a hold. The hold is applied to the
segment of frames between the two loop points.

Note that currently only one hold sequence per animation is supported. Therefore, other

existing hold sequences will be changed to “Repeat Once”. This change is performed without
warning.

o Delete will remove the loop point from the sequence. The Delete option will be grayed out if
the user has NOT right mouse clicked a selected loop point in the sequence.
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4.4. CREATING ACGITEM

The CG Item feature allows the user to create a one to three line “headliner” that can be faded, wiped,
or pushed on. The source of the headliner is a text file created by the user that contains the desired
headliners.

To create a CG Item, the user can select the CG Item from the Object menu (see section 4.2.5) or the
main toolbar. The CG Item consists of three lines of text and a display area. The user can set the
placement of the CG Item by selecting and dragging it to the desired position using the mouse or by
entering the desired coordinates in the Placement property of the CG Item Property Settings panel.

| El Untitled® - Overture Media Designer l;l!EJ
File Edit Media Object Buld VYiew Help

oy i is ¢ b g

: 6
| = i ) & e
| | Properties X
Zoom: 100% Showing Object: cg

120x108 Object | Compiler

v B
@2 = F

B Appearance
Fank Mame: Arial
Fonk Outline
Fank Shadow
Fank Size 43
T ‘t L 2 Text Colar [ 255285255 100%
ex ine = Behaviour
Text Line 3 ftion Fade
= Direction
Text L!ne 4 Duration 30
Text Line 5 Hold Time &0
Text Line 6 Repeat L
Text Llne 7 5 E::::;ent Don't Resume
Text Line 8 ncher conter
Text Line 9 et 0
Text Line 10 e 10
Line 2
Line 3
Line 4
Line 5
Line &
Line 7
Line &
Line 9
Width 400
% 246
¥ 154

x:246 y: 154 — Video hi246 v:77

Figure 4-51: CG Item on Design Canvas
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44.1. CGltem Menu

To access the CG Item menu, select the CG Item on the design canvas and right-click the mouse
button. The CG Item menu provides the options shown in Figure 4-52.

Unda Chrl+Z

Bring to Tap
Mowe Up

Movwe Diown
Send to Botkom

Delete

Figure 4-52: CG Item Menu

e Undo enables the user to undo the previous action.

e Redo enables the user to reinstate the undone action.

¢ Bring to Top enables the user to bring the selected object to the top of the object stack.

e Move Up enables the user to bring an object one step closer to the front.

¢ Move Down enables the user to send an object one step closer to the back.

e Send to Bottom enables the user to send the selected object to the bottom of the object stack.

o Delete enables the user to remove the object from the design canvas.
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4.4.2. CG Item Appearance

When the object is selected on the design canvas, the properties window will appear and the user can

select the appearance button =%/ {0 view and edit the object’s appearance (see Figure 4-53).
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Figure 4-53: CG Item Attributes
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4.4.2.1. CG Item Appearance

e Font Name enables the user to specify the font type of the text.
e Font Outline enables the user to add an outline to the text.
o Colour enables the user to set the colour of the font outline.

o Show Outline has two options, true or false. When set to true the font outline is visible
and when set to false the font outline is hidden.

0 Size enables the user to set the size of the font outline.
¢ Font Shadow enables the user to add a shadow to the text.
o Colour enables the user to set the colour of the font shadow.

o0 Depth; H enables the user to set the horizontal depth of the shadow around the text. The
range of the shadow depth is from 1 to 16 pixels.

o Depth; V enables the user to set the vertical depth of the shadow around the text. The
range of the shadow depth is from 1 to 16 pixels.

o Show Shadow has two options, true or false. When set to true the font shadow is visible
and when set to false the font shadow is hidden.

o Font Size enables the user to adjust the size of the font.

e Text Colour enables the user to adjust the colour of the font.

4.4.2.2. CG ltem Behaviour

o Action enables the user to set the action of the CG Item. The three action options are Fade,
Wipe, or Push.

o Direction enables the user to specify the direction of the action. There are four direction
options: Left, Right, Up and Down.

e Duration enables the user to specify the duration of the action (in frames). The transition time
range is from 1 to 60 frames.

¢ Hold Time enables the user to set the duration of the transition in frames. The valid transition
hold time range is from 1 to 600 frames.

o Repeat enables the user to select the number of times that the logo can be repeated. The
repeat function is written into the logo, so that when it is exported and played out the logo will be
repeated the number of times designated in OMD.

e Resume enables the user to determine whether the logo should return to its last on-air state
once it has played out or not resume playout. The options are Don’'t Resume and Last On-Air
State.
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4.4.2.3. CG ltem Placement

Overture enables the user to accurately place an image on the design canvas. The placement of the
object is determined by pixel and line position of the object with respect to the top-left corner (0,0) of
the video standard. The user can enter these values or use the mouse to move the object. The size of
the object box is determined in terms of pixels and lines from the top-left corner of the highlighted
object box.

When defining either the height or width of the display, the user MUST be aware they are defining the
area where the text will appear. If the font or text line is too large or too long, this area will crop the text
based on its size.

e Anchor enables the user to set the anchor (start point) for the CG Item. There are three
options to select from, which allows the user to vertically position the CG Item in the CG text
space. The options are Left, Center and Right.

o Height enables the user to view the height of the CG Item. The height value must be set to a
multiple of 4.

The CG Item can support up to 10 lines. The position of each line can be set individually. For the sake
of simplicity, only Line 1 will be described in this manual.

Line 1

0 X enables the user to set the horizontal position of Line 1 on the canvas. To adjust the
horizontal position of the CG Item, enter the desired coordinate for the X field of the Line 1
property. The entered value must be a multiple of 2.

0 Y enables the user to set the vertical position of Line 1 on the design canvas. To adjust
the vertical position of the CG Item, enter the desired coordinate for the Y field of the Line
1 property. The entered value must be a multiple of 2.

e Width enables the user to set the width of the CG Item background. The width value must be
set to a multiple of 4.

e X enables the user to set the overall horizontal position of the CG Item on the canvas. The
entered value must be a multiple of 2. The position of the CG Item can be adjusted by entering
the X coordinate into the property box or by using the mouse to move the object and place it in
the desired location on the design canvas. If the object is moved with the mouse, the
coordinates will be reflected in the X field.

e Y enables the user to set the overall vertical position of the CG Item on the design canvas. The
entered value must be a multiple of 2. The position of the CG Item can be adjusted by entering
the Y coordinate into the property box or by using the mouse to move the object and place it in
the desired location on the design canvas. If the object is moved with the mouse, the
coordinates will be reflected in the Y field.
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4.4.3. CG Iltem Data Window

If the CG Item object is selected on the design canvas, the properties window will appear and the user

i
=

can select the data button to view and edit the object’s data. See Figure 4-54.
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Figure 4-54: CG Item Data Window

4.4.3.1. Data Source

e CSV File enables the user to load a csv file as the source data. Loading a csv file enables the
user to pull information from the CSV file and assign it to the CG Item lines. The dialog box in
Figure 4-55 will open enabling the user to select the appropriate CSV file.

Page 4-58 Revision 1.9.2 OVERTURE MEDIA DESIGNER



everl’_z® Overture Suite 2.3 Software Manual

Select Source Text File E]

Look in: | ) previews "v._ A

5

L
My Recent
Dacuments

Dezktop

</

by Documents

)
53
ty Computer

kA Metwork, Filez of type: CSY Files [* cav)] [ |

Figure 4-55: Opening CSV File Dialog Box

e Line 1 to 10 Field enables the user to enter unique text information for each individual Line.

Upon selecting the appropriate button [e) to launch the corresponding field, the user can fill in
unique content for that CG Item.

Figure 4-56 displays the dialog box that will open when the Line 1 Field item is selected.
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Editing: Line 1 Field
|

I J [ Cancel

Figure 4-56: Line 1 Field Editing Window

e ODBC Connection enables the user to connect to an ODBC Connection. The ODBC enables
connection to a data source, filter, and provides results to the keyer for dynamic crawls and CG

Items.

When the ODBC Connection button is pressed (-] the user will be presented with an ODBC
Connection Setup Dialog Box as shown in Figure 4-57.

(0]

(0]

(0]

Data Source Name: Specify the name of the data source to which you are connecting.
Username: Enter the appropriate ODBC Connection username.

Password: Enter the appropriate ODBC Connection password.

SQL Query: Enter the SQL Query information into the SQL Query field.

Test Connection: This button enables the user to test the ODBC connection.
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Password;

SOL Query:
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Cancel

Figure 4-57: ODBC Connection Setup Window

4.4.3.2. CG ltem External Text File

e Filename enables the user to specify the source of the text file. The text file is a normal text
that contains the headlines.

4.4.3.2.1. Creating an External Text Source File

To create the source file, the user will need to use either WordPad or Notepad. The file is a simple
Text file (see Figure 4-58). In the file, each headline is separated by a blank line (carriage return only).
Currently, the CG text headliner feature allows for UP TO THREE lines per headline. The length of
each line in the headline is based on the font type and size selected for the headline.

The maximum size that the source file can be is 64 headlines or 8Kbytes
,@ (depending on which occurs first).
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" Headline1127 - Notepad Mi==

File Edit Format ‘iew Help

Favre ws. Holmgren
Green Bay wisits Seattle
Monday 9pm, EST

Saskatchewan Rough Riders Looking For Coach
Earrett, Riders part ways

Easeball Hall of Fame Nominees _
McGwire, Ripken Jr., Gwlynn on the List
Canseco also on ballot

Rapters win
Raptors beat up on Pacers
Eosh injured in the 3rd Quarter

Figure 4-58: Sample Text Source File

4.4.4. CG Item Effects Window
When the CG Item obiject is selected on the design canvas, the properties window will appear and the

J_—.'
user can select the effects button || to view and edit the object effects. See Figure 4-59. The Effects
panel enables the user to specify the transition effects for the CG Item object.
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Figure 4-59: CG Item Effects Window

44.4.1. CG Item Fade Settings
e Fade In enables the user to specify the Fade In duration (in frames). The valid range is 1 to 600
frames.

e Fade Out enables the user to specify the Fade Out duration (in frames). The valid range is 1 to
600 frames.

e Hold enables the user to specify the hold duration (in frames). Enter a value of 0 to hold the
media on-air until taken out. A valid transition hold time range is from 1 to 600 frames.

e Opacity enables the user to set the opacity of the CG Item fade with a valid range of 0 to 100%.
The Opacity control specifies the key value applied to the media.
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4.4.4.2. CG Item Quick In

e The Quick Effects In section provides the following options:

e Action enables the user to set the action to be executed when the media is triggered.
The three actions available include fade, wipe, and push.

o Direction enables the user to specify the direction of the action (Does not apply to Fade
actions).

e Duration allows the user to specify the duration of the action (in frames).

e Enabled, when set to true, the quick effects action will be enabled. When set to false,
the quick effects action will be disabled.

4.44.3. CG Item Quick Out

o The Quick Effects Out section provides the following options:

e Action enables the user to set the action to be executed when the media is triggered.
The three actions available include fade, wipe, and push.

o Direction enables the user to specify the direction of the action (Does not apply to Fade
actions).

e Duration allows the user to specify the duration of the action (in frames).

e Enabled, when set to true, the quick effects action will be enabled. When set to false,
the quick effects action will be disabled.

4.45. CG Item Compiler Window

The compiler window enables the user to set the properties of the object, which will be used to identify
the individual object name and output layer when the playlist is compiled.

Properties x

Showing Object: crawl

Object | Compiler

E General
Exclude From Build | False
Cukpuk Filename crawl
Cwkpuk Laver a5

w10y 1032 -- Video bl w516

Figure 4-60: Crawl Compiler Window
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e Exclude From Build enables the user to set whether the selected object will be included or
excluded from the compiling process. Select True if the user does NOT want the selected
object to be included in the compile build. Select False if the user does want to include the
selected object in the compile build.

¢ Output Filename enables the user to assign the object an output file name. When the project
is compiled, the object will be identified by the name specified in this field.

e Output Layer enables the user to assign the object to an output layer. This setting determines
the output layer of the object.

4.5. CREATING A DATE

To create a Date object, the user can select the Add Date option from the Object menu (see section
4.2.5) or the main toolbar. Once selected, the user will see a date object appear on the design canvas
as shown in Figure 4-61. The user can set the placement of the date by selecting and dragging it to the
desired position using the mouse or by entering the desired coordinates in the Placement property of
the Date Property Settings panel.

| ] Untitled® - Overture Media Designer IJ|§]
Fle Edt Media Object Buld View Help ]

e o
(O | b M (T A N E se

Design Canvas Propetties X

Zoom: 100% Showing Object: date
1920x 50) Object | Compiler
E Appearance

Drate Format Sadf ooy

Faont Name Arial

Font Size 48

Text Color |:| 255;255;255 100%
B Placement

Z 960

N 540

960 y: 540 -- Yideo h:960 v 270

Figure 4-61: Date Object on Design Canvas
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45.1. Date Menu

To access the Date menu, select the date object on the design canvas and right-click the mouse
button. The Date menu provides the options shown in Figure 4-62.

Unda Chrl+Z

Bring to Tap
Mowe Up

Movwe Diown
Send to Botkom

Delete

Figure 4-62: Date Menu

e Undo enables the user to undo the previous action.

e Redo enables the user to reinstate the undone action.

¢ Bring to Top enables the user to bring the selected object to the top of the object stack.

e Move Up enables the user to bring an object one step closer to the front.

¢ Move Down enables the user to send an object one step closer to the back.

e Send to Bottom enables the user to send the selected object to the bottom of the object stack.

e Delete enables the user to remove the object from the design canvas.

4.5.2. Date Appearance

When the date object is selected on the design canvas, the properties window will appear and the user

=

can select the appearance button %7/ to view and edit the object’'s appearance (see Figure 4-63).
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Figure 4-63: Date Property Settings Panel

4.5.2.1. Date Appearance

e Date Format enables the user to set the format of the date.
e Font Name enables the user to specify the font type of the date.
e Font Size enables the user to set the font size of the date.

e Text Colour enables the user to set the font colour of the date.

4.5.2.2. Date Placement

o X enables the user to set the horizontal position of the Date object on the canvas. The entered
value must be a multiple of 2. The position of the Date object can be adjusted by entering the X
coordinate into the property box or by using the mouse to move the Date object and place it in
the desired location on the design canvas. If the object is moved with the mouse, the
coordinates will be reflected in the X field.
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e Y enables the user to set the vertical position of the Date object on the design canvas. The
entered value must be a multiple of 2. The position of the Date object can be adjusted by
entering the Y coordinate into the property box or by using the mouse to move the Date object
and place it in the desired location on the design canvas. If the object is moved with the mouse,
the coordinates will be reflected in the Y field.

4.5.3. Date Effects
When the Date object is selected on the design canvas, the properties window will appear and the user

I . . . .
can select the effects button |~ to view and edit the object effects. See Figure 4-64. The Effects
panel enables the user to specify the transition effects for the date object.
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Figure 4-64. Date Effects Window

45.3.1. Date Fade Settings

e Fade In enables the user to specify the Fade In duration (in frames). The valid range is 1 to 600
frames.

e Fade Out enables the user to specify the Fade Out duration (in frames). The valid range is 1 to
600 frames.
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Hold enables the user to specify the hold duration (in frames). Enter a value of 0 to hold the
media on-air until taken out. A valid transition hold time range is from 1 to 600 frames.

e Opacity enables the user to set the opacity of the date fade with a valid range of 0 to 100%. The
opacity control specifies the key value applied to the media.

45.3.2. Date Quick In

The Quick Effects In section provides the following options:
e Action enables the user to set the action to be executed when the media is triggered. The three
actions available include fade, wipe, and push.
¢ Direction enables the user to specify the direction of the action (Does not apply to Fade actions).
¢ Duration allows the user to specify the duration of the action (in frames).

¢ Enabled, when set to true, the quick effects action will be enabled. When set to false, the quick
effects action will be disabled.

4.5.3.3. Date Quick Out

The Quick Effects Out section provides the following options:
e Action enables the user to set the action to be executed when the media is triggered. The three
actions available include fade, wipe, and push.
o Direction enables the user to specify the direction of the action (Does not apply to Fade actions).
e Duration allows the user to specify the duration of the action (in frames).

e Enabled, when set to true, the quick effects action will be enabled. When set to false, the quick
effects action will be disabled.

In order for the Date to function properly, the user MUST ensure the selected Font
,Ef Type is loaded onto the device.

45.4. Date Compiler Window

The compiler window enables the user to set the properties of the object, which will be used to identify
the individual object name and output layer when the playlist is compiled.
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Figure 4-65: Date Compiler Window

e Exclude From Build enables the user to set whether the selected object will be included or
excluded from the compiling process. Select True if the user does NOT want the selected
object to be included in the compile build. Select False if the user does want to include the
selected object in the compile build.

e Output Filename enables the user to assign the object an output filename. When the project is
compiled, the object will be identified by the name specified in this field.

e Output Layer enables the user to assign the object to an output layer. This setting determines
the output layer of the object.
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4.6. CREATING AN IMAGE OR IMAGE SEQUENCE OR ADDING A LOGO

An image and image sequence can be configured in the same way. Inserting an image imports a

single graphic and importing an image sequence imports a series of images, which create an animated
sequence.

A logo shares the same properties as an image sequence, therefore for the sake of simplicity refer to
this section for instruction on configuring the parameters of a logo.

To add a logo, select the Import Logo button from the main toolbar & . A Select Source Logo dialog

box will appear, as shown in Figure 4-66. The user will be prompted to navigate to the appropriate
folder and selected the logo file. Please note that the user will only be able to select an evl logo file
type.

Fa
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Figure 4-66: Select Source Logo
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To create an Image sequence, the user must select Add Image Sequence from the Object menu (see
section 4.2.5). Creating an image using the Add Image option enables the user to insert a single
image or a series of image files (animation) onto the design canvas. The Image Sequence Builder
window will appear and the user will be prompted to insert an image, as shown in Figure 4-67.

The Image Sequence Builder is divided into two sections: Source Graphics and Key Graphics
(Optional). The Source Graphics column inserts the actual images, whereas the Key Graphics
(Optional) column is used to add images that represent how the fill image is presented on the screen.

The Source is the image that appears on the design canvas and the Key is the space that the image
fills.

£ =,
Image Sequence Builder
Source Graphics ke Graphics (Optional)
Mame Path Mame Path
£ [ ¥ £ >

Figure 4-67: Image Sequence Builder Window

Once the Image Sequence Builder dialog box appears, the user can add a fill image or multiple
images by selecting the Add... button under the Source Graphics section. The Select Image(s)
dialog box will appear as shown in Figure 4-68. The Select Image(s) window allows the user to
navigate to the appropriate directory, and select the desired image. Select the Open button to add the
image to the Source Graphics list. Repeat the same procedure to insert an image into the Key
Graphics (Optional) column.
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Figure 4-68: Select Image(s) Window

It is common for a screen such as the one shown in Figure 4-69 to appear when selecting and opening
an image. The Select Insert Operation may appear if the user is trying to import a single image that is
part of a larger sequence of images. To insert all of the images in a sequence select the Insert
Complete Sequence option. To insert only the images listed after the selected image in the sequence,
select the Insert Partial Sequence (from selection to end) option. To insert only the individual
image, select the Insert Selected Image option. Once an option is selected the image(s) will be
displayed in the appropriate column of the Image Sequence Builder window.
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Figure 4-69: Select Insert Operation Window

To remove an image from either the Source Graphics or the Key Graphics (Optional) column,

highlight the image in the appropriate column and select the Delete button under the corresponding
column.

Once the desired images have been selected, click on the Continue button at the bottom of the screen.

Once the image is inserted, the image will be displayed on the design canvas as shown in Figure 4-70.
The user can then set the placement of the image by selecting the image object and dragging it to the
desired position using the mouse or by entering the coordinates in the Placement property of the
image Property Settings panel (see section 4.6.2.1).
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Figure 4-70: Image Sequence Object on Design Canvas

4.6.1. Image Sequence Menu

To access the Image menu, select the image on the design canvas and right-click the mouse button.
The Image menu provides the options shown in Figure 4-71.
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Figure 4-71: Image Menu
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4.6.2.

Undo enables the user to undo the previous action.

Redo enables the user to re-instate the undone action.

Play enables the user to play the animated image on the design canvas.

Pause enables the user to pause the animated image on the design canvas.

Stop enables the user to stop the animated image’s play mode.

Bring to Top enables the user to bring the selected object to the top of the object stack.

Move Up enables the user to bring an object one step closer to the front.

Move Down enables the user to send an object one step closer to the back.

Send to Bottom enables the user to send the selected object to the bottom of the object stack.
Delete enables the user to remove the object from design canvas.

Properties opens the Loop Point Control which enables the user to view and edit the animated
image sequence frame by frame. (See section 4.6.5)

Image Appearance

When the image object is selected on the design canvas, the properties window will appear and the

R

user can select the appearance button %" to view and edit the object’s appearance (see Figure 4-72).
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4.6.2.1.
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Figure 4-72: Image Appearance Window

Image Placement

Height enables the user to view the height of the image. The entered height value must be a
multiple of 4.

Width enables the user to view the width of the image. The entered width value must be a
multiple of 4.

X enables the user to set the horizontal position of the Image on the canvas. The entered value
must be a multiple of 2. The position of the Image can be adjusted by entering the X coordinate
into the property box or by using the mouse to move the Image and place it in the desired
location on the design canvas. If the object is moved with the mouse, the coordinates will be
reflected in the X field.

Y enables the user to set the vertical position of the Image on the design canvas. The entered
value must be a multiple of 2. The position of the Image can be adjusted by entering the Y
coordinate into the property box or by using the mouse to move the image and place it in the
desired location on the design canvas. If the object is moved with the mouse, the coordinates
will be reflected in the Y field.
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4.6.3. Image Effects

When the Image object is selected on the design canvas, the properties window will appear and the

[ . . : :
user can select the effects button | to view and edit the object effects. See Figure 4-73. The Effects
panel enables the user to specify the transition effects for the Image object.

Properties x

Showing Object: image
Object | Compiler

& e | L

ot
E Fade Settings

Fade In

Fade Cut

Hold

Opacity 100
E Quick In

Action Fade

Direction

Duration 15

Enabled False
B Quick Out

Action Fade

Direction

Duration 15

Enabled False

w1272 vy 168 -- Wideo 272 vidd

Figure 4-73: Image Effects Window

4.6.3.1. Image Fade Settings
e Fade In enables the user to specify the Fade In duration (in frames). The valid range is 1 to 600
frames.

e Fade Out enables the user to specify the Fade Out duration (in frames). The valid range is 1 to
600 frames.

e Hold enables the user to specify the hold duration (in frames). Enter a value of 0 to hold the
media on-air until taken out. A valid transition hold time range is from 1 to 600 frames.

e Opacity enables the user to set the opacity of the image fade with a valid range of 0 to 100%.
The Opacity control specifies the key value applied to the media.
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4.6.3.2. Image Quick In

o The Quick Effect In section provides the following options:

e Action enables the user to set the action to be executed when the media is triggered.
The three actions available include fade, wipe, and push.

o Direction enables the user to specify the direction of the action (Does not apply to Fade
actions).

e Duration allows the user to specify the duration of the action (in frames).

e Enabled, when set to true, the quick effects action will be enabled. When set to false,
the quick effects action will be disabled.

4.6.3.3. Image Quick Out

o The Quick Effect Out section provides the following options:

e Action enables the user to set the action to be executed when the media is triggered.
The three actions available include fade, wipe, and push.

o Direction enables the user to specify the direction of the action (Does not apply to Fade
actions).

e Duration allows the user to specify the duration of the action (in frames).

e Enabled, when set to true, the quick effects action will be enabled. When set to false,
the quick effects action will be disabled.

4.6.4. Image Compiler Window

The compiler window enables the user to set the properties of the object, which will be used to identify
the individual object name and output layer when the playlist is compiled.

Properties x
Showing Object: image

Object | Compiler

B General
Exchude From Build | False
Cutput Filenarne image
Outpuk Laver 003

272 vi 168 -- Wideo hiZ72 vig4

Figure 4-74: Image Compiler Window
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e Exclude From Build enables the user to set whether the selected object will be included or
excluded from the compiling process. Select True if the user does NOT want the selected
object to be included in the compile build. Select False if the user does want to include the
selected object in the compile build.

¢ Output Filename enables the user to assign the object an output filename. When the project is
compiled, the object will be identified by the name specified in this field.

e Output Layer enables the user to assign the object to an output layer. This setting determines
the output layer of the object.

4.6.5. Editing Loop Points of an Image Sequence

To access the Loop Point Control window, right mouse click the inserted image on the design canvas.
Once the image menu pops up, select the Properties option from the menu and the Loop Point
Control window will appear (see Figure 4-75). The Loop Point Control window enables the user to
view individual frames and edit the sequence. The user can insert loop points, which enables
segments to be faded in and out, repeated, or held until removed.

| Loop Point Editor .

Segment Start End Status
2 Frame: 1 &0 Repeat Once
Qpacity:  100% 100%%

I Ok J l Cancel

Figure 4-75: Loop Point Control Window for an Animated Image

The Loop Point Control window displays each individual frame in an image sequence (see Figure
4-75). Each frame is numbered in the bottom left hand corner of the individual frame box.

The Loop Point Control window enables the user to view the properties of the loop points. The
Sequence column identifies the number of loop points (key frames) present in the image sequence.
When the Loop Point Control window is first opened it will display the number 2 in the Sequence
column. These two points indicate the beginning point (frame 1) and the end point (last frame). For
example, Figure 4-75 shows that the image sequence is 60 frames in length; therefore, the Start frame
is 1 and the End frame is 60.
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The Start column identifies the frame number of the first frame in a frame segment and the End column
identifies the frame number of the last frame in the frame segment. For example, an image sequence
is 30 frames in length and a new loop point is inserted at frame 10, creating a total of three loop points
in this sequence. Therefore, the first frame segment would Start at 1 and End at 9 and the second
frame segment would Start at 10 and End at 30.

The Opacity property displays the opacity of the frame. The opacity of the selected loop point can be
adjusted to create a fade effect. For example, setting the opacity of a Start point to 0% and the opacity
of the End point to 100% will create a fade in effect.

The Status column determines whether the frame segment is held until taken out or repeated at the
selected loop point.

The loop points can be adjusted using key commands or mouse controls. Sections 4.6.5.1 and 4.6.5.2
describe these controls.
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4.6.5.1. Using the Key Commands

The loop points and frame segments can be edited using the key commands on the keyboard. Table
4-2 provides a list of keyboard commands that can be used to insert, edit and adjust loop point controls.

KEY DESCRIPTION

LEFT arrow The LEFT arrow key is used to navigate to the previous frame in the animated

] image sequence.

RIGHT arrow The RIGHT arrow key is used to navigate to the next frame in the animated image

) sequence.

+ The PLUS key (1) is used to zoom in on the frames view.

- The MINUS key (-) is used to zoom out on the frames view.

| The “I1” key is used to insert a loop point in the current (selected) frame.

The “D” key is used to delete a loop point in the current (selected) frame.

The “H” key is used to insert a hold. The hold is applied to the segment of frames
between the two loop points. The segment will be marked as Hold Until Taken
Out under the status column in the loop point editor.

Note that currently only one hold sequence per animation is supported. Therefore,
other existing hold sequences will be changed to “Repeat Once”. This change is
performed without warning.

R The “R” key is used to increase the number of repeat counts of a segment. Each
time the “R” key is pressed another repeat count is added.

R + SHIFT By holding the SHIFT key while pressing the “R” key, the user can decrease the
number of repeat counts of a segment. Each time the “R” + SHIFT keys are
pressed a repeat count is removed.

UP arrow ‘I When positioned on a loop point (key frame), the UP arrow will increase the opacity

in 1% increments.

DOWN arrow l

When positioned on a loop point (key frame), the DOWN arrow will decrease the
opacity in 1% increments.

UP arrow When positioned on a loop point (key frame), holding the SHIFT key while pressing
+ SHIFT the UP arrow will increase the opacity to 100%.

DOWN arrow When positioned on a loop point (key frame), holding the SHIFT key while pressing
+ SHIFT 1 the DOWN arrow will decrease the opacity to 0%.

Table 4-2: Loop Point Control Key Commands for Image Objects
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4.6.5.2. Using the Mouse Controls

The loop point parameters can also be adjusted using the mouse controls. Double-clicking a frame in
the sequence will insert a loop point at the beginning of the selected frame. To adjust the opacity of the
loop point, select and move the point up or down to the desired opacity level. While dragging the loop
point up and down, the Opacity column will display the numeric opacity value.

To access other loop point controls, right mouse click on a frame in the sequence to reveal the loop
point menu. The loop point menu, shown in Figure 4-76, enables the user to edit the loop point
parameters using the following controls.

Insert Fade Point:

Repeat Once
FRepeat =2
Repeat x5
Cuskom Repeat. ..

Hold until FADE SUT {Loop)

Figure 4-76: Loop Point Menu

¢ Insert Fade Point enables the user to insert a loop point in the current (selected) frame.

o Repeat Once enables the user to repeat the frame segment once.

o Repeat x2 enables the user to repeat the frame segment twice.

o Repeat x5 enables the user to repeat the frame segment five times.

e Custom Repeat enables the user to assign the number of times the frame segment will repeat.
Selecting this option will reveal the Custom Repeat dialog box, as shown in Figure 4-50. The

user will enter the desired custom repeat value into the Repeat field and then select the OK
button.

Custom Repeat

Enter the custom repeat walue in the box provided below,

Repeat; | &

£
w

[ (0] 4 ] [ Cancel

Figure 4-77: Custom Repeat Dialog Box
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e Hold until FADE OUT (Loop) enables the user to insert a hold. The hold is applied to the
segment of frames between the two loop points.

Note that, currently, only one hold sequence per animation is supported. Therefore, other
existing hold sequences will be changed to “Repeat Once”. This change is performed without
warning.

o Delete will remove the loop point from the sequence. The Delete option will be grayed out if
the user has NOT right mouse clicked a selected loop point in the sequence.

4.6.6. Preview the Animation

The animation can be previewed in Overture Media Designer. To preview the animation, right click the
animation object on the design canvas and then select play from the drop down menu. The user can
also control the playback mode via the main panel control or the main Media menu.

Once the animation is in playback mode, the user will be able to preview it on the design canvas. The
playback specifications will be displayed in the lower left hand corner of the screen, as shown in Figure
4-78.

Playback Complete

Figure 4-78: Playback Specifications

o0 Timecode: This item identifies the timing in frames.
0 Length: This item identifies the time in duration.
0 Frame: This item displays the current frame number.

Please note, that any changes made in the Overture Media Designer (for example, fades, repeats, etc)
can be previewed using the play command before the animation is compiled into an .evl.

The following is a list of playback commands:

Play: This button enables the user to preview the animated object by playing it on the design
canvas.

Step Back: This button enables the user to move the play mode back in one frame increments.
Pause: This button enables the user to pause the playback mode on the current frame.

Step Next: This button enables the user to move the play mode forward in one frame
increments.

C €€ R

Stop: This button enables the user to stop the playback mode of the selected object.
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CREATING A TEMPERATURE OBJECT

To create a Temperature Object, the user can select Add Temperature from the Object menu (see
section 4.2.5) or the main toolbar. A temperature object will appear on the design canvas as shown in
Figure 4-79. The user can then set the placement of the temperature by selecting the temperature
object and dragging it to the desired position using the mouse or by entering the desired coordinates in
the Placement property of the temperature Property Settings panel.

| ] Untitled* - Overture Media Designer l;”@
File Edit Media Object Build Wiew Help ]

(= BN ¥}
| ) & e
Design Canwas Properties x
L Showing Object: temp
Object | Compiler

=
7 LIz

B Appearance
Faonk MNamne Arial

Fonit Size: 48

Show Degree False

Shaw Units False

Text Color |:| 255;255;255 100%
E Behaviour

Unit Mode Celsius
B Placement

kS 960

¥ 540

%960 y: 540 -- Yideo h:960 w1270

Figure 4-79: Temperature Object on Design Canvas
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4.7.1. Temperature Menu

To access the temperature menu, right mouse click the temperature object on the design canvas. The
Temperature menu provides the following options shown in Figure 4-80:

Unda Chrl+Z

Bring to Tap
Mowe Up

Movwe Diown
Send to Botkom

Delete

Figure 4-80: Temperature Menu

e Undo enables the user to undo the previous action.

e Redo enables the user to reinstate the undone action.

e Bring to Top enables the user to bring the selected object to the top of the object stack.

¢ Move Up enables the user to bring an object one step closer to the front.

¢ Move Down enables the user to send an object one step closer to the back.

e Send to Bottom enables the user to send the selected object to the bottom of the object stack.

o Delete enables the user to remove the object.

4.7.2. Temperature Appearance

When the temperature object is selected on the design canvas, the properties window will appear and

S

the user can select the appearance button =7 to view and edit the object’s appearance.
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Properties X

Shaowing Ohject: temp
Object | Compiler

I =
- | |L =
) — R

E Appearance

Font Marme Arial

Fonk Size 45

Show Degres False

Shiow Uniks False

Text Color |:| 255;255;255 100%
Bl Behaviour

Unit Mode Celsius
E Placement

k4 960

ki 240

1960 v 540 -- Yideo b 960 w270

Figure 4-81: Temperature Appearance Panel

4.7.2.1. Temperature Appearance

e Font Name enables the user to specify the font type of the temperature text.
o Font Size enables the user to set the font size of the temperature text.

o Show Degree, when set to True the Temperature on the design canvas displays the degree °
symbol. If set to False, the degree ° symbol will not be displayed.

e Show Units, when set to True the Temperature on the design canvas displays the unit mode of
either Celsius or Fahrenheit. If set to False, the units will not be displayed.

o Text Colour enables the user to set the font colour of the temperature text.

4.7.2.2. Temperature Behaviour

¢ Unit Mode enables the user to set the unit mode to Celsius or Fahrenheit.
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4.7.2.3. Temperature Placement

e X enables the user to set the horizontal position of the temperature object on the canvas. The
entered value must be a multiple of 2. The position of the temperature object can be adjusted by
entering the X coordinate into the property box or by using the mouse to move the object and
place it in the desired location on the design canvas. If the object is moved with the mouse, the
coordinates will be reflected in the X field.

e Y enables the user to set the vertical position of the temperature object on the design canvas.
The entered value must be a multiple of 2. The position of the temperature object can be
adjusted by entering the Y coordinate into the property box or by using the mouse to move the
object and place it in the desired location on the design canvas. If the object is moved with the
mouse, the coordinates will be reflected in the Y field.

4.7.3. Temperature Effects

When the Temperature object is selected on the design canvas, the properties window will appear and
the user can select the effects button '**/ to view and edit the object effects. See Figure 4-82. The
Effects panel enables the user to specify the transition effects for the temperature object.
Properties X
Showing Object: temp

Object | Compiler

s | B

- =
[l Fade Settings

Fade In

Fade Cut

Hold

Opacikty 100
E Quick In

Action Fade

Direction

Duration 15

Enabled False
E Quick Out

Action Fade

Direction

Durakion 15

Enabled False

960 v 540 -- Yideo hi960 w270

Figure 4-82: Temperature Effects Panel
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4.7.3.1. Temperature Fade Settings

e Fade In enables the user to specify the Fade In duration (in frames). The valid range is 1 to 600
frames.

e Fade Out enables the user to specify the Fade Out duration (in frames). The valid range is 1 to
600 frames.

e Hold enables the user to specify the hold duration (in frames). Enter a value of 0 to hold the
media on-air until taken out. A valid transition hold time range is from 1 to 600 frames.

e Opacity enables the user to set the opacity of the image fade with a valid range of 0 to 100%.
The Opacity control specifies the key value applied to the media.

4.7.3.2. Temperature Quick In

The Quick Effects In section provides the following options:
e Action enables the user to set the action to be executed when the media is triggered. The three
actions available include fade, wipe, and push.

e Direction enables the user to specify the direction of the action (Does not apply to Fade actions).

e Duration allows the user to specify the duration of the action (in frames).

e Enabled when set to true, the quick effects action will be enabled. When set to false, the quick
effects action will be disabled.

4.7.3.3. Temperature Quick Out

The Quick Effects Out section provides the following options:
e Action enables the user to set the action to be executed when the media is triggered. The three
actions available include fade, wipe, and push.

¢ Direction enables the user to specify the direction of the action (Does not apply to Fade actions).

e Duration allows the user to specify the duration of the action (in frames).

e Enabled, when set to true, the quick effects action will be enabled. When set to false, the quick
effects action will be disabled.

In order for the Temperature to function properly, the user MUST ensure the
g selected Font Type is loaded onto the device.
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4.7.4. Temperature Compiler Window

The compiler window enables the user to set the properties of the object, which will be used to identify
the individual object name and output layer when the playlist is compiled.

Properties X
Shaowing Ohject: temp

Object | Compiler

E General
Exclude From Build | False
Cukpuk Filename kemp
Oukpuk Laver 995

3960 v 540 -- Video b 960 w270

Figure 4-83: Temperature Compiler Window

e Exclude From Build enables the user to set whether the selected object will be included or
excluded from the compiling process. Select True if the user does NOT want the selected
object to be included in the compile build. Select False if the user does want to include the
selected object in the compile build.

¢ Output Filename enables the user to assign the object an output file name. When the project
is compiled, the object will be identified by the name specified in this field.

e Output Layer enables the user to assign the object to an output layer. This setting determines
the output layer of the object.
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CREATING A TIME OBJECT

To create a Time Object, the user can select the Add Time item from the Object menu (see 4.2.5) or
the main toolbar. A time object will appear on the design canvas as shown in Figure 4-84. The user
can set the placement of the clock by selecting the clock object and dragging it to the desired position
using the mouse or by entering the desired coordinates in the Placement property of the time Property
Settings panel.

| k] Untitled* - Overture Media Designer E][El
Fle Edt Media Object Buld View Help
= GG\ iam > & 4
i D e =
= | ab "a e ) g:E <
Design Canvas Properties X

LTl Showing Object: time

Object | Compiler

=

&e Lz
E Appearance
Faonk Marne Arial
Font Size 48
Text Color |:| 255,255,255 100%:

E Behaviour

Source Time OF Day

Time Mode Hours:Minutes: Seconds., Fr.
E Placement

kS 602

i 368

sB02 w365 -- Yideo hi60Z vi 184

Figure 4-84: Time Object on Design Canvas

The user has the option to select an analog or digital clock item. From the Object drop down menu or
the right-click canvas menu, select the Add Time... menu item and then select either the Analog Clock
or Digital Clock option.
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add Audio Clip, ..

Add Crawl

Add CG Ikem

Add Date

add Image. ..

Add Image Sequence. .,

Add Temperature

Add Time » Analog Clock. ..
Add video Clip. .. Digital Claock.

Figure 4-85: Add Time Option — Object Menu

48.1. Time Menu

To access the Time menu, right mouse click the time object on the design canvas. The Time menu
provides the following options shown in Figure 4-86:

Unda Chrl+Z

Ering to Top
Mowve Up

Mavwe Dawn
Send to Botkom

Delete

Figure 4-86: Time Menu

e Undo enables the user to undo the previous action.

e Redo enables the user to reinstate the undone action.

e Bring to Top enables the user to bring the selected object to the top of the object stack.
¢ Move Up enables the user to bring an object one step closer to the front.

¢ Move Down enables the user to send an object one step closer to the back.

e Send to Bottom enables the user to send the selected object to the bottom of the object stack.
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o Delete enables the user to remove the object from the design canvas.

4.8.2. Digital Time Appearance

When the digital clock object is selected on the design canvas, the properties window will appear and

™

y

the user can select the appearance button =7 to view and edit the object’s appearance (see Figure
4-87).

Properties X
Showing Object: time
Object | Compiler

E Appearance

Font Marme Arial

Font Size 45

Text Calor |:| 255,255,255 100%:
B Behaviour

Source Time OF Day

Time Mode Hours:Minutes: Seconds AMPM
B Placement

k4 60

i 540

w1960 v 540 -- Yideo by 960 w270

Figure 4-87: Digital Time Appearance Panel

4.8.2.1. Digital Clock Appearance

o Font Name enables the user to specify the font type of the time text.
e Font Size enables the user to set the font size of the time text.

o Show Frames, when set to True the frames will be displayed. The Show Frames parameter is
only accessible if the Time Mode is set to 24 Hour Time.

e Show Meridiem, when set to True the meridiem will display the AM or PM time units. The
Show Meridiem parameter is only accessible if the Time Mode is set to 12 Hour Time.

¢ Show Seconds, when set to True the seconds’ digits will be displayed.

e Text Colour enables the user to set the colour of the time text.
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4.8.2.2. Digital Clock Behaviour

e Source enables the user to select the source of the time. There are three options, Time Of
Day, Timer 1 and Timer 2. Time of Day sets the source of the clock to time of day. Timer 1 sets
the source of the clock to user-defined Timer 1 on the device. Timer 2 sets the source of the
clock to user-defined Timer 2 on the device.

e Time Mode enables the user to set the time to one of the various time mode options. Figure
4-88 provides a list of the time mode options available when using the digital clock.

HoursiMinukes: Seconds, Frames (24 Hour Clock)
Hours:Minukes: Seconds (24 Hour Clock)
Hours:Minukes (24 Hour Clock)

Hours:Minukes: Seconds AMPM

Hours:Minukes AMJPM

Hours:Minukes: Seconds

Hours:Minutes

Seconds (Minutes * 60 + Seconds)

Mirutes: Seconds

Minutes, Seconds

Figure 4-88: Time Mode Options

4.8.2.3. Digital Clock Placement

o X enables the user to set the horizontal position of the time object on the canvas. The entered
value must be a multiple of 2. The position of the time object can be adjusted by entering the X
coordinate into the property box or by using the mouse to move the object and place it in the
desired location on the design canvas. If the object is moved with the mouse, the coordinates
will be reflected in the X field.

e Y enables the user to set the vertical position of the time object on the design canvas. The
entered value must be a multiple of 2. The position of the time object can be adjusted by
entering the Y coordinate into the property box or by using the mouse to move the object and
place it in the desired location on the design canvas. If the object is moved with the mouse, the
coordinates will be reflected in the Y field.

4.8.3. Analog Time Appearance

When the analog clock object is selected on the design canvas, the properties window will appear and

-

[ o

the user can select the appearance button =7 to view and edit the object’s appearance. (See Figure

4-89)
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Figure 4-89: Analog Clock Appearance Panel

4.8.3.1. Analog Clock Appearance

¢ Hand Length enables the user to set the length of the second hand.
e Hour Colour enables the user to set the colour of the hour hand.

¢ Min Colour enables the user to set the colour of the Minute hand.

e Sec Colour enables the user to set the colour of the second hand.

4.8.3.2. Analog Clock Behaviour

o Enable Time Offset enables the user to set the time offset. Setting the time offset to true will
enable the time offset and setting it to false will disable the time offset.

0 Hours enables the user to offset the clock by a designated hour.
0 Minutes enables the user to offset the clock by a designated minute.
0 Seconds enables the user to offset the clock by a designated second.
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4.8.3.3. Analog Clock Placement

Height enables the user to view the height (in pixels) of the selected analog clock image.
Please note that the image size cannot be scaled or adjusted in OMD. To change the size of the
image, the file would have to be modified in another graphics program and imported back into
OMD.

Width enables the user to view the width (in pixels) of the selected analog clock image. Please
note that the image size cannot be scaled or adjusted in OMD. To change the size of the image,
the file would have to be modified in another graphics program and imported back into OMD.

X enables the user to set the horizontal position of the time object on the canvas. The entered
value must be a multiple of 2. The position of the time object can be adjusted by entering the X
coordinate into the property box or by using the mouse to move the object and place it in the
desired location on the design canvas. If the object is moved with the mouse, the coordinates
will be reflected in the X field.

Y enables the user to set the vertical position of the time object on the design canvas. The
entered value must be a multiple of 2. The position of the time object can be adjusted by
entering the Y coordinate into the property box or by using the mouse to move the object and
place it in the desired location on the design canvas. If the object is moved with the mouse, the
coordinates will be reflected in the Y field.

4.8.4. Time Effects

When the Time object is selected on the design canvas, the properties window will appear and the user

I . : . .
can select the effects button | to view and edit the object effects. See Figure 4-90. The Effects
panel enables the user to specify the transition effects for the time object.
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Figure 4-90: Time Effects Panel

4.8.4.1. Time Fade Settings
o Fade In enables the user to specify the Fade In duration (in frames). The valid range is 1 to 600
frames.

¢ Fade Out enables the user to specify the Fade Out duration (in frames). The valid range is 1 to
600 frames.

¢ Hold enables the user to specify the hold duration (in frames). Enter a value of 0 to hold the
media on-air until taken out. A valid transition hold time range is from 1 to 600 frames.

¢ Opacity enables the user to set the opacity of the image fade with a valid range of 0 to 100%.
The Opacity control specifies the key value applied to the media.

OVERTURE MEDIA DESIGNER Revision 1.9.2 Page 4-97



Overture Suite 2.3 Software Manual everl’_zQ

4.8.4.2. Time Quick In

The Quick Effects In section provides the following options:

e Action enables the user to set the action to be executed when the media is triggered. The
three actions available include fade, wipe, and push.

o Direction enables the user to specify the direction of the action (Does not apply to Fade
actions).

e Duration allows the user to specify the duration of the action (in frames).

e Enabled, when set to true, the quick effects action will be enabled. When set to false, the quick
effects action will be disabled.

4.8.4.3. Time Quick Out

The Quick Effects Out section provides the following options:

o Action enables the user to set the action to be executed when the media is triggered. The
three actions available include fade, wipe, and push.

o Direction enables the user to specify the direction of the action (Does not apply to Fade
actions).

o Duration allows the user to specify the duration of the action (in frames).
[ ]

Enabled, when set to true, the quick effects action will be enabled. When set to false, the quick
effects action will be disabled.

In order for the Time to function properly, the user MUST ensure the selected
g Font Type is loaded onto the device.

4.8.5. Time Compiler Window

The compiler window enables the user to set the properties of the object, which will be used to identify
the individual object name and output layer when the playlist is compiled.
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Figure 4-91: Time Compiler Window

e Exclude From Build enables the user to set whether the selected object will be included or
excluded from the compiling process. Select True if the user does NOT want the selected
object to be included in the compile build. Select False if the user does want to include the
selected object in the compile build.

¢ Output Filename enables the user to assign the object an output file name. When the project
is compiled, the object will be identified by the name specified in this field.

e Output Layer enables the user to assign the object to an output layer. This setting determines
the output layer of the object.
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4.9. CREATING A VIDEO CLIP

To create a Movie, the user can select Add Video Clip... option from the Object menu (see section
4.2.5) or the main toolbar. The Select Source Movie window will appear, and the user will be
prompted to locate the movie file, as shown in Figure 4-92. Once the movie is inserted, the movie
object will be displayed on the design canvas as shown in Figure 4-93. The user can then set the
placement of the movie by selecting the movie object and dragging it to the desired position using the
mouse or by entering the coordinates in the Placement property of the movie Property Settings panel
(see section 4.9.2.1). Please note that when importing a movie, the audio and video will be imported
as two separate objects.

Select Source Movie

Fa

Look ir: | ' My Computer T € T r° M-
Y A 3% Floppy (A2
";ﬁ “e# | ocal Disk (C:)
My Fecent 125 CD Drvive (D)
Documents
F.-\-
Deszkiop

~
by D ocuments

&
by Computer

- =
by Metwoark Filez af type: Al Supported Movies [ awi” mov] [ |

Figure 4-92: Source Movie Window
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Figure 4-93: Video Object on Design Canvas

49.1. Video Menu

To access the Movie menu, select the movie on the design canvas and right-click the mouse button.
The Movie menu provides the options shown in Figure 4-94:

Unda

Play

Ering to Top
Mowve Up

Mawe Dawn
Send to Botkom

Delete

Properties

Chrl+Z

Figure 4-94: Video Clip Menu
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Undo enables the user to undo the previous action.

Redo enables the user to reinstate the undone action.

Play enables the user to play the movie on the design canvas.

Pause enables the user to pause the movie on the design canvas during playback mode.

Stop enables the user to stop the movie’s play mode.

Bring to Top enables the user to bring the selected object to the top of the object stack.

Move Up enables the user to bring an object one step closer to the front.

Move Down enables the user to send an object one step closer to the back.

Send to Bottom enables the user to send the selected object to the bottom of the object stack.
Delete enables the user to remove the object from design canvas.

Properties opens the Loop Point Control which enables the user to view and edit the movie
sequence frame by frame. (See section 4.9.5)
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4.9.2. Video Clip Appearance

When the video clip object is selected on the design canvas, the properties window will appear and the

[t}

user can select the appearance button =" to view and edit the object’s appearance (see Figure 4-95).

Properties x
Showing Object: image2
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& e
B Placement
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k4 280
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Figure 4-95: Video Clip Attributes Window

4.9.2.1. Video Clip Placement

Height enables the user to view the height of the movie background. The entered height value
must be a multiple of 4.

Width enables the user to view the width of the movie background. The entered width value
must be a multiple of 4.

X enables the user to set the horizontal position of the movie on the canvas. The entered value
must be a multiple of 2. The position of the movie can be adjusted by entering the X coordinate
into the property box or by using the mouse to move the movie and place it in the desired
location on the design canvas. If the object is moved with the mouse, the coordinates will be
reflected in the X field.

Y enables the user to set the vertical position of the movie on the design canvas. The entered
value must be a multiple of 2. The position of the movie can be adjusted by entering the Y
coordinate into the property box or by using the mouse to move the movie and place it in the
desired location on the design canvas. If the object is moved with the mouse, the coordinates
will be reflected in the Y field.
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4.9.2.2. Video Clip Effects
When the Video Clip object is selected on the design canvas, the properties window will appear and the

user can select the effects button | “*! to view and edit the object effects. See Figure 4-96. The Effects
panel enables the user to specify the transition effects for the video clip object.
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Figure 4-96: Video Clip Effects

4.9.2.3. Video Clip Fade Settings
o Fade In enables the user to specify the Fade In duration (in frames). The valid range is 1 to 600
frames.

o Fade Out enables the user to specify the Fade Out duration (in frames). The valid range is 1 to
600 frames.

o Hold enables the user to specify the hold duration (in frames). Enter a value of 0 to hold the
media on-air until taken out. A valid transition hold time range is from 1 to 600 frames.

¢ Opacity enables the user to set the opacity of the movie fade with a valid range of 0 to 100%.
The Opacity control specifies the key value applied to the media.
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4.9.2.4. Video Clip Quick In

The Quick Effects In section provides the following options:
e Action enables the user to set the action to be executed when the media is triggered. The
three actions available include fade, wipe, and push.

o Direction enables the user to specify the direction of the action (Does not apply to Fade
actions).

e Duration allows the user to specify the duration of the action (in frames).

e Enabled, when set to true, the quick effects action will be enabled. When set to false, the quick
effects action will be disabled.

4.9.2.5. Video Clip Quick Out

The Quick Effects Out section provides the following options:

e Action enables the user to set the action to be executed when the media is triggered. The
three actions available include fade, wipe, and push.

o Direction enables the user to specify the direction of the action (Does not apply to Fade
actions).

e Duration allows the user to specify the duration of the action (in frames).

e Enabled, when set to true, the quick effects action will be enabled. When set to false, the quick
effects action will be disabled.

4.9.3. Video Compiler Window

The compiler window enables the user to set the properties of the object, which will be used to identify
the individual object name and output layer when the playlist is compiled.

Properties x
Showing Object: image3

Chject Compiler

E General
Exclude From Build False
Cukput Filename image3
Outpuk Laver 995

w1308 i 204 -- Yideo hi308 w1102

Figure 4-97: Video Compiler Window
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o Exclude From Build enables the user to set whether the selected object will be included or
excluded from the compiling process. Select True if the user does NOT want the selected
object to be included in the compile build. Select False if the user does want to include the
selected object in the compile build.

¢ Output Filename enables the user to assign the object an output file name. When the project
is compiled, the object will be identified by the name specified in this field.

e Output Layer enables the user to assign the object to an output layer. This setting determines
the output layer of the object.

4.9.4. Video Clip Audio

When a video clip is added which contains audio, the audio tab will appear in a separate panel. The
audio from the video clip will be displayed as a separate object in the tab, as shown in Figure 4-98.
When the project is compiled the video clip audio will export as a separate object. The user can delete
the audio by right-clicking on the audio object in the audio tab and selecting Delete when the option
appears.

Audio x
Audio
Mame Path
audio 11 Pinky i publoverturel videos),
< *
w1298 v 206 -- Yideo Fi295 v 103

Figure 4-98: Video Clip Audio Window
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4.9.5. Editing Loop Points for a Video Clip Sequence

To access the Loop Point Control window, right mouse click the inserted movie on the design canvas.
Once the movie menu pops up, select the Properties option from the menu and the Loop Point
Control window will appear (see Figure 4-99). The Loop Point Control window enables the user to
view individual frames and edit the movie sequence. The user can insert loop points, which enables
frame segments to be faded in and out, repeated, or held until removed.

P

Loop Point Editor Ba

Segment Start En Status
z2 Frame:; 1 360 Repeat Once
Opacity:  100% 100%:

I K ] [ Cancel

Figure 4-99: Loop Point Control Window for a Video Clip Object

The Loop Point Control window displays each individual frame in a movie sequence (see Figure 4-99).
Each frame is numbered in the bottom left hand corner of the individual frame box.

The Loop Point Control window enables the user to view the properties of the loop points. The
Sequence column identifies the number of loop points (key frames) present in the movie sequence.
When the Loop Point Control window is first opened it will display the number 2 in the Sequence
column. The two points listed in the sequence column indicate the beginning point (frame 1) and the
end point (last frame). For example, Figure 4-95 shows that the movie sequence is 195 frames in
length; therefore, the Start frame is 1 and the End frame is 195.

The Start column identifies the frame number of the first frame in a frame segment and the End column
identifies the frame number of the last frame in the frame segment. For example, a movie sequence is
30 frames in length and a new loop point is inserted at frame 10, creating a total of three loop points in
this sequence. Therefore, the first frame segment would Start at 1 and End at 9 and the second frame
segment would Start at 10 and End at 30.

The Opacity property determines the opacity of the frame. The opacity of the selected loop point can
be adjusted to create a fade effect. For example, setting the opacity of a Start point to 0% and the
opacity of the End point to 100% will create a fade in effect.

The Status column determines whether the frame segment is held until taken out or repeated at the
selected loop point.
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4.9.5.1. Using the Key Commands

The loop point parameters can be edited using the key commands on the keyboard.

The following

keyboard commands can be used to insert, edit and adjust loop point controls.

KEY DESCRIPTION

LEFT arrow The LEFT arrow key is used to navigate to the previous frame in the movie

= sequence.

RIGHT arrow | The RIGHT arrow key is used to navigate to the next frame in the movie

s sequence.

+ The PLUS key (1) is used to Zoom In on the frames view.

- The MINUS key (-) is used to Zoom Out on the frames view.

| The “1” key is used to insert a loop point in the current (selected) frame.

D The “D” key is used to delete a loop point in the current (selected) frame.

H The “H” key is used to insert a hold. The hold is applied to the segment of frames
between the two loop points. The segment will be marked as Hold Until Taken
Out under the status column in the loop point editor.

Note that currently only one hold sequence per animation is supported. Therefore,
other existing hold sequences will be changed to “Repeat Once”. This change is
performed without warning.

R The “R” key is used to increase the number of repeat counts of a segment. Each
time the “R” key is pressed another repeat count is added.

R +SHIFT By holding the SHIFT key while pressing the “R” key, the user can decrease the
number of repeat counts of a segment. Each time the “R” + SHIFT keys are
pressed a repeat count is removed.

UP arrow I When positioned on a loop point, the UP arrow will increase the opacity in 1%
increments.

DOWN arrow 1

When positioned on a loop point, the DOWN arrow will decrease the opacity in 1%
increments.

UP arrow ' When positioned on a loop point, holding the SHIFT key while pressing the UP
+ SHIFT arrow will increase the opacity to 100%.

DOWN arrow When positioned on a loop point, holding the SHIFT key while pressing the

+ SHIFT DOWN arrow will decrease the opacity to 0%.

Table 4-3: Loop Point Control Key Commands for Movie Objects
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4.9.5.2. Using the Mouse Controls

The loop point parameters can also be adjusted using the mouse controls. Double-clicking a frame in
the sequence will insert a loop point at the beginning of the selected frame. To adjust the opacity of the
loop point, select and move the point up or down to the desired opacity level. While dragging the loop
point up and down, the Opacity column will display the numeric opacity value.

To access other loop point controls, right mouse click on a frame in the sequence to reveal the loop
point menu. The loop point menu, shown in Figure 4-100, enables the user to edit the loop point
parameters using the following controls.

Insert Fade Point:

Repeat Once
FRepeat =2
Repeat x5
Cuskom Repeat. ..

Hold until FADE SUT {Loop)

Figure 4-100: Loop Point Menu

¢ Insert Fade Point enables the user to insert a loop point in the current (selected) frame.

o Repeat Once enables the user to repeat the frame segment once.

o Repeat x2 enables the user to repeat the frame segment twice.

o Repeat x5 enables the user to repeat the frame segment five times.

e Custom Repeat enables the user to assign the number of times the frame segment will repeat.
Selecting this option will reveal the Custom Repeat dialog box, as shown in Figure 4-101. The

user will enter the desired custom repeat value into the Repeat field and then select the OK
button.

Custom Repeat

Enter the custom repeat walue in the box provided below,

Repeat; | &

£
w

[ (0] 4 ] [ Cancel

Figure 4-101: Custom Repeat Dialog Box
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e Hold until FADE OUT (Loop) enables the user to insert a hold. The hold is applied to the
segment of frames between the two loop points.

Note that currently only one hold sequence per movie is supported. Therefore, other existing
hold sequences will be changed to “Repeat Once”. This change is performed without warning.

o Delete will remove the loop point from the sequence. The Delete option will be grayed out if
the user has NOT right mouse clicked a selected loop point in the sequence.

4.9.6. Preview the Video Clip

The animation can be previewed in Overture Media Designer. To preview the animation, right click the
animation object on the design canvas and then select play from the drop down menu. The user can
also control the playback mode via the main panel control or the main Media menu.

Once the animation is in playback mode, the user will be able to preview it on the design canvas. The
playback specifications will be displayed in the lower left corner of the design canvas, as shown in
Figure 4-102.

Playback Complete

Figure 4-102: Video Clip Playback Specifications

The playback specifications provides the following information:
0 Timecode: This item identifies the timing in frames.
0 Length: This item identifies the time in duration.
o Frame: This item displays the current frame number.

Please note, that any changes made in the Overture Media Designer (for example, fades, repeats, etc)
can be previewed using the play command before the animation is compiled into an .evl.

The following is a list of playback commands:

Play: This button enables the user to preview the animated object by playing it on the design
canvas.

Step Back: This button enables the user to move the play mode back in one frame increments.
Pause: This button enables the user to pause the playback mode on the current frame.

Step Next: This button enables the user to move the play mode forward in one frame
increments.

L €2 K

Stop: This button enables the user to stop the playback mode of the selected object.
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